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1 About This Study Guide 
When I started my journey as a self-taught finite element analyst it felt like a 

daunting challenge. But thanks to Altair University webpage and its free ebooks, 

Altair Academic Forum, Youtube channels (Altair India Student Contest) and 

Altair.com learning center my learning curve was made easier. My first Radioss 

simulation was complete by the end of the first week and my confidence began to 

grow. I later became a regular contributor to the Altair Academic Forum, where my 

reputation was noticed by the Altair University team and I was offered an 

opportunity to revise this edition. I hope your learning experience will be as fun and 

enjoyable as it is educational and practical. 

 

This study guide aims to provide a basic introduction into the exciting and 

challenging world of explicit Finite Element Analysis. We deliberately kept the 

theoretical aspects as short as possible as with our other eBooks. Instead, we 

concentrated on providing information a new Radioss user typically needs to get 

started and spark an interest in the subject. 

 

The chapter entitled: Explicit Analysis - Some Fundamentals is meant to provide a 

rather high-level introduction to the topic. More detailed information about Radioss 

files, element formulations, materials, contact formulations, kinematic conditions, 

loads, monitored volumes, connections, output requests, time step control, helpful 

tools, checks, best practice and post-processing is then provided in subsequent 

chapters.  

https://altairuniversity.com/
https://altairuniversity.com/free-ebooks/
https://forum.altair.com/
https://www.youtube.com/channel/UCRvT-aRk0ivhDHpO9HwBFxQ
https://www.altair.com/learning-center/
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Two additional chapters are added in this third edition: “Connections” and 

“Monitored volumes” and some content from the first edition are reintroduced. The 

pre-existing chapters were revised to include additional comments and 

functionalities and stay up to date with the latest software release. A lot of new 

content has been added to the Recommended Videos appendix.  

 

In here we adopted the rather common model building workflow: 

• Geometry cleanup, meshing and mesh checks are carried out with standard 

HyperMesh and HyperMesh X. These working steps are discussed in detail in the 

free study guide: “Practical Aspects of Finite Element Simulation”. 

• Definition of properties, materials, contacts, barriers, model checking and 

correction, as well as the specification of analysis output data take place in standard 

HyperMesh, HyperMesh X or HyperCrash.  

• Postprocessing takes place in HyperView (mainly contour plotting) and 

HyperGraph (plotting of diagrams). 

 

We also included a series of videos that cover most of the topics addressed in this 

book. In order to help you get a better understanding of an explicit analysis, the 

tutorials go beyond the standard click-and-go approach to include additional 
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explanations. Working your way through these tutorials should be rather straight 

forward since more detailed information was already provided in earlier chapters. 

The Capstone Projects “Cell Phone Drop” and “Roof Crush” are meant to test what 

you have learned. All the model files for the tutorials in this book can be 

downloaded from here.  

 

The focus of this book is on the analysis so the reader should know the fundamentals 

of finite element analysis. A basic understanding of the preprocessor HyperMesh (or 

HyperCrash) makes your life much easier. The same accounts for postprocessing of 

results with HyperView and HyperGraph. Maybe the appendix “Postprocessing - 

Crashworthiness” is all you need to know. If not, then please have a look at the 

following free eLearning courses available in our Learning & Certification Program 

(https://certification.altairuniversity.com/).  

 

• Learn Post Processing with HyperView (topics addressed: HyperWorks Desktop 

Environment, Animation and View Controls, Strength Analysis, HyperGraph Plotting, 

Modal & Frequency Response (NVH) Analysis, Crashworthiness, Publishing Results) 

• Learn Preprocessing with HyperMesh (topics addressed: Interface and Basic 

Interaction, Geometry, 2D Meshing, Solids and Solid Meshing, 1D Meshing and 

Connectors, Analysis Set Up) 

• In addition, the free study guide: “Practical Aspects of Finite Element Simulation” 

(www.altairuniversity.com/academic-program/) may also give you a good 

introduction.  

• Learn Explicit FEA with RADIOSS is an eLearning course about RADIOSS (topics 

addressed: Introduction to RADIOSS Elements, Summarizing Explicit FEA Process 

with a Crash Box; Introduction to Material Library and Contact Modeling, 

Introduction to Rigid Walls and Boundary Conditions, Time Step Control, Model Set 

Up and Analysis, Debugging Techniques, Fundamentals of Crash Analysis). 

Additionally, we offer: 

• Highly discounted seminars & workshops at colleges and/or at Altair facilities 

• An Altair moderated forum (https://forum.altair.com) and much more ... 

https://altairuniversity.com/learning-library/model-files-for-the-tutorials-and-examples-in-the-ebook-crash-analysis-with-radioss-a-study-guide/
http://certification.altairuniversity.com/
http://certification.altairuniversity.com/course/view.php?id=70
http://certification.altairuniversity.com/course/view.php?id=70
http://certification.altairuniversity.com/course/view.php?id=69
http://certification.altairuniversity.com/course/view.php?id=69
http://www.altairuniversity.com/free-ebooks-2/
http://certification.altairuniversity.com/course/view.php?id=32
https://forum.altair.com/
http://forum.altairhyperworks.com/
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Regardless of the project complexity you are working on, the reliability of your 

results is only as good as the person who uses the software: The solver is only 

capable of working with the problem that you define; it cannot design the part for us 

and does not have engineering judgment, so the ultimate design decisions lie with 

YOU. A very popular statement which summarizes the above (and which is 

mentioned in many documents) simply says:  

Garbage in, Garbage out 

This study guide will be periodically updated as more topics and technologies will be 

added in subsequent software releases. We hope you enjoy this study guide and 

would appreciate feedback. 

 

Best regards, 

Simon Križnik and Matthias Gölke 

 

On behalf of “The Altair University Team” 
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Disclaimer 
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mistakes. However, publishers and authors will not be responsible for loss, damage 

in any form and consequences arising directly or indirectly from the use of this book.  

© 2020 Altair Engineering, Inc. All rights reserved. No part of this publication may be 

reproduced, transmitted, transcribed, or traslated to another language without the 

written permission of Altair Engineering, Inc. To obtain this permission, write to the 

attention Altair Engineering legal department at:  

1820 E. Big Beaver, Troy, Michigan, USA, or call +1-248-614-2400. 
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2 HyperWorks For Teaching 
Leading universities across the globe are using HyperWorks computer aided 

engineering (CAE) simulation software for teaching and research in the fields of: 

• Structural Analysis 

• Computational Fluid Dynamics (CFD) 

• Optimization 

• Multi-Body Simulation (MBS) 

• Electro-Magnetic Field Simulation 

• Numerical Methods & System Simulation 

Altair has commercial expertise to share with the academic community. By including 

real life scenarios in your teaching material, Altair can help you add value to your 

engineering design courses. 

Our unique licensing system allows universities to use the entire (full version) 

HyperWorks suite in a very flexible and cost-efficient way as sketched out below: 

 

 
 

Since teaching differs from campus to campus, and from region to region we are 

very interested to discuss your needs with you personally. 

Please let us know your requirements by sending an email notification to 

altairuniversity@altair.com 

We are more than happy helping and assisting you with your teaching activities.
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3 Explicit Analysis Fundamentals 
This chapter is based on the fabulous book “Practical Finite Element Analysis” by 

Nitin Gokhale et al. from Finite To Infinite. We - the Altair University Team - are very 

thankful for the courtesy to re-use some of his material in this Study Guide! 

We also included material from our RADIOSS Standard Seminar Classes and 

HyperWorks Help Documentation: HyperWorks Solvers > RADIOSS > Theory Manual 

and User Guide. 

3.1 Introduction  

Altair RADIOSS is a next-generation implicit and explicit finite-element solver for 

nonlinear transient dynamics. This robust, multidisciplinary solver allows 

manufacturers to maximize crash, impact, safety, manufacturability and fluid-

structure interaction performance in order to bring innovative products to market 

faster. It is equipped to solve complex nonlinear behavior with a multitude of 

material and failure models. Radioss has built-in multi-physics capabilities for fluid-

structure interaction and blast simulation. Limited implicit solver capabilities 

support gravity equilibrium as well as Spring Back Analyses. Optimization 

capabilities are available through seamless integration with OptiStruct as well as 

through a link with HyperStudy. The integration with OptiStruct allows the problem 

setup with native Radioss input format as well as through OptiStruct input. Radioss 

can be used to analyze a wide variety of design problems in which the structural 

and system behavior can be simulated: 

• Explicit dynamic analysis 

• Non-linear implicit static analysis 

• Transient heat transfer and thermo-mechanical coupling 

• Explicit Arbitrary Euler-Lagrangian (ALE formulation) 

• Explicit Computational Fluid Dynamics (CFD) 

• Smooth Particle Hydrodynamics (SPH) 
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• Incremental sheet metal stamping analysis with mesh adaptivity 

• Non-linear buckling analysis 

The main aim of this chapter is to introduce basics of nonlinear transient dynamic 

analysis in terms of the solution methodology and discuss some of the practical 

simulations performed in the industry.    

 

Solving Real-World Problems Computationally 

When dealing with dynamic, nonlinear, and transient events, such as impact 

analysis, there are five requirements for reducing a real-world problem into a 

computational space: 

• Geometric modeling deals with the overall representation of the structure and 

whether the structure as a whole or subsections of the structure can be assumed 

to be idealized to simplify the computational matrices. This also includes a 

determination of the relevant volume of the computational area: i.e. model a 

failing bracket vs. the bracket as well as all surrounding parts. 

• Application of physical laws is the second level of computational reduction. For 

many linear statics problems, only the most idealized forms of conservation of 

energy, conservation of mass, and equilibrium equations are necessary. As the 

empirical problem under review develops more real-world behavior, the solution 

must take into account more complete formulations of these laws of 

conservation. 

• Formulation of time and space discretization includes determining whether the 

problem setup would best benefit from a Lagrangian representation, Eulerian 

representation, or an Arbitrary Lagrangian Eulerian (ALE) representation. 

• Space discretization uses the idealizations of the geometric modeling as well as 

the forms of the physical laws required for the analysis type to represent the 

problem as FE entities. This requires the engineer setting the problem up to 

provide all information required for any nonlinearities, contacts, constraints, 

initial conditions, etc, not resulting or apparent from the geometrical FE 

arrangement. 
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• Time integration is simply a selection of whether Explicit formation with a 

Central Difference Method or an Implicit formulation would be the best 

approach for the problem at hand. 

The five steps listed above walk through the top two tiers of complexity on below 

diagram. Past that point, and once all selections have been set up to the satisfaction 

of the engineer, the solver is responsible for using the information provided to 

assemble a mathematical model of the system and calculating or iterating a 

numerical solution from the input deck. 

 

 

 

 

Introduction to Nonlinearity 

Load-displacement response of one or more characteristic load introduction points 

is considered to evaluate nonlinearity of structures. When the structural response 

(deformation, stress and strain) is linearly proportional to the magnitude of the load 
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(force, pressure, moment, torque, temperature etc.), then the analysis of such a 

structure is known as linear analysis. When the load to response relationship is not 

linearly proportional, then the analysis falls under nonlinear analysis. 

 

 

 

For example, when a compact structure made of stiff metal is subjected to a load 

relatively lower in magnitude as compared to the strength of the material, the 

deformation in the structure will be linearly proportional to the load and the 

structure is known to have been subjected to linear static deformation. But most of 

the time either the material behavior is not linear in the operating conditions or the 

geometry of the structure itself keeps it from responding linearly. Due to the cost or 

weight advantage of nonmetals (polymers, woods, composites etc.) over metals, 

nonmetals are replacing metals for a variety of applications. These applications have 

nonlinear load to response characteristics, even under mild loading conditions. Also, 

the structures are optimized to make most of its strength, pushing the load level so 

close to the strength of the material, that it starts behaving nonlinearly. In order to 

accurately predict the strength of the structures in these circumstances, it is 

necessary to perform a nonlinear analysis. 

The stiffness matrix relating to the load and response is assumed to be constant for 

static analysis; however, all the real-world structures behave nonlinearly. The 
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stiffness matrix consists of geometric parameters such as length, cross sectional area 

and moment of inertia, etc. and material properties such as elastic modulus, rigidity 

modulus etc. The static analysis assumes that these parameters do not change when 

the structure is loaded. On the other hand, nonlinear static analysis considers the 

changes in these parameters as the load is applied to the structure. These changes 

are accommodated in the analysis by rebuilding the stiffness matrix with respect to 

the deformed structure (i.e. altered properties) after each incremental load 

application. Although, the world is nonlinear, it should be mentioned that in many 

cases the assumption of linearity is valid and in that way a linear analysis can be 

done instead. Also, from a computation point of view, it is a much less expensive 

approach. 

Sources of Nonlinearity 

There are three main sources of nonlinearity: Geometric nonlinearity, Material 

nonlinearity and Boundary condition nonlinearity. 

1. Geometric nonlinearities can be related to large strain and large displacement. 

In analyses involving geometric nonlinearity, changes in geometry as the 

structure deforms are considered in formulating the constitutive and 

equilibrium equations. Many engineering applications require the use of large 

deformation analysis based on geometric nonlinearity. Applications such as 

metal forming, tire analysis, and medical device analysis. Small deformation 

analysis based on geometric nonlinearity is required for some applications, like 

analysis involving cables, arches and shells. Such applications involve small 

deformation, except finite displacement or rotation. 

2. Material nonlinearity is associated with the inelastic behavior of a component 

or system. Material nonlinearities occur when the stress exceeds the yield stress 

or force-displacement law is not linear, or when material properties change with 

the applied loads. The material will no longer behave in a linear fashion. The 

causes for material non-linearity which can be permanent deformations and 

cracking. 
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3. Boundary condition nonlinearity arises when boundary conditions in a FE model 

change during the course of the analysis. The boundary conditions could be 

added to or removed from the model due to boundary nonlinearity as the 

analysis progresses. During large displacements, we may also require that 

pressure is normal to the moving surface, so that it moves with respect to the 

global coordinate system. 

 

Implicit and Explicit Analysis 

Choice of a proper analysis type is sometimes not done correctly due to insufficient 

knowledge about the problem being examined. Often a simpler solver solution is 

chosen and complexity of the situation is neglected, such as choosing linear analysis 

when the problem needs plasticity considerations. Below a chart is presented that 

shows how one should investigate the type of analysis that is applicable for a 

structural problem. Five types of analyses are presented that in fact are somehow 

similar - it is sometimes parameters, like velocity, strains and forces that are critical 

to a proper choice of solution from the below presented analyses. 
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Incremental load (also known as displacement steps) is required for all nonlinear 

and dynamic analyzes. This simply means in order to solve a mathematical problem, 

we need to break down the relationship between physics and time. We form two 

groups for this purpose: either time-dependent or time-independent problems. We 

typically use implicit or explicit approaches to solve these problems. When the 

effects of acceleration are significant and can’t be neglected, we refer to problems 

as time-dependent.  For example, in a drop test, as the item decelerates to a halt, 

the highest force occurs within the first few milliseconds. In this case, it is necessary 

to account for the effect of such a deceleration. By contrast, the loading can be 

considered quasi-static or time-independent when loads are slowly applied to a 

structure. If the rate of loading is slow enough the effects of acceleration can be 

neglected. Implicit and Explicit methods are approaches used in numerical analysis 

for obtaining numerical approximations to the solutions of time-dependent ordinary 

and partial differential equations. The implicit approach is useful in problems where 

time dependency of the solution is not an important factor [like static, modal 

analysis etc.] whereas for Explicit Dynamics approach is most helpful in solving high 

deformation time dependent problems [Crash, Impact etc]. 
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An explicit dynamics analysis is used to determine the dynamic response of a 

structure due to stress wave propagation, impact or rapidly changing time-

dependent loads. Momentum exchange between moving bodies and inertial effects 

are usually important aspects of the type of analysis being conducted. This type of 

analysis can also be used to model mechanical phenomena that are highly nonlinear. 

Nonlinearities may stem from the materials, (hyperelasticity, plastic flows, failure), 

from contact (high speed collisions and impact) and from the geometric deformation 

(buckling and collapse). Events with time scales of less than 1 second (usually of 

order milliseconds) are efficiently simulated with this type of analysis. Based on all 

these conditions the user will select an explicit solver to solve the analysis. Typical 

examples of explicit analysis are crash analysis, drop test, bird strike, fan blade 

out…etc. Obtaining an answer from an explicit simulation can be simple — it can be 

more challenging to get the correct answer. The predictions of a simulation are 

usually very difficult to confirm using traditional techniques, making it crucial that 

the analysis is carried out carefully and thoroughly.  Nonlinear analysis requires a lot 

of experience and a careful understanding of what you want to achieve, as well as a 

careful understanding of the software's analytical capabilities. When choosing a 

method for a dynamic problem, considerations must be made regarding the length 

of time the response can take place compared to the explicit method's stability limit. 

Consider also the size of the problem and the limitations of explicit analysis 

regarding the types of useable elements. There is an obvious choice in some cases, 

but this choice depends on specific case-dependent details in many practical 

problems. 
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Why & When To Run An Explicit Analysis Video by Rahul Rajan, Altair India (14 

minutes) 

 

In Radioss, both implicit and explicit time-integration schemes are available. In an 

explicit scheme, velocities and displacements are obtained by direct integration of 

nodal accelerations. With this approach, the cycle time step is often small, due to 

stability considerations. Therefore, for static or slow dynamic computations where 

the duration of the study is long, many cycles are necessary to carry out the 

simulation. An alternative to explicit method in such cases is the implicit time-

integration scheme. It can be shown that the implicit scheme is unconditionally 

stable, resulting in a larger cycle time step compared to the explicit method. 

However, in an implicit scheme, a global stiffness matrix should be assembled and 

inverted, leading to higher cost and greater memory requirements, per loading step. 

Although implicit scheme is unconditionally stable, it is not unconditionally 

convergeable (nonlinear case). In fact, it is generally less robust than explicit scheme 

and requires more user involvement. The equilibirium is enforced to user specified 

tolerance which tends to be more accurate. Implicit analysis can better handle 

problems such as cyclic loading, snap through, and snap back. 

 

https://altair-2.wistia.com/medias/wccd1xy5bu
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An explicit approach is more appealing for fast dynamic problems with highly 

nonlinear geometric and material behaviors. As all quantities may be treated as 

vectors, low storage is needed. The number of cycles to achieve simulation may be 

quite large, but global efficiency is generally observed. The implicit method, on the 

other hand is more efficient for static applications and/or long duration simulations. 

Explicit dynamics solvers provide an alternative approach to solving highly nonlinear 

static analyses that do not converge or converge with an implicit solver very slowly.  

Models that include complex contact with significant sliding and highly nonlinear 

material behavior and distortion of elements can be handled by explicit solvers.  

While implicit solvers are still the first choice for statics problems, explicit solvers 

with appropriate transient time and damping settings can be used to provide robust 

solutions to particularly troublesome statics problems. 

 



    
 

 

32 
 

 
 

 

The optimal solution is to have both implicit and explicit methods readily available in 

the same code. Implicit and explicit solvers in Radioss share the same routines for 

internal force computation; thus enabling seamless switching between the two 

schemes without an out-of-balance issue during the transition. The two schemes can 

be coupled to run multi-stage analyses. The user should provide the required control 

cards to activate the implicit scheme. When the RADIOSS solver is running an 

implicit analysis it will be shown in the out file as ** IMPLICIT OPTION USED **. The 

keywords required to launch a RADIOSS implicit analysis are defined in the Engine 

file and begin with /IMPL. The two uses for the implicit solution are spring-back 

(implicit) after sheet metal forming (explicit), or gravity loading/initial state 

computations (implicit) before crash simulations (explicit). Implicit analyzes are 

intended to complement the explicit solution hence some explicit features are not 

available. It is recommended to use OptiStruct for all other implicit simulations. The 

explicit method eliminates most of the limitations of the implicit method by using 

small time steps bypassing convergence checks. It can accurately simulate the 

propagation and interaction of stress waves caused by shocks or impacts, and it can 

solve highly nonlinear and structurally unstable problems that cannot be solved with 

implicit methods due to convergence difficulties. 
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3.2 Dynamic Equilibrium Equation 

These are basically the equilibrium equations of transient dynamics. These are 

written as: 

  
Where  M is the mass matrix, C  is the damping matrix  and K is the stiffness matrix.  

All that we do is just determine the evolution of the basic quantities such as 

displacement, velocity and acceleration given initial conditions on displacement and 

velocity with respect to time. 

All other quantities can be derived from these and most important are the element 

stresses, plastic strains, contact forces and   the energies such as kinetic, potential 

energy and overall energy absorption characteristics also known as energy 

management. 

Most software would commonly solve the dynamic equilibrium equation in an 

implicit way but the most popular way that should be used for highly nonlinear 
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problems is to use explicit time integration scheme such as a central difference 

scheme. There are several advantages of such a procedure and the most important 

is that it leads to an algorithm which can be easily programmed, does not require 

any matrix inversion procedure and further is extremely suitable for a fast parallel 

computing Methodology. 

 

3.3 Transient Dynamics Solution Methodology 

When solving dynamic problems with the Finite Element Method, it must be 

remembered that we use FEM only for the spatial discretization and the temporal 

(Time) discretization is always by using the Finite Difference Method. This approach 

is called as the Semi Discrete Galerkin as the space time finite element concept was 

a failure. We divide the total response time into much smaller time intervals called 

time steps or increments. The equilibrium equations are solved and the value of 

unknowns are determined at ( t + Δ t) based on the knowledge of their values at 

time t. 
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The explicit time discretization method requires a time step smaller than a critical 

value tcr. If the time step is greater than the critical time step, the solution of the 

equations is amplified artificially during the step-by-step procedure, due to the 

accumulation of the discretization error. 

 

 



    
 

 

37 
 

The stability condition is largely explained in the RADIOSS Theory Manual. For a 

system without damping, it can be simplified in a closed form: 

 

Where,   is the highest angular frequency in the system. For a discrete system, 

the time step must be small enough to excite all frequencies in the finite element 

mesh. This requires such a short time step that the shock wave does not miss any 

node when traveling the mesh: 

 

Where, lc  is the critical length of the element and c is the sound speed ( for 

a simplified case with E being the Young modulus and  being the material density). 

 

In Some More Detail - Explicit Time Integration Schemes 

The equations of motion can be written down as follows: 

 
where ‘n’ represents a time level index. Physically this means 

Inertial force + Damping force + Stiffness force = External force 

Using second order accurate Explicit Central Difference Operator, 

 

 
Substituting the above equations into equation (1), we get 
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If the problem is linear then {K} is evaluated at each and every time step. There is no 

computational advantage as still we shall have to invert the matrix present on left 

hand side of equation (5) . 

Mass matrix can be made diagonal/lumped rather than using a consistent one by 

using standard row/column sum lumping techniques as described in most of the text 

books of FEA such as R D Cook et .al. { 8 } whereas the damping matrix has to be 

made diagonal by suitable approximations as otherwise the classical damping matrix 

is usually non- symmetric. If the problem doesn’t involve damping then the solution 

technique as given by Eq. (5) is straightforward without any matrix inversion but 

does require data on initial conditions which can be obtained as follows. 

 

 

 

Where 

 

 
 

Most of the numerical algorithms use a two-step formulation rather than the above 

procedure and this doesn’t require any initial condition on the diagonality of {C} the 

damping matrix. 
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The equations of motion is recasted as follows: 

 

 
 

Using the above equations, 

 

 
The method can be started by using the initial conditions and the approximation {U} 

and or by using 

 

 
 

The von-Neumann stability condition for the scheme yields a conditional stability 

governed by the following condition: 

 

 
 

Where ζ is the fraction of critical damping at the highest undamped frequency of the 

whole model. 

We can also write the frequency in terms of the material property and the 

characteristic length of the element and we get: 

 

 
 

Another convenient form to remember is to recast the above equation as 
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This is also called as Courant Stability or CFL (Courant–Fredrichs and Levy) 

conditions. The physical interpretation of this is that ‘t’ must be small enough such 

that the information doesn’t propagate across more than one element per time 

step. 

   

The elastic speed does depends on the wave propagation characteristics and 

different elements can have different wave speeds. Most software use a time step 

scaling factor to the maximum time step that can be allowed and this is usually of 

the order of 0.9 with a provision to change this factor for highly nonlinear problems. 

If we use reduced integration elements, then effectively we are adding the hourglass 

force on the right hand side of the equilibrium equation as illustrated by the 

following equation. 

 

Inertia Force + Damping force + Internal force = External force + Hourglass force 

Care must be taken to solve the system in such a way that it ensures a sufficient 

accuracy and the fact that it doesn’t mask any prominent physical behavior of the 

system e.g. a fracture or breakage of the physical system completely masked by the 

hourglass effects. 

A quick check on the minimum mesh length that corresponds to a failure time step 

of 1 micro sec for steel (Young’s Modulus =210 GPa, Density = 7800 kg/m  ) would 

tell you that it is of the order of 5 mm. Thus you should set the global length in a 

pre-processor software to 5 mm size for crash simulation. Using a larger element 

length is always a better practice. 

Explicit schemes are economical and efficient for problems involving high frequency 

loads as these problems require very small time steps to capture the associated 

phenomena and the schemes are stable for small time steps only. 

Note: More informtion about “Time Step” in RADIOSS is included in the chapter 

“Time Step Control”. 
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3.4 Impact versus Quasistatic Simulations 

If the excitation frequency is less than one third of the lowest natural frequency of 

the structure it can be considered a quasistatic loading where inertial effect can be 

neglected. The term Quasi Static is used to represent a slow dynamic process as 

opposed to a fast dynamic process. The distinction between these two is quite 

obvious when we see the load application in following figure, a suddenly applied 

load (mathematically a heavy side or step input) will result in a displacement two 

times that of the static displacement of the system. The term Quasi Static simulation 

is used when we use a dynamic code to produce a static result. It must be 

remembered that we will get a static or close to static result only if the ramp up time 

is sufficiently large (i.e. the ramp up slope is not too steep so as to get a close result 

as same as of that as Full dynamic simulation). 

 
Full Dynamic or Impact Simulation               Quasi Static Simulation 

 

In statics, we totally ignore the dynamic effects due to inertial force. The major 

difficulty in using a dynamic code for getting a static simulation result are: 

• Presence of acceleration / inertial force term. Displacements are derived 

from solution of acceleration. Whereas in Statics, displacements are primary 

variable and are directly obtained. 

• Static stress analysis gives you stresses but dynamic code gives you rather 

stress waves. The effect of stress waves reflection at boundaries are always present 

in a dynamic solution. 

A dynamic code always produces oscillations in the result which can be reduced by 

using a larger ramping (a very progressive and smooth enough loading) in 
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combination with damping. For increasing the speed Of explicit methods for 

quasistatic simulation we have following options: 

1. Increase the element length 

2. Increase the density of the component , increasing the mass of component 

3. Increase the rate of loading 

4. Decrease elasticity moduli of the material 

Option 1 is preferred at least for initial runs 

Option 2 is known as the “Mass Scaling“. Although this increases the computational 

speed considerably, care must be taken    to see that a bound is put on the 

percentage of mass increase. Secondly it should not change the physics of the 

problem i.e. mass increase is allowed for deformable bodies but if applied to rigid 

bodies then results will be different than the original model. Mass scaling is a much 

accepted technique among the CAE Community to increase the speed of the explicit 

software. 

Option 3 is known as the “Time scaling” by increasing the rate of loading in order to 

reduce the simulation time. The kinetic energy should be low compared to the 

internal energy for most of the simulation, to minimize the inertial effects. 

Option 4 is not used much in practice. 

Conventional way is to use implicit codes for quasistatic simulation but the major 

problem is issues of convergence and efficiency of the code when friction / sliding 

contact is present. Complex contacts work better in an explicit code. 

 

3.5 Numerical Modeling Approaches 

Lagrangian And Eulerian Codes 

Historically this difference in the approaches is due to the different approaches used 

for solid mechanics and fluid mechanics. In solid mechanics, we always follow a 

particle tracking or lagrangian approach, that is the Finite element mesh keeps on 

deforming with the structure. As Belytschko (1) puts it “Every  material  point  is  

compulsorily  also  a  finite  element  node.”Here the mesh continuously follows the 
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deformed structure and hence this approach has always some limitation with 

respect to the very large deformation problems. In Fluid Mechanics, the attention is 

put  on  a  control  volume  bound  by control surfaces and then one monitors the 

mass momentum and energy exchange across it. Essentially we solve the same 

equation as that in a solid mechanics but we put them in a solution suitable form 

also called as conservation form. The conservation form has lot of practical 

applications in problems with shock waves and if used in the integral form is the 

basis of Finite Volume Method. This approach is also called the Eulerian or Field 

approach. Thus the mesh remains fixed all the time  in space and you don’t have any 

severe or stringent limitations on the mesh quality. 

The physics thus dictates the following requirements: 

• Lagrangian meshes for slight to moderate deformation. 

• Eulerian meshes for large deformation. 

It is also possible to use another type of formulation called Arbitrary Lagrangian 

Eulerian (ALE) formulation in which the nodes can be programmed to move 

arbitrarily. The nodes on the boundaries are moved on the boundaries itself while 

the interior nodes are moved to minimize the mesh deformation. 

The difference can be clearly observed in the following figure. In Lagrangian meshes, 

element boundaries remain coincident with boundaries and material interfaces. In 

Eulerian, they do not and then you  will  have  to  use  other  approximate  or  

tracking methods for the treatment of moving boundaries. 



    
 

 

44 
 

 
 

Mesh rezoning is also another approach which can be used with the projection of 

variables between the meshes (similar to submodeling technique used in static 

analysis). But this is also a time consuming procedure and introduces spurious jumps 

in the state variable histories as it violates the conservation laws. Zukas (1992) gives 

a detailed account of the applications of various Lagrangian and Eulerian codes 

available for impact dynamics along with their detailed capabilities. 

 

Smooth Particle Hydrodynamics (SPH) 

The principal idea of SPH is to treat hydrodynamics in a completely mesh-free 

fashion, in terms of a set of sampling particles. This is a mesh free method and there 

is no physical contact between the particles. The behavior of SPH particles after an 

impact is shown in the image below. We can see that the object is splashing as soon 

as it contacts with the floor. The typical examples of SPH formulations are bird strike 
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analysis, fuel sloshing etc. Smoothed particle hydrodynamics is a remarkably 

versatile and simple approach for numerical fluid dynamics. 

 

  

 

3.6 Contact Treatment And Algorithms 

Contact between two components occurs when they try to come towards each 

other during the deformation process. When the bodies touch, a force is transmitted 

across the common interface. Usually there is friction present between the surfaces 

and hence forces normal and tangential to the surface will be created. This gives rise 

to a contact pressure and a shear stress. 

 

A high end computational process is required due to severe discontinuity with 

respect to boundary conditions.  This discontinuity in boundary conditions arises as 

the boundary condition of no interpenetration is applied only when the two parts 
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are in contact. This should be removed when the components try to separate. Thus 

the boundary conditions resemble an ON / OFF switch and the software must detect 

contact and clearance continuously as the simulation proceeds. If there were no 

contacts defined then the components would simply penetrate into each other and 

this is unphysical. The software by default doesn’t have any logic to detect the 

contact unless the user indicates or gives a hint on the specified surfaces or nodes 

that might come in contact with each other in course of time. Thus there is a need to 

have a powerful contact algorithm. Such an algorithm must be able to detect when 

the two parts are coming into contact or trying to separate from each other and 

apply the appropriate constraint at the point of contact or remove the 

corresponding boundary condition during parts moving away from each other. 

 

Terminology and Its Implications For Contact 

a. Master And Slave Bodies: Two bodies which can contact each other during the 

deformation process are called Master and Slave bodies. Both of these can be 

deformable or Master is rigid and Slave is a deformable. Master is rather 

coarsely meshed than the salve. If the densities of the bodies are equal then the 

material with a lower stiffness (softer material) is treated as a slave. 

b. Master And Slave Surfaces: The surfaces of the master and slave bodies. The 

edges of these surfaces are called master and slave lines/ segments and so 

correspondingly the nodes as master and slave nodes. These two surfaces jointly 

together are called as Contact pair. 

c. Contact Clearance: The contact constraint is applied as the clearance becomes 

zero. This is the distance separating the contact pair. 

d. Contact Pressure: This is the normal component of force per unit area at the 

contact interface. There is absolutely no limit   in the contact formulation on 

magnitude of contact pressure. The surfaces separate from each other when 

contact pressure becomes zero or negative and the kinematic constraint is 

removed. It is the dramatic change in contact pressure when a contact condition 

changes from “Open” to “Closed“ making it difficult to analyze. 
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Sticking or slipping can result in convergence problems during contact 

simulation. So friction  should  be  included  in the contact analysis only when it 

has a significant influence on response. Also software allow an elastic slip which 

is indicated by  the dotted line. This is a small amount of relative motion 

between the surfaces that occurs when the surfaces would be sticking. 

 

There are two methods to analyse contact: 

1. The Penalty Stiffness Formulation in which stiff springs are used between the 

contacting bodies 

2. The Lagrange Multiplier which handles the kinematic constraint in a strict way 

but on the other hand is computationally    very costly 

 

Contact Types 

These are classified with respect to the elasticity and the type of contacting bodies: 

• Rigid to Deformable: When one of the contacting bodies is highly stiffer than the 

other, then it can be considered as a rigid one and other deformable. The rigid 

body undergoes no deformation and stresses. This is well suited to a softer 

material coming in contact with a hard material. 

• Deformable to Deformable: In this the two contacting bodies have the same 

order of elasticity and a typical example is a bolted flange. 

 

Classification Based on the Type of the Contacting Bodies 

• Point To Point Contact: If the interaction takes place at a point for both the 

contacting bodies then the problem is classified as a point to point contact. Most 

commonly used software have GAP elements to define this and usually these 

types of contact problems involve small relative sticking. Typical example is a pipe 

whip model. Point to Point contact can also be used to solve a surface to surface 

interaction if the nodes of the two line up, relative sliding deformation is 

negligible and the deflection of the two surfaces is small e.g. interference or 

shrink fit. 
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• Point To Surface Contact: In this type , the interaction takes place at a point on 

one body and on a surface in another contacting body. This is very rare case of 

contact simulation and an example can be a spinning top impacting a rigid floor 

or two beams contacting each other at a beam tip . 

• Surface To Surface Contact: This is the most common way to handle all the 

engineering problems providing better results on contact pressure and frictional 

stress . It also supports large deformation with a significant amount of sliding and 

friction efficiently. Examples of this can be many typically all metal forming 

simulation and forging or deep drawing. 

 

Typical Contact Algorithm 

The flow chart in the following figure shows a typical algorithm used for contact 

analysis. It examines the state of all contact pairs at the start of each increment to 

establish whether slave nodes are open or closed. If a node is closed, it determines 

whether it is sliding or sticking. A constraint is applied for each closed node and 

removes the constraints from anywhere, contact state changes from closed to open. 

The procedure is repeated until the iteration is completed with no change in contact 

states and this iteration becomes the first equilibrium iteration. The algorithm then 

checks for normal equilibrium convergence checks. If the convergence check fails, 

another iteration is performed. The entire process is repeated for all subsequent 

load steps. 
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Algorithm For Contact Analysis 

 

There are three methods used in practical software:  

1. Kinematic Constraint Method or Lagrange Multipliers: Constraints are 

imposed into global equations by a transformation of the slave node displacement 

components along the contact interface. The transformation will distribute the slave 

node normal force component to adjacent master nodes. If the master surface is 

finer than the slave surface then master surface nodes can penetrate through the 

slave surface without any resistance and creates a kink in the slide line. This can lead 

to hourglass problem. 
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2. Distributed Parameter Method: In this algorithm, half the mass of each slave 

in contact is distributed to the master surface area. The internal stress in each 

element determines a contact pressure distribution for the master elements that 

receives the mass. The acceleration is updated at the master surface. We then 

impose the penetration constraints on slave node accelerations and velocities to 

make sure the movement along the master surface. 

3. Penalty Stiffness Formulation Method: This is probably the widest used 

method both in implicit and explicit codes. The method uses normal interface 

springs between all the nodes of the contact surface. A stiffness modulus is 

computed for each master and slave segment based on the elasticity and the 

thickness property of each of the contacting elements. One should be careful 

enough  in selecting spring stiffness as this decreases time step. This method is very 

reliable and the hour glassing problem is less as compared to the other methods. 

 

Typical Issues In Contact Analysis 

Improper Surface Normals: This is the most common error and usually the software 

have an Automatic option to correct the orientation. Master surface normals should 

point toward the slave surface. 

Compatible elements: All elements underlying a surface must be compatible. They 

must be either shells or solids or of the same order (either first or second), all 

deformable or all rigid. That is you cannot have slaves where one is shell of first 

order and adjoining element is a second order. 

 

 

 
           (a) Incorrect                      (b) Correct                                   (c) Correct 

Compatibility Check 
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Number Of Increments: Contact analysis require a careful, logical approach. Divide 

the analysis into several steps if necessary and apply loading slowly to make sure 

that the contact conditions are established. 

Boundary Conditions: There should not be any constraints applied for nodes on the 

contacting surfaces in the direction of contact. If friction is included in the model, 

there should not be any boundary condition in any direction for the nodes on 

contact surfaces. 

 

 

 
                 (a) Incorrect                                      (b) Correct 

 

 

Extending The Rigid Surface: For Rigid to deformable contact simulation, rigid 

surface should be large enough to ensure that slave nodes don’t slide off and fall 

behind a rigid surface. This will lead to a convergence failure. Extending the rigid 

surface as shown in the figure can improve the convergence. 
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                           (a) Incorrect                            (b) Correct 

Mesh Density Of Slave Surface: Slave mesh must be fine enough to interact with all 

important features on the rigid or master surface. Otherwise the master surface will 

just penetrate into the slave as shown in the figure. 

 

 

 
 

 

Proper Selection Of Master & Slave: The slave and master surface definitions should 

be selected carefully. The slave surface should be more finely meshed than the 

master. If the mesh densities are of the same order, slave surface is the one with 

lesser Elastic Moduli. 

 

 

 
 

 

No Initial Penetration: There should not be any initial penetration as shown in the 

figure. This gives rise to a simulation with sliding energy present at the initial 

conditions which is physically wrong and hence it should be strictly seen that the 
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penetration check is applied through the pre-processor as well as by carrying out the 

zero second termination run to cross check. 

 

 
 

 

Avoid Sharp Corners: Avoid sharp corners in rigid surfaces as they can pose severe 

convergence problems. Better to have smooth rigid surfaces by providing fillets in 

the sharp corners. 

 

 

 
                                         a) Incorrect                    b) Correct 

 

 

3.7 Some Aspects of Shell Element Technology 

Some Aspects of Shell Element Technology 

This topic has been discussed till depth in the books written by Belytschko et.al (1). 

We will make no attempt to discuss the advantages of each over the other. Although 

the default shell formulation may be fast due to several simplifications required for 

the speed, there can be severe drawbacks such as ignoring change in warpage and 

one can easily observe the failure for standard twisted beam with end load. 
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It is a good idea if you make comparison of the elements for running a quasi-static 

simulation and compare the results with standards with respect to accuracy and 

computational cost. This motivates you to gain a major confidence in full vehicle / 

large practical problems. 
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Hourglass 

Hourglass is weird modes of deformation that occur in under integrated elements 

and no stresses will be produced.  This can affect solution accuracy by varying the 

structure’s true response. This leads to inaccurate stress, strain and deflection 

results. For an under-integrated element, displacements and forces may exist for 

each node of the element. If sum of all these forces and displacements give null 

strain and stress on the integration point of the element then that element fails to 

calculate stiffness for certain mode of deformation. At this stage we say element has 

entered into hourglass. Soon after this as element failed to calculate stiffness the 

element will behave weirdly. 

 

 
 

Reduced Integration Elements, Hourglassing And Control: 

• Use of lower order elements as opposed to higher order. If you look 

carefully at the stability condition, higher order elements yield a higher 

maximum frequency than the lower order elements. This is one of the major 

reason that lower order elements are preferred in all practical codes. 

• Reduced integration against full one. The implications of this are a 

computationally very efficient procedure but at the cost of increased effort 

to control the hourglass or chequer board modes / zero strain energy non 

physical modes. 
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Full Vs Reduced Integration For A Linear Quadrilateral 

 

If you carry out FEA of a single shell element by using 4 Gauss points or solid 

element using 8 Gauss points then you shall get exactly six rigid body modes. By 

using reduced integration we get spurious rigid body modes apart from 6 rigid body 

modes due to what is called as “rank deficiency“. See e.g. Hughes (6). These modes 

are called as Hourglass modes. Although they don’t add any extra energy into the 

system, they must be avoided as they are non -physical. This is usually done by 

adding extra stiffness or viscosity across the diagonal which adds extra strain energy 

into the system and we call this as Hourglass Energy. Now we must be careful 

enough to see to it that this is much less as compared to the internal energy of the 

system. 
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A thumb rule is that the hourglass energy should be less than 10% of Internal 

energy. Also it is very important not to stiffen the already will working element. 

Following are some of the observations on Hourglass Control Methods: 

• Default viscous formulations work better. 

• Stiffness form is most stable for large crash problems but also results in a 

slightly stiffer response. 

• Flanagan - Belytschko stiffness control is best for large rotations associated 

with highly nonlinear problems. 

• One can assign different hourglass control methods to different parts. Better 

use a refined mesh rather than a coarse mesh for large rotations. 
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3.8 Typical Application Of Explicit Simulations In 

Various Industries  

Automotive  

Automotive industry has probably the widest application of crash simulation. 

Simulating the crashworthiness of the vehicle in terms of very simple models based 

on the spring mass damper systems was the focus when the computers were very 

slow. Nowadays software such as RADIOSS and others have very wide practical 

aspects such as use of special seat belt elements and development of dummies for 

occupant safety. Several standards have originated in various countries and it is 

impossible to give a detailed account of these. In the following we discuss some of 

the most essential applications related to the automotive industry. There are very 

detailed procedures such as five-star ratings and no attempt will be made here to 

take a detailed account of these.   

 

Consumer Goods Industry / Communications Industry 

Crashworthiness also finds a lot of applications in drop test of components such as 

television, plastic buckets and mobile phone. Points of interest here are to check the 

structural integrity of the component and monitor any damage caused to the 

system. In mobile industry any damage caused to the antenna and the LCD display 

are very important as they make the device totally useless.   

 

Applications In Other Industries 

Although developed mainly for automotive applications, crash simulation software 

have also found applications in train, ship and aircraft crashworthiness. The two 

main standards associated with FAA (Federal Aviation Administration) requirements 

are those of bird strike impact and engine blade containment. Other applications in 

defense sector are simulating the explosive detonation process and design of 
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weapons. Computational Biomechanics also is continuously evolving with the 

development of finite element models closely following the actual physical models. 

 

3.9 Some Points to Note While Running a 

Dynamic Simulation 

• Always mention the system of units which you have used for simulation. 

• You must have a fairly good idea of what would be the total file size of the 

output since a wrong input could generate a large output of ascii and binary 

files, and you will run out of space very soon. 

• A thumb rule to remember is: If T is the termination time, then your animation 

output file generation time step should be T/10 (so that you have minimum 10 

frames available) and the time history file size should be a further ten times 

lesser as you would require an accurate representation of energy, contact forces 

and stresses data. 

• There should be a zero penetration in the model so that there are no initial 

contact related energies in the model. It is always a good practise to run a 0 

msec run for the model making you understand if there are gross modeling 

errors in the model. 

• It is always better to set the global element length to 5 mm which corresponds 

to a time step of 1 e-06 seconds for steel material. Try to make your initial runs 

with coarse mesh so that you know how your model behaves. 

• There are lot of element formulations and different material models, and a 

beginner could naturally be very confused with understanding the software 

overall, it is hence a good idea to understand the element formulations that 

perform best and why. This comes through a lot of verification runs, reading the 

software manuals carefully and experimental validation of the material models. 

• Just defining the contacts and leaving to the software to do the rest of the things 

is not enough. You must also check if it is giving you a physically compatible 

behavior or result. 
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• Usually a crash simulation software has different cards suitable for rigid bodies 

and deformable bodies. Carefully study these options so that you get a full idea 

of the capabilities of the software. 

• Try to use restarts to the maximum extent as this is a powerful utility associated 

with explicit dynamics code. 

• Crawl, walk, run approach: start with the simplest model and progressively add 

complexity. An FE model should be as simple as possible, but as complex as 

necessary. In other words, numerical models should capture the required 

physical behavior with the minimum amount of input parameters. 

• Always check the CAE results with some hand calculations and make a note if it 

makes some sense. Always check the energy balance. If hourglass energy is  

large  compared to internal energy (strain energy) of the system, then it can 

mask the physical failure and can give a totally erroneous result. A thumb rule is 

that the hourglass energy should be a maximum of 10 % of the internal energy. 

• Note:  By using reduced integration you save a lot of computational time which 

is always necessary in transient dynamics. Any philosophy which makes your run 

fast should be used e.g. lumped mass matrix instead of consistent mass matrix. 

The risk of using reduced integration is that it generates non –physical zero 

strain energy modes which are to be compulsorily eliminated by using artificial 

stiffness / viscosity thus generating additional strain energy which we call as 

hourglass energy. Another strategy to make a fast run is to use mass scaling 

which increases the time step but you should set reasonable limitations on the 

maximum mass increase. 

• There can be many errors and mistakes by a beginner. Always remember that 

the cause of these errors is very much present in the deck itself. Common are 

wrongly formatted input, initial contact penetration, improper load curve 

definitions and massless nodes due to temporary nodes created not deleted. 

Floating point exceptions can be caused by parts with zero density or thickness, 

over constrained nodes. Always take a closer look whether you have inputted 

the correct information and whether the mesh is of a good quality. Normal run 

doesn’t necessarily guarantee that you have solved the problem in a correct way 
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as what is more important is always checking the CAE simulation result with the 

test data or physical behaviour of the system. 

• If the time step is too small due to the presence of a small element, it is always 

better to coarsen the mesh thus allowing an considerable increase in the time 

step. 

• Total energy of the system is always constant: 

Total Energy = Internal Energy + Kinetic energy + External Work 

• For most of the impact problems, there will be initial kinetic energy and no 

external work at time t=0.0. As the simulation advances Kinetic energy will 

decrease, Internal energy will increase and the total energy of the system should 

always remain Constant. If the total energy plot shows a very big jump then the 

model has an error and you must check the definition of contacts. The 

momentum printout also shows whether the bodies after hitting are going in the 

right direction. Always ensure that parts are going in the right direction with 

right velocities at the right time. 

• Effect Of Process And Residual Stress On Crash Analysis is important for  

correlation between physical crash test and FE. The work hardening effect and 

formation of residual stresses during metal forming causes change in 

subsequent yield stress and deformation behaviour of formed components. 

Thus the mechanical properties of formed components can significantly 

different from those of the blank. Consideration of these material property 

changes in crash simulation is vital for achieving good simulation accuracy. One 

step forming simulation technique from HyperForm is used improve accuracy of 

crash simulation result by mapping residual stress-strain data predicted by 

HyperForm onto crash simulation model. 
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4 RADIOSS Files 
Preprocessing of RADIOSS models may be carried out using HyperCrash by importing 

a meshed model into HyperCrash and then adding materials, contacts, loads etc.)  

 

 
Graphical User Interface Of HyperCrash 

 

Alternatively, the entire model set up, starting from geometry cleanup-meshing, 

mesh quality etc. may be completed in HyperMesh.  

 

 
Graphical User Interface Of HyperMesh 
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The  analysis file will be exported either from within HyperMesh or HyperCrash. 

 

Starter and Engine Files 

There are two parts to the Radioss simulation, the Starter and Engine. The Starter is 

an input data check and must successfully complete without errors before the 

simulation can be completed in the Engine. Engine and Starter file can also be 

combined into Single Input File utilizing Merge starter and engine file in Export 

panel. 

 

 
 

Starter File 

The Radioss Starter takes as input the model or commonly called Starter input file 

runname_0000.rad and creates the Starter output file runname_0000.out. The 

Radioss Starter is responsible for checking the model consistency and reporting any 

errors or warnings in the output file. If there are no errors in the model, the Radioss 

Starter creates initial restart file(s), runname_0000_CPU#.rst. 
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Starter Block Format 

• Each block defines one feature: a set of nodes or elements, materials, 

properties, interfaces… 

• Each block starts with a “/” (slash) followed by a keyword and ends at the 

beginning of the next block 

• The content of each block is entered as formatted lines of 100 characters 

divided in 10 fields of 10 characters. 

 

 
 

 

 

 



    
 

66 

Block Format Part Definition /PART 

A Part in RADIOSS is a set of elements with the same property id (prop_ID) and 

material id (mat_ID). In one part all elements are of the same type (e.g. all shells). 

The subset_ID is optional. If omitted, the part belongs to the global model 

 

 
 

 

 
Sample Card Image 



    
 

67 

RADIOSS Starter Listing File 

 

Engine File 

The Radioss Engine takes as input the Radioss Engine file, runname_0001.rad and 

the initial restart file(s) created by the Radioss Starter. The Radioss Engine files 

describes the solution control and output for the simulation. While the Radioss 

Engine is running, an Engine output file, runname_0001.out, is created which 

contains statistics about the simulation including time, time step, current system 

energeies, energy error, and mass error. 

 

• Generates animation & time history output files (Annn Tnnn) 

• Outputs details of the computation (runname_0001.out) 

• Generates runname_0001.rst file for restart (using runname_0002.rad 

engine file) 
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Engine file assistant is a great time saving tool which allows users to import an 

existing engine file or create new with just few clicks in RADIOSS user profile. 

 

https://youtu.be/eDloZ3NEvhY?t=747
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Typical Engine File Keywords 

 

 

Multiple Engine Files 

It is possible to define multiple Engine files to change the solution control and 

output during a simulation. Some common use cases of this powerful feature 

include: 

• Initializing gravity or pre-tension before a simulation. 

• Changing write frequency of output files, such as animation files, (/ANIM/DT, 

/H3D/DT), time history (/TFILE), and restart (/RFILE). 

• Changing the time step control options used, (/DT/Keyword). 

• Modifying system damping (/DAMP, /DYREL, or /KEREL). 

• Adding or removing boundary conditions (/BCS/Keyword) or defining initial 

conditions (/INIV/Keyword). 

• Removing elements (/DEL/Eltyp) or turning on or off rigid bodies 

(/RBODY/Keyword2). 

• Extending simulation run time 
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Running RADIOSS: Option 1 — From Run Manager 

 
Note: This option is not available in the HyperWorks Student Edition 

 

 

Running RADIOSS: Option 2 — From HyperMesh 
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Essential Run Options 

 filename in form: filename_nnnn.rad 

   -starter   Run just the starter 

  -nt nnn   Specify number of CPUs in multiprocessor (SMP) 

run  

  -v ver    Required version of solver (e.g. 13.0)  

  -sp    Specify to run a single precision version of 

RADIOSS  

  -noh3d   Do not generate h3d file from anim files  

  -screen   Display results in the solver control window  

 

RADIOSS Process 
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RADIOSS File Structure (Video By Rahul Rajan, Altair India) (14 minutes) 

 

 

Guidelines to create Engine file for RADIOSS (14 minutes) 

 

https://altair-2.wistia.com/medias/9v47veeusj
https://altairuniversity.com/learning-library/what-you-need-to-know-about-radioss-files/
https://www.youtube.com/watch?v=PZXiybZ8Fds
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Procedure to Restart a RADIOSS Run (10 minutes) 

https://www.youtube.com/watch?v=m29VgFiHk7k
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Frequently Asked Questions (RADIOSS Files) 

How To Set The Number Of Processors For A Run  

For RADIOSS SPMD 

The number of processors has to be defined in command line argument (see 

Command Line Arguments) by option –nspmd (or –np). It is used by RADIOSS Starter 

for the “Domain Decomposition”. 

The same number of processors must be input as a MPI parameter when you launch 

RADIOSS Engine. 

Example: 

[user@machine]$ ./s_11.0_linux964 -nspmd 4 

[user@machine]$ mpirun -np 4 ./e_11.0_linux64 plmpi -nt 2 -input 

CRA2V51_0001.rad 

 

For RADIOSS SMP 

Define the number of SPMD domains to 1, and then define the number of threads by 

domain to a value > 1 (see Help Documentation - RADIOSS > Reference Guide for 

details). 

Check if the number of processors is correctly set by looking at the RADIOSS Engine 

display (standard output or listing file (Runname_0001.out, Runname_0001.lis or 

RunnameLnn): 
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The number of processors has to be defined in Command Line Arguments by option: 

-nthread [INTEGER] or  -nt [INTEGER] at starter. 

 

Example: 

[user@machine]$ ./s_11.0_linux964 -nt 2 -i CRA2V51_0000.rad 

The number of processors must be the same when launch engine and is defined in 

command line argument by option: 

-nthread [INTEGER] or  -nt [INTEGER] at starter. 

[user@machine]$ mpirun -np 1 ./e_11.0_linux64 -nt 2 -input CRA2V51_0001.rad 

 

What Should I Do If The Engine Stops With The Message: ** ERROR IN OPENING 

INPUT FILE?  

** ERROR IN OPENING INPUT FILE 

This message appears, if: 

• RADIOSS Engine input file in V44 (RunnameD01) contains the keyword /VERS/51  
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• RADIOSS Engine input file in V51 (or higher) (Runname_run#.rad) contains the 

keyword /VERS/44.  

 

Parallelism 

What Is The Difference Between RADIOSS SMP And RADIOSS SPMD?  

SMP Version 

SMP stands for Shared Memory Parallelism. 

This version is based on shared memory architecture of computers. 

For this kind of computer, all processors can access to a common memory space. 

Each process can access to all memory allocated by the program. 

 

        
Shared Memory Architecture 

 

Depending on the operating system, this version will be able to use up to 8, 12 or 16 

processors with a reasonable efficiency. The efficiency can be considered as an 

acceptable one if it is greater than 50% (that is to say, the speedup is greater than 

half the number of processors). 

 

SPMD Version 

SPMD stands for “Single Program Multiple Data”. 

RADIOSS Starter divides the model into several domains (equal to number of 

processors asked for). 

Up to RADIOSS Version 4: 
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The data is next sent to each process in RADIOSS Engine; this is the “Parallel 

Initialization”. The first process reads the complete RESTART file, sending the data to 

each other process. 

 

Some additional memory is needed on first process for this operation in this version. 

From RADIOSS Version 5.1: 

RADIOSS Starter writes as many RESTART files as the number of processes which will 

be used for the run. Each RESTART file is built from only the data that will be needed 

by the relative process, and is read directly by this process when running RADIOSS 

Engine. Additional memory is no longer needed for the “Parallel Initialization”. Then 

each program executes on each domain. The management of computation at the 

frontiers of the domains remains and the necessity to communicate some 

information between the processes is implemented through the use of the MPI 

‘Message Passing Interface’. 

 

This SPMD version is free from the computer architecture. It can run on distributed 

memory machines, shared memory machines, workstations cluster or high-

performance computation cluster. 

 

With this version it is possible to use more processors than with the SMP version, 

with a better efficiency. It becomes possible to use more than 128 cores with a good 

speedup. 

 

 
Distributed Memory Architecture For Computer 
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Version 100: Radioss File Extensions 
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5 Element Formulations 
Discretization is the process of dividing a model body into an equivalent system of 

many smaller bodies (finite elements) interconnected at points (nodes or nodal 

points) common to two elements. Suppose we need to find the stresses and 

displacement upon loading an object with arbitrary shape. So in order to model this, 

we need elements that have geometric shape similar to the real structure or region. 

One geometric shape cannot represent all possible engineering structural shapes. 

The user will model with elements that look like beam, truss, plate, cylinder…etc. In 

FEA, by using basic element almost all structures are approximated. The different 

element formulations (1D, 2D, 3D) require different parameters to be set. An 

understanding of FE elements, their types, and their capabilities is the first step to 

ensuring that the performance of the model is as close to the performance of 

empirical study as the numerical model will allow. The basic set of information 

output from a run includes stress and strain and physical displacement and rotation. 

Radioss element library contains elements for one, two or three dimensional 

problems and can be classified into the following categories of elements: 

 

• Solid elements 8- and 20-node bricks, 4- and 10-node tetrahedrons 

• Solid-shells 8- , 16- and 20-node hexahedrons, 6-node pentahedral element 

• 2 dimensional elements 4-node quadrilaterals for plane strain and 

axisymmetrical analysis 

• Shell elements 4-node quadrilaterals and 3-node triangles 

• One dimensional elements rivet, springs, bar and beams 

 

5.1  1D Elements (Line elements) 

RADIOSS incorporates a set of 1D elements for use in FEA modeling. One-

dimensional elements are modeled by connecting two nodes together linearly and 

then assigning constant cross-sectional properties to that element to define the 
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element’s behavior. There are three general types of one-dimensional elements 

available: truss elements, beam elements, and spring elements. 

 

Typical Automotive Applications Of 1D Elements 

 

Overview Of 1D Elements 

 
 

/PROP/TYPE2 or /PROP/TRUSS  

• 2 node element  

• Tensile/compression behavior only (no 

bending stiffness) 



    
 

82 

• Compatible with elastic and elasto-plastic materials (Law 1 and 2) 

• Property defined by cross-sectional area 

• Force output in truss orientation 

• for  modeling cables, ropes, chains 

 

 

 
 

 

/PROP/TYPE3 or /PROP/BEAM 

• Property defined by cross-sectional area and inertias 

• The 1-2 node define element geometry, the 3 node defines the cross 

sectional orientation. 

• 6 DOFs per node (bending and torsional stiffness) 

• ωDOF: flags for release of rotational stiffness at end nodes 

• Based on the Timoshenko formulation, can degenerate into the standard 

Euler-Bernoulli formulation 

• The existence of bending stiffness is the primary difference between beam 

and truss elements 
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/PROP/TYPE18 or 

/PROP/INT_BEAM 

 

• The cross-section of the element is defined using up to 100 integration points 

• Based on the Timoshenko theory and takes into account transverse shear 

strain without warping in torsion 

• Used for deep beam cases (short beams) 

• The section can be partially plastified contrary to the classical beam element 

(TYPE3)  
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/PROP/TYPE4 or /PROP/SPRING 

• Spring elements are also 1D elements which are modelled using 2 

nodes. These elements are commonly used to model connectors in 

the model. 

• Simple physical spring with dashpot 

• 1 DOF per node, tension-compression behavior:  

• Linear elastic:      

• Nonlinear elasto-plastic: 

 

 

 
 

 

Linear and variety of non-linear springs can be defined for SPRING through function 

reference (similar for SPR_PUL, SPR_BEAM and SPR_AXI) 
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Example Spring Property Card 

 

 

/PROP/TYPE8 or /PROP/SPR_GENE 

• Six degrees of freedom spring: three translations and three rotations. 

• Each degree of freedom is independent from the other and is associated with a 

specific stiffness 

• For modeling joints and connections 

• May have a length equal to zero 

• The local coordinate system is determined either by setting a skew or by using 

global coordinate system, when the skew is not given. 

 

• /PROP/TYPE12 or 

/PROP/SPR_PUL 

• Pulley spring property set (with one 

translational DOF) is used to model a 

pulley 

• modeled using a 3 node /SPRING element 

where node 1 and node 3 are the ends of 

the rope and node 2 is the pulley location 
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• This behavior resembles a deformable rope with friction applied at node 2. 

• Should have a non-zero length 

• The spring behavior for a Type 12 is identical to a Type 4. 

 

/PROP/TYPE13 or /PROP/SPR_BEAM 

• 2 or 3 nodes element. 

• 6 degree of freedom per node according to the property 

• For each degree of freedom (3 translation, 3 rotations), the behavior definition 

is similar to the previous spring element. 

• There is coupling between bending and shearing. 

• Uncoupled failure parameters (min, max) for each direction or coupled failure 

model  

• Failure defined function of elongation (strain),force or internal energy. 

• Spring element can be activated of de-activated by sensor. 

 

/PROP/TYPE25 or /PROP/SPR_AXI 

• Axisymmetric Spring 

• Simplification of spring TYPE13 

• Properties of the spring cross-section are considered to be invariable with 

respect to Y and Z 

 

/PROP/TYPE32 or /PROP/(SPR_PRE) 

• Before pretensioning, a piston is fixed in its initial position; when activated, the 

piston is pushed and cannot slide once the piston has reached the end of its slide, 

it is unable to slide further in any direction in the opposite direction from its 

actual position 

• Used to model seat belt pretensioners or apply pretension to a bolt 
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/PROP/TYPE33 or /PROP/KJOINT 

• Kinematic joints are defined by a spring and two local coordinate axes, which 

belong to connected bodies 

• If the axis becomes non-orthogonal during deformation, the stability of the joint 

cannot be ensured 

• Joint properties are defined in a local frame computed with respect to two 

connected coordinate systems. They do not need to be initially coincident 

 

/PROP/TYPE45 or /PROP/KJOINT2 

• Spring elements between node 1 and node 2.  

• Local skew system is defined :  

• Local X : between node 1 and node 3 

• Local Y : between node 1 and node 4 

• Node 1 and Node 2 nodes must be slave node of different rigid bodies.  

• It is recommended to have initially node 1 and node 2 coincident. 

• Null for free degree of freedom 

• Rigid body stiffness for the blocked degree of freedom Possibility to define 

specific stiffness and viscous behavior for each degree of freedom 

• The joint stiffness is automatically computed by default. 

Joints Types: 
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x: denotes a blocked d.o.f. / 0: denotes a free d.o.f 
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Spring Property Summary: 

 

 

Spring elements can have deformation, force and energy-based failure criteria. 

Kinematic joints can be modeled by providing high stiffness to fixed degrees of 

freedom and zero stiffness in the direction which you want to be free. 

 

 
                      1D Elements: BEAM & TRUSS (7 minutes) 

 

https://altairuniversity.com/learning-library/v_beam-and-truss-elements-in-radioss/
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       1D Elements: Spring Type 4 (8 minutes) 

 

 

 
       1D Elements: Spring Type 12 (4 minutes)   

 

 

In the following videos, Rahul Rajan explains in some detail 1D Elements of type: 

https://altairuniversity.com/learning-library/v_b_spring-type-4-in-radioss/
https://altairuniversity.com/learning-library/v_f_spring-element-type-12-in-radioss/
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    1D Elements: Spring Type 13 (22 minutes) 

 

 

 
1D Elements: Spring Type 8 (20 minutes) 

 

https://altairuniversity.com/learning-library/spring-type-13-in-radioss/
https://altairuniversity.com/learning-library/v_e_spring-element-type-8/
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Information Required For Spring (6 minutes) 

 

 

 
            Procedure to Create KJOINT2 in RADIOSS (9 minutes) 

 

 

5.2  2D Elements (Shell Elements) 

Shell elements are 3 or 4 node 2D planar elements with constant thickness, and have 

either a triangular or quadrilateral shape, that can be oriented in the space. They are 

https://altairuniversity.com/learning-library/v_c_required-input-for-spring-elements-in-radioss/
https://altairuniversity.com/learning-library/10-procedure-to-create-kjoint2-in-radioss/
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typically used to model structures such as pressure vessels, automobile bodies, ship 

hulls, aircraft fuselages… etc. Shell elements support all translational degrees of 

freedom as well as all rotational degrees of freedom, that is shell elements have 6 

degrees of freedom. RADIOSS shells are based on Mindlin-Reissner theory that 

includes transverse shear deformation valid for moderately thick and thin shells. 

RADIOSS provides both reduced and fully integrated 4-noded shell elements.  

 

 

Typical Applications Of Shell Elements: 

 
 

 

Overview Of Shell Elements 

• Mass of the element is distributed to the nodes 

• Large rotations with large strains with bilinear shape functions 

• 3-noded shell elements and both reduced and fully integrated 4-noded shell 

elements are available 

• Geometry defined by a curved mid-surface defined with 3 or 4 nodes and a 

thickness h—usually small compared to the two other dimensions 

• Shells include membrane, bending and shear deformation while the normal 

stress (through the thickness) is always zero 
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• RADIOSS shells are based on Mindlin-Reissner shell theory that includes 

transverse shear deformation valid for moderately thick and thin shells 

 

 

 

 

 

 

 

 

 

 

 
 

 

Shell Elements: Reduced Integration Schemes 

• 1 integration point on the surface 

• Widely used in programs with explicit time integration applied in crashworthiness 

studies 

• Dramatically decreases the computation time compared to 4-pt integration 

• Very efficient if the hourglass modes (which result from the reduced integration 

scheme) are properly stabilized.  
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Hour glassing Due To Reduced Integration 

• Reduced integration can lead to non-physical zero energy modes, called 

hourglass modes 

• Two methods used to control formation of hour glassing: 

• Perturbation (Q4 Elements) 

• Physical Stabilization (QEPH Elements) 

 

 
 

Normally hourglass occurs in under integrated elements. The recommended 

parameters for avoiding hourglass, for shell elements, are Ishell=24 (QEPH 

formulation) and keep N=5 (number of integration points through thickness). 

 

Hourglass Perturbation Control Methods: 

Perturbation method Ishell=1,2,3 or 4 (Q4) 

• The hourglass deformation is detected with the relative motion (velocity) of the 

nodes. 
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• When hour glassing is detected, a force is applied on the node to stabilize the 

deformation. 

• This force is defined according the element stiffness (Young modulus, yield 

stress, plastic tangent..) 

• This force introduces an artificial energy (named hourglass energy) 

 

Perturbation method Ishell= 24 (QEPH) 

• Hourglass yield depends on natural yield 

• Hourglass loading stiffness depends on natural tangent modulus 

• The hourglass treatment is done at the material level 

• QEPH is not recommended for orthotropic materials 

 

Hourglass Control Methods Comparison 

• The Q4 (Belytshko & Tsay) elements may have bad behavior in case of large 

rotation and distortion and in case of elastic load-unloading cycles.  

• The QEPH elements give accurate results in case of loading and unloading even if 

there is hourglass mode deformation. 
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The meaning and effects of Hour glassing Video By Rahul Rajan, Altair India (7 

minutes) 

 

 

Key Parameters on/PROP/SHELL 

Ishell  Select element formulation for 4-noded shells 

Ish3n  Select element formulation for 3-noded shells 

N  Choose number of integration points through the thickness 

Ismstr  Specify small or large strain formulation 

Iplas  Choose method for calculating post-yield strains 

Ithick  Determine if thickness is constant under load, or if element thins 

  

/PROP/TYPE1 or /PROP/SHELL: Q4 

 
• 1 integration point on the surface 

https://altair-2.wistia.com/medias/di577pglvl
https://altair-2.wistia.com/medias/di577pglvl
https://altairuniversity.com/learning-library/iv_some-remarks-about-hourglass/
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• Relatively inexpensive 

• Default shell formulation is Ishell = 1 

• Q4 is an under-integrated 4 node element (BT) 

• Hourglass stabilization with perturbation method 

 

PROP/TYPE1 or /PROP/SHELL: QBAT 

 

 
 

• QBAT is a fully integrated 4 node element (Batoz) 

• 4 Gauss integration points on the surface 

• No hourglass deformation 

• 5 local degrees-of-freedoms per node—drilling (rotation around local z) can 

be activated with Idrill 

• No shear locking due to in-plane reduced integration for shear 

• Transverse shear deformation is taken into account 

• Most accurate element, but higher CPU cost (2 to 3 times that of a Q4) 

 

/PROP/TYPE1 or /PROP/SHELL: QEPH 

 

 
 

• QEPH is an improved under-integrated 4 node element with 1 integration 

point on the surface 

• Physical hourglass stabilization 

• Best compromise between cost and quality 

• Generally, QEPH elements costs only up to 15% more than a BT element and 

the results are close to those of QBAT 
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/PROP/TYPE1 or /PROP/SHELL: C0 

 

 
 

• C0 is a standard triangle (C0) with modification for large rotation 

• 1 integration point on the surface 

• No hourglass deformation 

• Low CPU Cost 

 

 

Shell Element Formulation Summary: 

 
 

Number of  Integration Points Through the Thickness: 

 

 
 

• Up to 10 points through the thickness 

• 1 integration point through the thickness give membrane behavior 
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• N = 5 integration points recommended 

 

Shell Strain Formulation 

 

 
 

Small Strain 

• Usually for problems with small deformations 

• Strain computed based on the initial element shape 

Large Strain 

• For problems with large displacements and strains 

• Strain computed based on the current element shape with the derivate of 

the shape function 

• Small strain activation possible in RADIOSS Engine in the event that time 

step reaches D Tmin due to element deformation 

 

Shell Stress Computation 

From the deformation and the strain rate of the previous step, RADIOSS computes 

the strain to each integration point 

From this strain, the stress is computed with a elastic stress increment 

 
 

With these computed stress values, the Von Mises stress is computed and compared 

to the yield stress of the material 
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If the Von Mises stress is smaller than yield stress, the computed stress is the one 

used in order to compute the internal force of the elements 

 

Shell plane stress plasticity 

 

 
 

If the Von Mises stress is bigger than yield stress, RADIOSS will : 

• Update the strain through the thickness (ezz) 

• Compute the new thickness of the shell element 

• Compute the stresses using the material law plasticity surface, the strain and 

the strain rate. The projection of the stress on the plastic surface is done 

with: 

o Radial return (faster)  

o Iterative projection 

with Newton’s method 

(more accurate) 

 

 

 

 

Thickness Change 
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• Initial thickness is used to compute strains and to integrate stresses, but the 

thickness variation is still computed for post-processing reasons 

• If a variable thickness is used, true thickness is computed not only for post-

processing, but also for strain computation and stresses integration. 

• For accurate results, especially when necking or spring back, it is strongly 

recommended to use iterative plastic projection and thickness variation. 

 

Shell Element  Recommendations For Crash Applications: 
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a) With variable thickness and iterative plasticity it is possible to model necking 

failure. The material hardening must be accurate. 

b) For glass, plastic, and glass windshield (3 glass layers, 1 plastic layer and 3 glass 

layers). Less accuracy, 2+1+2 can also be used. For more complex glass plastic 

windshields, more layers can be used. 

c) If elastoplastic hourglass (3) is used, it is recommended to use 0.1 for hm and hf 

and default for hr. 
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Composite modeling techniques: 

• Each Layer with at Least One Solid: The model is large which leads to high 

accuracy results but need more computation resource. 

 

 

 

• Mixed Approach (Middle Layer Thick): Defines shells for top and bottom 

layer and solid for middle layer. 

 

 

 

• Sandwich Shell Approach: Use only one shell element through the thickness. 

Use different materials to define multiple layers. 
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In composite shell modeling there are two types of problems: 

1. Composite shell with isotropic layers (orthotropic in z direction). An example 

is laminated Windshield, where material LAW27 (PLAS_BRIT) or LAW36 (PLAS_TAB) 

can be used. 

2. Composite shell with orthotropic layers (orthotropic in x, y and z). An  

example is Sandwich shell with external fiber glass layers and internal foam layer, 

where material LAW25 (COMPSH) and all shell formulations can be used, except for 

QEPH. 

 

Modeling composite in Radioss could be defined by Layer based or Ply based with 

different property: 

• Layer based modeling with /PROP/TYPE10 (SH_COMP), /PROP/TYPE11 

(SH_SANDW) 

• Ply based modeling /PROP/TYPE17 (STACK), /PROP/TYPE51, 

/PROP/PCOMPP+/STACK, /PROP/TYPE19 (PLY) and /PLY 

 

 

 



    
 

106 

For ply-based modeling, info (like material, thickness, anisotropic angle, anisotropic 

axis angle and number of integration points) for each ply defined in /PROP/TYPE19 

(or /PLY) and assembled in /PROP/TYPE17 or /PROP/TYPE51 (or /STACK) with option 

Pply_IDi. 

 

 

 

For ply-based modeling, the way to assemble plies could be “by ply” or “by 

substack”. “By ply” is simply pile up plies one by one from bottom to top. The way 

“by substack” need first pile up plies one by one to create each substack, and then 

each substack could either be combined or could also be stacked with substack 

connection “INT”. 
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Layer (Ply) Number N (Nply_ID ) and Integration Points each Layer(Ply) 

For layer-based modeling which use /PROP/TYPE10, /TYPE11. N is the number of 

layers through the shell thickness. For these properties, there is one integration 

point (IP) each layer. 

For ply-based modeling, which use /PROP/TYPE17, /TYPE51 and /PCOMPP. Pply_IDi 

is the number of plies through the shell thickness. Plies could be combined until n 

plies for these properties. 

For TYPE17 only one integration point is allowed while for TYPE51 and /STACK up to 

9 integration points are allowed. Number of integration point defined with option 

“Npt_ply” in property TYPE19 or /PLY. 

 

Example (Ply) (/PROP/TYPE51) 

In this example, Npt_ply=3 defined in /PROP/TYPE19, means 3 integration points 

defined per ply and with option Iint=0 defined in /PROP/TYPE51, then these 3 

integration points are uniformly distributed through each ply thickness. If Iint=1 in 

/PROP/ TYPE51, then integration points are distributed to follow Forces and 

Moments Calculation Gauss Integration Scheme through each ply thickness. 
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Anisotrophy in Layer (Ply) 

The first anisotropic direction of material could be defined with angle ϕ and global 

vector (Vx ,Vy ,Vz ). It is also possible to use angle ϕ and skew. In this case, x-axis of 

skew replaced the global vector V. 

Project the global vector in shell element and then rotate ϕ degree is the first 

anisotropic direction (also called Material direction 1). The positive direction of ϕ is 

according to shell normal. 

The material direction 1 of the local element reference is normally the fiber 

direction. Then the material character (E-Module, yield stress, and so on) of 

direction 1 which defined in material law could be then applied in the correct 

direction on local element reference. 

 

 
   

 

Composite material could be orthotropic or anisotropic. In Radioss it is possible to 

describe this character with anisotropic axis angle αi in ply-based properties. In case 

of αi=900, then it describes orthotropic material. For layer based properties (TYPE10 

and TYPE11) which without this option , so that only orthotropic material could be 

defined. 

 

Layer (Ply) Thickness and Position 

• For /PROP/TYPE10, layer thickness is simply averaged by layer number and are 

automatically overlying one by one from bottom to top. 

• For property TYPE11, TYPE17, TYPE51 and /STACK, layer (ply) position and 

thickness depend on option Ipos 
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• For property TYPE17, TYPE51 and /STACK, it is also possible to offset the plies 

with Ipos = 2, 3, 4 

• For /PROP/TYPE17, /PROP/TYPE51 and /STACK, ply thickness could be changed 

by option in /DRAPE (which is used in /PROP/TYPE19 or /PLY). 

 

 
 

 

Comments On Shell Modeling Practices 

• Mesh on neutral fiber (midsurface) 

• Create homogeneous mesh size for each part 

• Have minimum of 6 elements per buckle wavelength 

• Use 3 elements on flanges 

• Suppress holes smaller than reference mesh size 

 

 

Shell Element Quality: 
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5.3 Solid Elements 

The available 3D solid elements are tetrahedral (4 faces), pentahedral (5 faces), 

pyramid (5 faces) and hexahedral (6 faces) elements. Brick or tetrahedral elements 

may have different number of nodes and Solid elements support only translational 

DOF. They are used to model solid objects where beam and shell elements or are 

inappropriate to model them (all three dimensions are comparable). 

• Geometry defined by nodal location 

• Hexahedron and tetrahedron with linear and quadratic interpolation 

functions 

• Linear elements are better in terms of time and memory consumption, 

especially  due  to  the  low  number  of  integration points and a larger time step 

• Penta (6-noded) elements used in mesh transitions are degenerated 

hexahedrons (handled by pre-processor) 
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Based on mechanics of continuum, a three dimensional solid can be classified in a 

given category. For a solid with dimensions R, L and t, with t being the thickness, L is 

the working direction and R is the curvature radius, write: 

• If L/t > 20 and R/t > 20: Thin shell assumptions are valid (Kirchhoff or Mindlin 

shell models) 

• If 10 < L/t < 20 and 10 < R/t < 20: Moderately thick shell (Mindlin model) 

• If 4 < L/t < 10 and 4 < R/t < 1: Thick shell 

• If L/t < 4 or R/t < 4: Solids 

An adapted finite element mesh is then applied to each case: 

• Shell theory: 2D mesh of the mid-surface 

• Thick shell: 3D mesh with constant normal stress assumption 

• Solids: 3D mesh without constant normal stress assumption 

In Radioss all of these formulations are available. For a given mesh, several kinds of 

formulations may be available based on: 

• The number of integration points 

• The stress updating method 

• Large or small strain assumption 

• Plasticity options for necking and material law integration 

• Type of element and hourglass formulation 
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                                             Typical Applications of 3D elements 

 

 

Overview Of Solid Elements 
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/PROP/TYPE14 or /PROP/SOLID 

• Isolid  Choose hex element formulation 

• Itetra  Choose tetra element formulation 

• Ismstr  Specify small or large strain formulation 

• Iframe Select co-rotational formulation if required (hex only) 

• IHKT  Choose tangent modulus estimation method 

 

/PROP/TYPE14 or /PROP/SOLID: Brick8 

 

 
 

• Brick8 is a reduced integration, 8 node 

element with linear interpolation 

• 1 point integration 

• Viscous (penalty) hourglass stabilization 

• Characteristic length,  
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• Relatively inexpensive 

 

/PROP/TYPE14 or /PROP/SOLID: HA8 

 

 
 

• HA8 is a fully integrated, 8 node element 

• Number of integration points, Inpts, can be specified, from 2x2x2 to 9x9x9 

• No hourglassing 

• Relatively expensive 

 

/PROP/TYPE14 or /PROP/SOLID: H8C 

 

 
 

• H8C is a fully integrated, 8 node element 

• Number of integration points 2x2x2 

• No hourglassing, Relatively expensive 

 

/PROP/TYPE14 or /PROP/SOLID: HEPH 

 

 
 

• HEPH is an improved reduced integration, 8 node element 

• 1 point integration 

• Physical hourglass stabilization 
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• Best compromise between cost and quality 

• HEPH is not recommended for orthotropic materials 

 

/PROP/TYPE14 or /PROP/SOLID: Tetra4 

 

 
 

• Tetra4 is a 4-noded solid 

• 1 point integration 

• No hourglassing 

• Shear locking 

• Characteristic length,   

• Relatively inexpensive 

 

/PROP/TYPE14 or /PROP/SOLID: Tetra4 

 

 
 

• Tetra4 is a 4-noded solid with 6 DOF per node & 4 point integration 

• Displacement of the dummy nodes is computed on the basis of rotational DOF 

• High time step versus 10 nodes tetra element with same accuracy 

• Shear locking effect low or negligible (it may appear in bending) 

• Compatibility with shells 

• Characteristic length,  
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Solid Element Summary: 

 

 
 

Solid Strain Formulation 

 

 
 

Element Coordinate System 

 

 
 

• Co-rotational formulation is more accurate if large rotations are involved, at the 

expense of higher computation cost 

• It is recommended in cases of elastic or visco-elastic problems with important 

shear deformations or in the case of large rigid body motions. 
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Hourglass Tangent Modulus 

 

 
 

• Default is fine for most cases 

• Recommend to use IHKT = 2 with HEPH and Lagrange type total strain, Ismstr = 

10 for foam or rubber materials (laws 38, 42, 69, and 82) 

 

Solid Elements Recommendations for Crash Applications:       
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For Foam or Rubber Materials (Law 38, 42, 62, and 82): 

 

 
 

Note: For Ismstr = 10 engineering stress-strain curves are required 
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For Foam Material (Law 70): 

 

 
 

Note: For Ismstr = 1 engineering stress-strain curves are required 

 

 
 

Note: The Isolid flag is ignored for /TETRA4 and /TETRA10 elements as these elements 

have their own specific formulation 

 

/PROP/TYPE6 or /PROP/SOL_ORTH: Orthotropic Solid 

• Used to define the fiber plane for /MAT/LAW14(COMPS0), the steel 

reinforcement direction for /MAT/LAW24 (CONC) or the cell direction for 

/MAT/LAW28 (HONEYCOMB). 

• This property is only available for 8-node linear solid elements (/BRICK), 

tetrahedron elements (/TETRA4 and /TETRA10), and 2D solid elements (/QUAD). 

Quadratic bricks (/BRIC20 and /SHEL16) and pentahedron elements (/PENTA6) 

are not compatible with this property. 

• three different ways to define orthotropy direction: 

o With Ip= 0 and skew_ID ≠ 0, skew is used. 
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o With Ip = 1, 2 or 3, orthogonalized isoparametric system (r’-s’-t’) and 

orthotropic angle are used 

o With Ip = 11, 12 or 13, orthogonalized isoparametric system (r’-s’-t’) and 

reference vector V are used 

 

Overview of Thick Shell elements: 

 

 

 

 

 

 

 

 

/PROP/TYPE20 or /PROP/TSHELL: Thick Shell 

• The elements HA8, HEPH and BRICK20 can be transformed to solid-shell 

elements by setting constant the normal stress through the thickness. 

• This assumption allows obtaining solid elements suitable for thick-shell 

modeling, where only one element through a thickness can be used. 

• In additional to these elements, SHELL16, PA6 and other solid-shell elements 

are available. 

• Solid-shell elements, especially SHELL16 can be useful to model thick shell 

structures with massive junctions 

• The time step proportion to the shortest distance between two nodes can 

be small depending on the thickness and material characteristics 

 

Mesh 

 

Element Name 

Number of 

Integration Points 

Hourglass 

Formulation 
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HSEPH 

Inplane: 1 

In thickness: up to 9 

 

Physical stabilization 

HA8 From 2x2x2 to 9x9x9 --- 

 

 

 

 

PA6 

 

Inplane: 1 

In thickness: up to 9 

 

 

--- 

 

 

 

 

SHELL16 

 

Inplane: 3x3 or 2x2 

In thickness: up to 9 

 

 

--- 

 

 

 
 

In this video Rahul Rajan discusses different 2D elements (18 minutes) 

 

https://altair-2.wistia.com/medias/9ahjo4tqz8
https://altair-2.wistia.com/medias/9ahjo4tqz8
https://altair-2.wistia.com/medias/9ahjo4tqz8
https://altair-2.wistia.com/medias/9ahjo4tqz8
https://altairuniversity.com/learning-library/v_g_2d-shell-elements-in-radioss/
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Watch this video by Rahul Rajan to learn more about 3D element formulations (15 

minutes) 

 
 

Question 

While running RADIOSS I’m getting this error as below 

MESSAGE ID :          169 

 ** STOP : ZERO OR NEGATIVE VOLUME 

  FOR 4 NODES TETRAHEDRON ID=121736, INTEGRATION POINT=1 

  Is there any options/ method to remove this error? 

• The NEGATIVE VOLUME error happens when solid elements are very deformed 

and their characteristic length goes to 0. For large strain formulation the time 

step of an element goes to 0 when the element is compressed. In RADIOSS 

Starter input file (Runname_0000.rad), use Ismstr =2 in the solid property and in 

        RADIOSS Engine file (Runname_0001.rad) use the option/DT/BRICK/CST which will 

set the time step value tmin at which the solid elements will switch to small strain. 

This means that the solid elements using Ismstr =2 will use large strain formulation 

while their time step remains greater than tmin, and will then switch to small strain 

formulation. 

        (/DT/BRICK/CST option is used to control the time step of the analysis. The time 

step becomes constant after reaching Tmin specified by the user). 

https://altairuniversity.com/learning-library/v_h_solid-elements-in-radioss/
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5.4  Frequently Asked Questions (Elements) 

The Run Stopped With The Message: “Zero Or Negative Volume”, When Solid 

Elements Are Used With Ismstr=2 and /DT/BRICK/CST; Is This Normal?  

Ismstr =1, 2 and 3 are not available for the 8 integration points solids using 

formulations Isolid =12 and 112. 

This means that these solids continue to use large strain formulation, and hence the 

following error message appears: “Zero or Negative Volume” 

In order to use this small strain formulation with 8 integration points solid elements, 

use the HA8 solid formulation which is available as of RADIOSS V44. 

When using this formulation, set Isolid =14 with Inpts =222 (corresponding to Isolid 

=222 in input format 44). Also set Icpre =1 for elastic or visco-elastic material law, 

and Icpre =2 for elasto-plastic laws. 

 

I Used Solid Elements And Several Integration Points, And Starter The Following 

Error Message Appears, While The Element Seems To Be Well-Defined: ** ERROR:  

ZERO OR NEGATIVE 3D SOLID VOLUME, is This Normal?  

** ERROR:  ZERO OR NEGATIVE 3D SOLID VOLUME 

 

 
 

ZERO OR NEGATIVE VOLUME 3D-ELEMENT NB 1  

In the figure above, the volume of the element is positive, but the sub-volume 

associated to one integration point is negative. The solid is decomposed into sub-

volumes associated to each integration point. If the element is badly warped, one 

sub-volume could be negative 
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How Many Integration Points Should Be Used In The Thickness Of Shell Elements?  

If only one integration point is used, a membrane only behavior will be obtained 

(except with law 1, up to V44). Some materials, such as fabric, can justify such a 

choice (no bending stiffness). 

In case of an elastic behavior, one gets the exact solution from three integration 

points – that is to say that the bending moments are exactly integrated through the 

thickness of the shell – and it is not necessary to use more integration points. 

In case of a plastic behavior, the bending moments are not integrated exactly. Using 

more integration points, the solution becomes more accurate; so it is recommended 

to use five integration points. 

 

   
 

I Am Using Material Law 1 With 1 Integration Point Through the Thickness And Still 

Get Bending Moments; Why?  

Up to V44, Material Law 1 for shells does not use integration points but switches to 

the global formulation (corresponding to N=0); whatever the number of integration 

points N is asked for. So up to V44, there is no way to use this material law with only 

one integration point and membrane only behavior. 

Workaround: use Material Law 2 with integration point and a huge value for the 

yield stress. 

As of V51, Material Law 1 for shells uses global formulation, except if one integration 

point is asked for in the property, then a membrane only behavior occurs. Note that 

this can explain some differences in the results between versions up to V44 and V51. 
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With Shell Elements Using The Same Material Law, But Different Types Of 

Properties (While Keeping The Same Number Of Integration Points), I Do Not Get 

The Same Results; Why?  

The integration scheme which is used for property types 1 and 9 (relative to 

isotropic shells through the thickness) sets the integration points and weights in 

order to integrate exactly the bending moments in the elastic case (from three 

integration points since for one integration point, no bending moments are 

computed). 

The integration scheme which is used for property types 10 and 11 is a step-by-step 

integration scheme and uses integration points at the center of each layer, and 

weights which correspond to the relative thickness of each layer. So the integration 

scheme is not the same one. 

An error relatively important can occur in the elastic field, when there are a few 

layers or large differences on the thicknesses of the layers. One way to work around 

this problem is to subdivide the thicker layers. But it is generally not well-suited in 

case of modeling the failure of the layers. 

  

 
 

Elastic Case: 

Stress is linear through the thickness; an integration of forces step-by-step is exact. 

But the integration of moments, step-by-step is not exact since symbol(z) z is 

quadratic. 
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When Is It Better To Use QEPH Shells Instead Of Belytschko Shells?  

QEPH shells are more accurate for elastic or elasto-plastic loads, whatever the 

loading type - quasi-static or dynamic; but they are not recommended with 

anisotropic and orthotropic material laws. 

QEPH shells will give better results if the mesh is fine enough. In case of a coarse 

mesh, this formulation will be too stiff and some local buckling phenomena could be 

missed. In case of a coarse mesh, the Belytschko shells often give better results. 

QEPH/HEPH is not recommended for orthotropic materials because the stabilization 

forces are computed based on isotropic assumptions 

  

I Used Solid Elements And The Run Stopped Before The End Time, With The 

Message: “Zero Or Negative Volume”: How Can This Problem Be Solved?  

This happens when solid elements are very deformed and their characteristic length 

goes to 0. You may notice in the output file that before getting this error message, 

the time step of the element written into the message drops down. 

In case of large strain formulation, the time step of an element goes to 0 when the 

element is compressed. In a mathematical way, the element cannot reverse its 

orientation since its stiffness increases to an infinite value; but due to numerical 

accuracy, the element may go to reverse its orientation. 
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In order to solve the problem of both the drop in cycle time step and subsequent 

termination of the run due to a negative volume, you might first check that the 

material used is well-suited to the physics which is represented. Then switch the 

elements to small strain formulation. This is done as follows: 

In the RADIOSS Starter input file (Runname_0000.rad), use Ismstr =2 in the solid 

property or in the option /DEF_SOLID; in RADIOSS Engine file (Runname_0001.rad) 

use the option / DT/BRICK/CST which will set the time step value symbol_tritmin at 

which the solid elements will switch to small strain. 

This means that the solid elements using Ismstr =2 will use large strain formulation 

while their time step remains greater than symbol_tritmin, and will then switch to 

small strain formulation. 

Their volume will then remain constant and the element can even reverse its 

orientation. The drop of their time step normally stops except for some materials, 

especially viscous materials. 

 

5.5  Frequently Asked Questions (Property) 

Question 

I have a problem using PROP16 for fabric shell. THICK is defined in global thickness 

as 0.93, then three layers are set each 0.31 mm thickness. 

What is the meaning of the following error? 
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Answer 

This error means the number of layers in your model is higher than 1. As mentioned, 

you defined three layers which is not allowed for /PROP/TYPE16. The following input 

parameters are available in /PROP/TYPE16: 

Thick: Shell thickness 

N: Number of layers, with 1 < N < 100, Default set to 1 (Integer) 

Ti: Thickness of layer i (currently only one is allowed) 

Since this property is currently compatible with Elastic Anisotropic Fabric 

(/MAT/LAW58 - FABR_A), only one layer is allowed. It is recommended: 

Thick = 1*T1 

/PROP/TYPE16 + /MAT/LAW58 will consider only membrane stress, no bending 

stress, since fabric cannot resist bending. 
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Question 

Which strain formulations are available for connection element with 

/PROP/CONNECT?  

/PROP/CONNECT is used only for /MAT/LAW59. This element formulation is based 

on relative elongation of element in normal and shear direction. This allows avoiding 

the dependence of element time step from element height. Element height can be 

even equal to 0. Note that material stiffness is specified in normal and in shear 

direction. Material has no stiffness in lateral direction. Therefore, it is always advised 

to couple nodes of LAW59 elements to some Lagrange components either directly or 

through a tied contact. 

The parameter Ismstr in /PROP/CONNECT specifies how the nodal forces are 

calculated from stresses.  

For Ismstr=4 use the actual middle area of the element and for Ismstr=1 use initial 

middle area. This is implemented in order to avoid time step drop, when LAW59 

element separates from master surface (due to the failure of master surface 

elements) and it starts to expand laterally. 
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6 Materials 
Any good simulation depends on the inputs provided and an experienced analyst will 

always evaluate and confirm the correctness of the inputs to get the best results of 

the analysis. Attention should be given to the material type chosen and the material 

properties provided. There could be different material properties needed as input to 

fully characterize a material for analysis purposes. Any unclear or illogical data 

provided during material characterization will lead to invalid results. Choosing the 

right material and providing the reliable material data in performing a simulation is 

very important. RADIOSS provides one of the most comprehensive material and 

rupture libraries in the industry. The material laws and rupture criteria span across 

definitions for concrete, foam, rubber, steel, composites, biomaterials, and more. 

The choice of a constitutive law for a given material depends at first to desired 

quality of the model. For example, for standard steel, the constitutive law may take 

into account the plasticity, anisotropic hardening, the strain rate, and temperature 

dependence. However, for a routine design maybe a simple linear elastic law is 

sufficient to obtain the needed quality of the model. This is the analyst design 

choice. On the other hand, the software must provide a large constitutive library to 

provide models for the more commonly encountered materials in practical 

applications. The available material laws classification: 

 

• Isotropic Elastic 

• Isotropic Elasto-Plastic 

• Composite and Fabric 

• Hyper and Visco-elastic 

• Concrete and Rock 

• Honeycomb 

• Hydrodynamic 

• Connections 

• Other 
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• Multi-Material, Fluid and Explosive 

The constitutive laws may be used by the analyst for general applications or a 

particular type of analysis. You can also program a new material law in Radioss. This 

is a powerful resource for the analyst to code a complex material model. 

In this chapter we will have a look at the following material laws: 

Law 1 – Elastic 

Law 2 – Johnson-Cook 

Law 25 – Composite 

Law 27 – Elastic-Plastic Brittle 

Law 28 – Honeycomb 

Law 36 – Elastic-Plastic Tabulated 

Law 42 – Ogden (Hyperelastic) 

Law 69 – Ogden & Mooney-Rivlin (Hyperelastic) 

Law 70 – Foam 

 

Mechanical characterization of materials 

The typical material test for metal is tensile test. With this test strain-stress curve, 

yield point, necking point and failure point of material could be observed. Engineer 

strain- stress curve could be generated by: 

 

S0=Section area in the initial state 

 

l0=Initial length 

In this Force-elongation curve or engineer stress-

strain curve, three points are important: 

1. Yield point: where material begins to yield. Before yield you can assume 

material is in elastic state (the Young's modulus E could be measured) and after 

yield, material plastic strain which is non-reversible. Some material in this test will 

first reach the upper yield point (R ) and then drop to the lower yield point (R ). In 

engineer stress-strain curve, lower yield stress (conservative value) could be taken. 
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Some material can not easily find yield point. Take the stress of 0.1 or 0.2% plastic 

strain as yield stress. 

2. Necking point: where the material reaches the maximal stress in engineer 

stress-strain curve. After this point, the material begins to soften. 

3. Failure point: where material failed.  

 

 
 

True stress-strain curve which is requested in most materials in Radioss, except in 

LAW2, where both engineer stressstrain and true stress-strain are possible to input 

material data. True stress and true strain can be calculated: 

σtr = σeexp (εtr)     εtr = ln (1 + εe) 
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The result is true stress-strain curve (red). Plastic true stress-strain curve is shown in 

green, which plastic strain begin from 0. This green plastic true stress-strain curve is 

what you need, as in LAW36, LAW60, LAW63, and so on. The true stress-strain curve 

is valid until the necking point of the material. After the necking point, the material 

curve has to be defined manually for hardening. Using a different material law, 

Radioss will extrapolate the true stress-strain curve to 100%: 

• Linear extrapolation: If stress-strain curve is as function input (LAW36), then 

stress-strain curve is linearly extrapolated with a slope defined by the last two points 

of the curve. It is recommended that the list of abscissa value be increased to a 

value greater than the previous abscissa value. 

• Johnson-Cook: After necking point, Johnson-Cook hardening is one of the 

most commonly used to extrapolate the true stress-strain curve. 

• Swift and Voce 
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6.1  Isotropic Elasticity 

/MAT/LAW1 (ELAST) Linear Elastic Material 

/MAT/ELAST defines an isotropic, linear elastic material using Hooke’s law. This law 

represents a linear relationship between stress and strain. It is available for truss, 

beam (type 3 only), shell and solid elements. This material law is used to model 

purely elastic materials. The material stiffness is determined by only two values: the 

Young’s modulus (E), and Poisson’s ratio (n). The shear modulus (G) can be 

computed using E and n: 

Can only be used for parts that are stressed below the yield strength. 

 

 

Note: The value of density is always used in explicit simulations. 

 

6.2  Isotropic Elasto-Plastic 

Model Description Law  

Number 

Johnson-Cook (2) 

Zerilli-Armstrong (2) 

von Mises isotropic (3) 

hardening with polynomial 

pressure 

Johnson-Cook (4) 

Gray model (16) 

Ductile damage for solids (22) 
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and shells 

Ductile damage for solids (23) 

Aluminum, glass, etc. (27) 

Hill (32) 

Tabulated piecewise linear (36) 

Cowper-Symonds (44) 

Zhao (48) 

Steinberg-Guinan (49) 

Ductile damage for porous 

materials, Gurson 

(52) 

Foam model (53) 

3-Parameter Barlat (57) 

Tabulated quadratic in 

strain rate 

(60) 

Hänsel model (63) 

Ugine and ALZ approach (64) 

Elastomer (65) 

Visco-elastic (66) 

Anisotropic Hill (72) 

Thermal Hill Orthotropic (73) 

Thermal Hill Orthotropic 3D (74) 

Semi-analytical elasto-

plastic 

(76) 

Yoshida-Uemori (78) 

Brittle Metal and Glass (79) 

High strength steel (80) 

Swift and Voce elasto-

plastic Material 

(84) 

Barlat YLD2000 (87) 

 

/MAT/LAW2 (PLAS_JOHNS) Johnson-Cook Material 

This law represents an isotropic elasto-plastic material using the Johnson-Cook 

material model. This model expresses material stress as a function of strain, strain 

rate and temperature. A built-in failure criterion based on the maximum plastic 

strain is available. 
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How To Determine Parameters 

If material is not temperature or strain rate sensitive, then:  

Calculate true stress and strain from engineering values from tensile test: 

       σy ≅ Sy          σu = Su(1+ eu)        εu = ln(1+ eu)  

Iflag=1 automatically determines Johnson-Cook parameters based on: 

• Yield stress (SIG_y) 

• Ultimate tensile engineering stress (UTS) 

• Engineering strain ( EPS_UTS ) at necking point. 
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(Note: Mind the conversion of true stress vs. engineering stress. A brief “discussion” 

about this topic is included in the free Study Guide “Practical Aspects of Finite 

Element Simulation”) 

 

/MAT/LAW2 or /MAT/JOHNS: Example Mild Steel 

Mild steel material model with rupture defined on material card. Failure of the 

element happens when 1 integration point reaches εp
max 

 

 
 

 

 
 

 



    
 

138 

/MAT/LAW2 or /MAT/JOHNS: Optional Failure Model 

Using the Johnson-Cook failure model /FAIL/JOHNSON along with the Johnson-Cook 

material model provides more user control of the failure Johnson-Cook failure strain 

definition: 

 

 
 

Include /FAIL/JOHNSON to define element failure criteria 

 

 
 

Mild steel applied to tensile and compression specimen using failure on 

/FAIL/JOHNSON 
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/MAT/LAW36 (PLAS_TAB) Elastic Plastic Piecewise Linear 

Material 

This law models an isotropic elasto-plastic material using user-defined functions for 

the workhardening portion of the stress-strain curve (for example, plastic strain vs. 

stress) for different strain rates. 

Note: The first point of yield stress functions (plastic strain vs stress) should have a 

plastic strain value of zero. If the last point of the first (static) function equals 0 in 

stress, default value of ep
max is set to the corresponding value of ep. (for more 

information please see the Hyperworks Help Documentation)  

 

• Isotropic elasto-plastic material  

• User-defined function for the work-hardening portion of the stress-strain curve 

• Available for brick and shell elements 
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• Elastic portion of material stress-strain curve defined by Young modulus and 

Poisson’s ratio 

• Material plasticity curves can be given for up an arbitrary number of strain rates 

• Linear interpolation of strain-stress curve  

o For a given strain rate 

o For a given plastic strain 

In order to avoid poor curve extrapolation during the strain calculation, a dummy 

curve defined for a high strain rate value can be added in the model—typically the 

highest strain rate curve is repeated. 

The curves have to be defined such as they don’t intersect themselves in the strain 

range being used. Otherwise the calculation may fail. 

 

There are 4 damage and rupture parameters: 

• εp
max is the maximum plastic strain for element deletion for any loading (tensile , 

shear or compression). 

• εt is the beginning of tensile damage. From this point the stress value defined in 

the curve is reduced by the factor                          

where ε1 is the largest principal strain 

• εm is the end of the tensile damage. The stress value is null but the element is 

not deleted 
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• εf is the tensile failure strain value for element deletion 

Note: The first point of yield stress functions (plastic strain vs stress) should have a 

plastic strain value of zero. 

 

 

 

 

 

 

 

 

 

 

Example /MAT/PLAS_TAB card image: 
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/MAT/PLAS_TAB or /MAT/LAW36 : Yield Stress Function 

 
 

Law36 & Law 43 function input: 

 

                 

Correct 

 

 

 

              

Incorrect 

 

 

 

/MAT/PLAS_TAB or /MAT/LAW36 : Example Mild Steel 

Results show failure in tension because of tensile failure criteria on material card 



    
 

143 

 
 

 

Example /MAT/PLAS_TAB card image with Johnson Cook failure model 

 
 

Results using failure criteria on/FAIL/JOHNSON failure card 
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/MAT/PLAS_TAB or /MAT/LAW36 : Yield Stress vs Pressure 

If the yield stress is pressure dependent, then a scale factor can be applied via a 

function, fct_Idp 

Function fct_Idp is used to distinguish the behavior in tension and compression for 

certain materials (that is: pressure dependent yield) 
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Example of pressure dependent yield stress on crush tube 

 

 
 

/MAT/PLAS_TAB or /MAT/LAW36 : Yield Stress Vs Pressure Example of pressure 

dependent yield stress on crush tube—card image 
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Result of pressure dependent yield stress on crush tube:  

 

 

 

/MAT/LAW27 (PLAS_BRIT) Elasto-Plastic Material with Brittle 

Failure 

• This law combines an isotropic elasto-plastic Johnson-Cook material model with 

an orthotropic brittle failure model. Material damage is accounted for prior to 

failure. Failure and damage occur only in tension. This law is applicable only for 

shells. 

• Yield surface definition same as Johnson-Cook (Law2) 

• Useful for modeling brittle failure of glass 

• Damage and rupture defined with 4 parameters for each principal direction: 

et   = Strain at the beginning of tensile failure  

em = Maximum tensile strain at which the stress in the element is set to a value 

dependent on dmax1 

dmax = Maximum damage factor  

ef = Maximum tensile strain for element deletion 
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/MAT/LAW27 or /MAT/PLAS_BRIT: Example Safety Glass 
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6.3 Composite and Fabric 

/MAT/COMPSH or /MAT/LAW25: 

Composite shell and solid material 

Two variations of the same material law type 25: 

• If the formulation flag Iform = 0, the plasticity 

model is based on standard (Tsai-Wu) formulation is 

used. 

• If the formulation flag Iform = 1, the plasticity 

model is based on CRASURV formulation is used. 

This material is assumed to be orthotropic-elastic before the Tsai-Wu / CRASURV 

criterion is reached. The material becomes nonlinear afterwards. For solid elements, 

the material is assumed to be linearly elastic in the transverse direction. The Tsai-Wu 

criterion can be set dependent on the plastic work and strain rate in each of the 

orthotropic directions and in shear to model material hardening. Strain and plastic 

Tsai-Wu for solid (12) 

Composite Solid (14) 

Composite Shell 

Chang-Chang 

(15) 

Fabric (19) 

Composite Shell (25) 

Fabric (58) 
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energy criterion for brittle damage and failure is available. A simplified delamination 

criterion based on out-of-plane shear angle can be used. 

 

 

 Shell Element Brick Element Failure Model 

 

 

 

LAW12 

 /PROP/TYPE6 

(SOL_ORTH) 

/PROP/TYPE21 

(TSH_ORTH) 

 

/PROP/TYPE22 

(TSH_COMP) 

/FAIL/HASHIN 

/FAIL/PUCK 

 

/FAIL/LAD_DAMA 

 

 

 

LAW14 

 /PROP/TYPE6 

(SOL_ORTH) 

/PROP/TYPE21 

(TSH_ORTH) 

 

/PROP/TYPE22 

TSH_COMP) 

/FAIL/HASHIN 

/FAIL/PUCK 

 

/FAIL/LAD_DAMA 

 

 

 

 

LAW15 

/PROP/TYPE9 (SH_ORTH) 

/PROP/TYPE10 (SH_ORTH) 

 

/PROP/TYPE11 (SH_SANDW) 

 

/PROP/TYPE17 (STACK) 

 

/PROP/TYPE19 (PLY) 

  

 

 

 

/FAIL/CHANG 

 /PROP/TYPE10 (SH_ORTH)   

 /PROP/TYPE11 (SH_SANDW) /PROP/TYPE6 

(SOL_ORTH) 

/FAIL/CHANG 
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/PROP/TYPE17 (STACK) 

/PROP/TYPE14 (SOLID) /FAIL/HASHIN 

LAW25  

/PROP/TYPE19 (PLY) 

/PROP/TYPE20 (TSHELL) /FAIL/PUCK 

  

/PROP/TYPE51 

/PROP/TYPE21 

(TSH_ORTH) 

 

/PROP/TYPE22 

TSH_COMP) 

/FAIL/LAD_DAMA 

(for solid only) 

 /PROP/PCOMPP   

LAW19 /PROP/TYPE9 (SH_ORTH)   

LAW58 /PROP/TYPE16 (SH_FABR)   

 

6.4  Hyper and Visco-elastic Materials 

Closed cell, elasto-plastic foam (33) 

Boltzman (34) 

Generalized Kelvin-Voigt (35) 

Tabulated law (38) 

Generalized Maxwell-Kelvin (40) 

Ogden-Mooney-Rivlin (42) 

Hyper visco-elastic (62) 

Tabulated input for Hyper-elastic (69) 

Tabulated law - hyper visco- 

elastic 

(70) 

Tabulated law - visco-elastic 

foam 

(77) 

Ogden material (82) 

Simplified hyperelastic material 

with strain rate effects 

(88) 

Tabulated law - visco-elastic 

foam 

(90) 

Arruda-Boyce Hyperelastic 

Material 

(92) 

Yeoh hyperelastic material (94) 

Bergstrom-Boyce Nonlinear 

viscoelastic material 

(95) 
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/MAT/OGDEN or /MAT/LAW42 : Ogden, Mooney-Rivlin 

Visco Hyperelastic behavior (non-linear elastic) is generally used to model 

incompressible rubbers, polymers, foams, and elastomers. This material can be used 

with shell and solid elements. 

 

Stress – strain relationship is based on the strain energy density, W:  

The stress corresponding 

to this strain energy is:  

The Mooney Rivlin version 

gives the strain energy as: 

where:  

Note: C10 and C01 are material parameters; I1 and I2 are first and second deviatoric 

strain invariants: 

 

Example Card Image of Hyper-Elastic Material 

 

 
 

Best practice for corresponding property : 

• HEPH solid element formulation (Isolid = 24) 
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• Lagrange type total strain (Ismstr = 10) 

• Advanced tangent modulus estimation (IHKT = 2) 

 

 

 

/MAT/LAW69  

Incompressible Hyperelastic Material model specified using the Ogden or Mooney-

Rivlin material models. It is generally used to model incompressible rubbers, 

polymers, foams, and elastomers. Material parameters are computed from 

engineering stress-strain curve from uniaxial tension and compression tests. It is 

used with shell and solid elements. Users can reproduce viscous behavior in this 

material card using /VISC/PRONY card, which is an isotropic visco-elastic Maxwell 

model that can be used to add visco-elasticity to certain shell and solid element 

material models. The visco-elasticity is input using a Prony series. The Card Image of 

Law69: 
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  You can use /MAT/LAW69 - Incompressible Hyperelastic Material with 

Tabulated Input specified using the Mooney-Rivlin material models and this 

material model is generally used to model rubbers. Material parameters are 

computed from engineering stress-strain curve provided by the user. 

 

/MAT/FOAM_TAB or /MAT/LAW70: Tabulated Foam 

• Visco-elastic behavior 

• Stress – strain relationship defined by functions according to strain rate 

• Unloading behavior defined by: 

o Curves 

o Hysteresis parameters 

Best practice for corresponding property: 

• Belytschko solid element formulation (Isolid = 1, or 17 if hourglass issues) 

• Small strain (Ismstr = 11) 

• Element coordinate system non co-rotational (Iframe = 1) 
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6.5 Honeycomb Materials 

/MAT/HONEYCOMB or /MAT/LAW28 

• Used to model honeycomb or foam material. 

• This law describes a three dimensional nonlinear elasto-

plastic material 

• Nonlinear elasto-plastic behavior can be specified for 

each othrotropic direction and shear as function of strain or volumetric strain 

• All degrees of freedom are uncoupled and the material is fully compressible 

• Tension and shear strain based failure criteria can be specified. 

• Requires solid orthotropic property /PROP/TYPE6 (SOL_ORTH) 

• Material is compatible with hexa and tetra elements, including 10-node 

tetrahedron elements 

 

6.6 Concrete and Rock Materials 

Drucker-Prager for rock or concrete by polynominal (10) 

Drucker-Prager for rock or concrete (21) 

Reinforced concrete (24) 

Drücker-Prager with cap (81) 

 

 

 

 

 

 

 

 

 

Honeycomb (28) 

Crushable 

foam 

(50) 

Cosserat 

Medium 

(68) 
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6.7 Multi-Material, Fluid and Explosive Materials 

Jones Wilkins Lee model (5) 

Hydrodynamic viscous (6) 

Hydrodynamic viscous with k-

ε 

(6) 

Boundary element (11) 

Boundary element with k-ε (11) 

ALE and Euler formulation (20) 

Hydrodynamic bi-material 

liquid gas material 

(37) 

Lee-Tarver material (41) 

Viscous fluid with LES subgrid 

scale viscosity 

(46) 

Solid, liquid, gas and 

explosives 

(51) 

 

6.8  Connections Materials 

Predit rivets (54) 

Connection material (59) 

Advanced connection material (83) 
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6.9  Other Materials 

Fictitious (0) 

Hooke (1) 

Purely thermal material (18) 

SESAM tabular EOS, used with 

a Johnson-Cook yield criterion 

(26) 

Superelastic Law for Shape 

Memory Alloy 

(71) 

Porous material (75) 

GAS material GAS 

(-) 

User material (29~

31) 

 

6.10 Failure Models 

In addition to the possibility to define user's material failure models, Radioss 

integrates several failure models. These models use generally a global notion of 

cumulative damage to compute failure. They are mostly independent to constitutive 

law and the hardening model and can be linked to several available material laws. A 

compatibility table is given in the Radioss Reference Guide. 

 

Failure Model Type Description 

BIQUAD Strain failure model Direct input on effective plastic strain to 

failure 

CHANG Chang-Chang model Failure criteria for composites 

CONNECT Failure Normal and Tangential failure model 

EMC Extended Mohr 

Coulomb failure model 

Failure dependent on effective plastic strain 

ENERGY Energy isotrop Specific energy 

https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz


    
 

157 

FABRIC Traction Strain failure 

FLD Forming limit diagram Introduction of the experimental failure data 

in the simulation 

HASHIN Composite model Hashin model 

HC_DSSE Extended Mohr 

Coulomb failure model 

Strain based Ductile Failure Model: Hosford- 

Coulomb with Domain of Shell-to-Solid 

Equivalence 

JOHNSON Ductile failure model Cumulative damage law based on the plastic 

strain accumulation 

LAD_DAMA Composite 

delamination 

Ladeveze delamination model 

NXT NXT failure criteria Similar to FLD, but based on stresses 

PUCK Composite model Puck model 

SNCONNECT Failure Failure criteria for plastic strain 

SPALLING Ductile + Spalling Johnson-Cook failure model with Spalling 

effect 

TAB1 Strain failure model Based on damage accumulation using user- 

defined functions 

TBUTCHER Failure due to fatigue Fracture appears when time integration of a 

stress expression becomes true 

TENSSTRAIN Traction Strain failure 

WIERZBICKI Ductile material 3D failure model for solid and shells 

WILKINS Ductile Failure model Cumulative damage law 

 

Review the summary overview about Material Law2 and Law36 by Rahul Rajan (28 

minutes)  

https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
https://altair-2.wistia.com/medias/9dtedtjqjz
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Lecture by Paul du Bois about material models for crashworthiness analysis 

 

 

 

6.11 Generating Material Data 

• Ask material supplier 

• Do a web search (www.matweb.com) 

• Use testing facilities to generate material parameters:  

https://www.datapointlabs.com/ Catalog.asp 

 

 

For the more advanced RADIOSS user: 

You may also create & define your own materials in RADIOSS. For further 

information please see 

 

RADIOSS USER’S CODE INTERFACE 

 

http://training.altairuniversity.com/analysis/structural/projects/customizing-radioss/
https://altairuniversity.com/learning-library/vi_materials-in-radioss/
https://altairuniversity.com/learning-library/material-for-crashworthiness-analysis/
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6.12 Frequently Asked Questions 

(Materials/Failure) 

How To Get Law24 (Concrete Material) Data From Real Physical Tests?  

You can get data for Law24 from the following tests: 

• Get density by weighing a specimen 

• Get Young modulus with a cylinder compression test 

• Poisson coefficient (usually assumed to be near 0.2) 

• Get ‘fc’ from Compression strength (using cube compression test) 

• With the following additional tests, material Law24 will be more accurate (in 

fact, providing data fits the failure envelope): 

• Get ‘ft’ from tensile test: 

• ‘ft’ is direct tensile strength. This test provides ‘ft/fc’ value for Law24.  

• Get couple of (ft,Ht) from Splitting tensile test: 

• This test is also called Brazilian test.  

• ‘Fst’ is splitting tensile strength in Splitting tensile test. Assuming that Fst=ft. 

Then you need to model this test to fit limit strength (ft) by validating ‘Ht’ value. This 

test should be with very slow velocity, so use HA8 solid property for in Splitting 

tensile test. 

• Get ‘fb’ from biaxial test and get (f2,s0) from confined test. 

 

 

Which Curve Should Be Input In Material Law36 In Order To Characterize A 

Material?  

For elastic plastic laws in RADIOSS, one gives a true stress versus true strain curve, so 

you have to convert the experimental curve. How to proceed is described in the 

online documentation (Example 11: Tensile Test in the RADIOSS Tutorials and 

Examples manual): 

 



    
 

160 

I Use Solid Elements And Epmax In The Corresponding Material After The Criteria 

Epmax Is Reached, Elements Are Not Deleted; Why?  

Depending on the material law, the solid elements are not deleted after the criteria 

E1pmax is reached (they do not appear as “deleted elements” in post-processors). 

For Material Laws2, 4 and 22, only the deviatoric part of the stress tensor is set to 

zero, the internal pressure of the solid is still computed. 

On the other hand, for Material Laws3, 23, 28 and 36 the solid elements are deleted 

when E1pmax is reached. 
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7 Interface / Contact Modeling 
The explicit analysis method efficiently solves complex dynamic contact problems 

(boundary condition nonlinearity). Accurate modeling of contact interfaces is 

essential to correctly capture contact interaction between bodies. RADIOSS has a 

large number of contact types suitable for many applications. In RADIOSS an 

interface is created by defining the master segment and slave node set. The master 

segment can be parts components, elements, contact surface, node surface sets and 

slave entities can be parts components and node sets. The contact algorithm will 

check every time step for potential penetration of a slave node through a master 

segment. If penetration is detected the contact is treated with either a Penalty or 

Lagrange multiplier method. 

 

.  

 

 

In this chapter we will learn about: 

• TYPE7, variable stiffness, node to surface contact 

• TYPE11, variable stiffness, edge to edge contact 
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•  TYPE19, combination of Type 7+11 

• TYPE24 , linear stiffness, node to surface, and surface to surface contact 

 

The Penalty Method Used In Interfaces 

Interfaces using the penalty method are based on master/slave treatment. Contact 

can only occur between a set of slave nodes and a set of master segments. Master 

segments are defined depending on the type of element they lie on. If it is a 3-node 

or a 4-node shell, the segment is the surface of the element. If it is a solid element, 

the segment is defined as a face. Finally, if it is a 2D solid element (quad), the 

segment is a side. 

 

 
 

A gap distance is defined to determine whether or not a node is in contact with a 

segment. Spring elements that generate resistive forces as a function of penetration 

are created between the slave node and its projection. The spring stiffness is 

automatically computed according to the material and property of both master 

segment and slave node. The time step may be affected by the interface stiffness. 

During the penetration, as a spring is connected to the slave node, the spring 

stiffness must be added to the overall stiffness acting on the node (stiffness from all 

elements connected to this node). The nodal time step must be reduced to account 

for the spring stiffness. Contact ends when the penetrated node is completely 

pushed out of the gap. Therefore, the elastic spring and the reaction force are 

removed. It is worthwhile to note that the contact interfaces with penalty method 
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are fully compatible will all kinematic conditions (for example, rigid body, imposed 

velocity, etc.). 

 

 

 

Lagrange Multiplier Method (/LAGMUL and /INTER/LAGMUL) 

Contrary to the penalty method, the Lagrange Multiplier method is purely 

mathematical and does not require physical elements (springs) to model contact. A 

nonlinear system of equations is solved to account for contact conditions. Therefore, 

there is no time step collapse due to high interface stiffness, but it takes more CPU 

time to do one cycle as new equations need to be solved by a nonlinear solver. The 

method has the advantage to stop slave nodes at the contact surface (the contact 

condition is precisely satisfied); however the friction cannot be computed. 

 

Variations of Interfaces 
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Friction 

Several friction formulations are available within Radioss. The simplest one, which is 

also the most used, is the Coulomb friction law. This formulation provides accurate 

results in crash analysis and requires just one parameter (Coulomb friction 

coefficient, μ ).  Iform=2 Stiffness Friction formulation is recommended. Normal and 

Tangential Forces Applied to a Node: 
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Types Of Interfaces Used In RADIOSS 
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7.1 Interface Type 7: Nodes to Surface Contact 

• Automatic node to surface contact interface using penalty method with variable 

stiffness 

• A gap is defined around the master segment and the slave nodes 

• The contact gap can be constant or variable 

• Resistive forces are applied to keep slave nodes out of the contact gap 

• Interface time step is computed to insure stability 

Interface type 7 is a general-purpose interface and can simulate all types of impact 

between a set of nodes and a master surface. Contrary to interface types 3 and 5, 

interface type 7 is non-oriented and slave nodes can belong to the master surface. 

Therefore, this interface can simulate auto-impact, especially buckling during a high-

speed crash. Interface type 7 solves all problems and limitations encountered with 

interface types 3 and 5. The search for the closest segment is done via a direct 

search algorithm; therefore, there are no search limitations and all possible contacts 

are found. The energy jumps induced by a node impacting from the shell edges are 

removed by the use of a cylindrical gap around the edges. 
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Finally, the main advantage of interface type 7 is that the stiffness is not constant 

and increases with the penetration preventing the node from going through the 

shell midsurface. This solves many bad contact treatments (common when using 

either interface type 3 or 5). 

The gap used in interface type 7 is rather different than those of the previous 

interfaces. The gap used is on both sides of the shell mid-surface, and a cylindrical 

gap is added around the edges. 

The main advantage of interface type is that the stiffness is not constant and 

increases with the penetration preventing the node from going through the shell 

mid-surface. This solves many bad contact treatments (common when using either 

interface type 3 or 5). 

The main limitations of this interface are: 

• Time step is reduced in case of high impact speed or contacts with small 

gap. 

• It does not work properly if used with a rigid body at high impact speed or 

rigid body with small gap. 

• It does not solve edge to edge contact (to solve this, /INTER/TYPE11 should 

be used along with TYPE). 
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Important Interface Parameters 

Igap       Determines how the size of the gap is calculated 

Gapmin      Minimum gap for activation of interface 

Inacti       Action to take if initial penetrations exist 

Istf       Affects how the stiffness of the interface is calculated 

Iform      Friction formulation 

Stmin       Minimum stiffness to use in the interface 

Idel             Update For Deleted Elements Due To Failure 

The recommended contact parameters for interface Type 7: 

• Istf=4 

• Igap=2 

• Fscale_Gap=0.8 

• INACTI=6 

• Gap_min=0.1 

• Fric = 0.1 

• Iform=2 

Interface Type 7: Some Gap Definitions 

• gm: master element gap: 

o gm = t/2, t is the thickness of the master element for shell elements 

o gm = 0 for brick elements 

• gs: slave node gap: 

o gs = 0  if the slave node is not connected to any element or is only 

connected to brick or spring elements 

o gs = t/2, t is the largest thickness of the shell elements connected to the 

slave node 

o gs    for truss and beam elements, with S being the cross section 

of the element. 

• If the slave node is connected to multiple shells and/or beams or trusses, the 

largest computed slave gap is used. 
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A Type 7 Interface uses a gap even if the user has not defined it 

If Gapmin is not defined or set to zero, then Gapmin = min (tm, lmin/2)  where: 

• tm is average thickness of master shell elements 

• lmin is smallest side length of all master segments (shell or brick) 

If all master segments are brick, then Gapmin =  lmin/10 where: 

• lmin is the small side length of all master brick segments. 

 

 
 

If not explicitly defined, the Constant Gap would equal Gapmin which is the master 

segment thickness. 

 

 
 

The Variable Gap = max [Gapmin, (gs + gm)] where:    

• Gapmin is defined as before  

• gm = tm/2, where tm is thickness of master shell – or zero for master brick 

elements 

• gs = ts/2, where ts is largest thickness of shell connected to slave node – or 

zero if slave node not connected to any element or only connected to brick 

or springs 
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Caution With Variable Gap Igap = 1, 2, or 3 

• If Gapmin is not specified or set to zero, you can get unexpected results: 

• Gapmin = tm , (if Gapmin is not specified and tm < lmin/2) 

o gm = tm/2 

o gs = ts/2 

So, Variable Gap = max [Gapmin, (gs + gm)]  = max [tm, (tm/2 + ts/2)]  

 

 
 

Solution: Specify Small Gapmin Specify small Gapmin so that: 

Gapmin = small number (less than smallest shell thickness, like 0.1) gm = tm/2 gs = ts/2 

So, Variable Gap = max [Gapmin, (gs + gm)]  = max [small number, (ts/2 + tm/2)]  

 

 
 

Interface Type 7: What About Solid Elements? 

Recall that for lgap = 1, the Variable Gap = max [Gapmin, (gs + gm)] where: 

• Gapmin = min (tm, lmin/2) or Gapmin = lmin/10 if master segments are all brick    
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• gm = tm/2, where tm is thickness of master shell – or zero for master brick 

elements 

• gs = ts/2, where ts is largest thickness of shell connected to slave node – or zero 

if slave node not connected to any element or only connected to brick or springs 

Best to always specify a small Gapmin 

 

 
 

Note: Values for variable gap shown when Gapmin is not specified 

Interface Type 7: Options For Defining The Gap 

 

 
 

The Variable Gap = max {Gapmin, min [Fscalegap*(gs + gm), Gapmax]} where: 

• Gapmin is defined as before 

• gm = tm/2, where tm is thickness of master shell – or zero for master brick 

elements 

• gs = ts/2, where ts is largest thickness of shell connected to slave node – or zero 

if slave node not connected to any  element or only connected to brick or 

springs 

Gapmax is an upper limit on the gap (no upper limit if not specified) 
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Interface Type 7: Limitation Of Gap Definition 

In case of self-impact definition, there is an initial penetration when the gap value is 

larger than the mesh size 

 

 
 

This situation can be solved with Igap= 3 or with the flag Irem_gap = 2 

 

Interface Type 7: Options For Defining The Gap 

 

 
 

The Variable Gap = max {Gapmin, min [Fscalegap*(gs + gm), %mesh_size*(gs_l+gm_l), 

Gapmax]} where 

• Gapmin, gs, and gm are defined as before 
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• gm_l = length of smallest edge of master element 

• gs_l = length of smallest edge of element connected to slave node 

• %mesh_size = percentage of mesh size (0.4 is default) 

 
 

Interface Type 7: What About Initial Intersections? 

• Intersections result if slave nodes are past the master segment (shells or solids) 

• This condition can cause locking situations leading to computation failure 

• If slave nodes lie on the master segment an ERROR will occur because of the 

Type 7 contact stiffness definition 

 

 
 

• Penetrations result if a slave node is closer to the master segment than the 

calculated gap 

• Initial repulsion forces give an error in the energy balance due to the 

interfaces work 

• Set /IOFLAG parameter Ipri = 5 to get detailed information in the *out file 

regarding any initial penetrations 
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• There are options in the solver to remove initial penetrations 

• Penetrations and intersections should be removed from the model with 

Tools>Penetration Check in Hypermesh or Quality>Check All Solver Contact 

Interfaces in Hypercrash  

 

 
 

Interface Type 7: Options For Removing Initial Penetrations 

 

 
 

The initial penetration, P0 should be smaller than 30% of the initial gap to avoid 

contact stability issues 
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Interface Type 7: Resistive Forces 

The resistive force is nonlinear with respect to the penetration of the slave node into 

the gap and is a function of the penetration value and rate. 

Resistive Force 

 where: 

  

 

The instantaneous stiffness is: 
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Interface Type 7: Initial Contact Stiffness, K0 

 

 
 

The final value for the contact stiffness, K, can be bounded by lower and upper 

limits, Stmin and Stmax: 

 
 

Interface Type 7: Sliding Force Computation 
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Interface Type 7: Time Step Computation 

Because the interface stiffness is nonlinear, the slave node cannot cross the master 

segment. This gives good accuracy for the node location.However, this means that 

the interface time step needs to be evaluated during the solution. If there is large 

penetration, the interface stiffness becomes large, leading to reduced time step. 

 

 
 

Interface Type 7:  Update For Deleted Elements Due To Failure 
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Interface Type 7: Recommendations For Crash Applications 

 

 
 

 

 
 

Non-Linear Type7 Summary 

Advantages 

• Physically correct representation 

• High accuracy for describing self-contact and buckling 
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• Best used with shells to shells or solids to shells 

Disadvantages 

• Requires more stringent modeling practices 

• Does not tolerate intersections (slave node passing master segment) 

• Time step may reduce due to increasing interface stiffness 

 

Limitation Of Nodes-To-Surface Interface 

There are situations where the Type 7 node to surface interface will not detect the 

contact due to edges crossing each other at angles. Type 11 interface can be added 

to capture the physics correctly. 

 

 
 

 

7.1 Interface Type 11: Edge to Edge Contact 

• This interface simulates impact between edge to Edge or lines. A line can be 

a beam or truss element or a shell edge or spring elements. In association with 

interface TYPE7, interface TYPE11 solves the locking cases 

• Defined by identifying master and slave lines (edges) 

• Impacts occur between a master and a slave line. A slave line can impact on 

one or more master lines. A line can belong to the master and the slave side. This 

allows self-impact. 

• Works similar to Type 7 in terms of Penalty formulation, Gap definition and 

Search method 
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• Uses complicated mathematical algorithms; therefore, it is strongly advised 

to use it only when necessary. A huge interface TYPE11 can slow down the 

computation. 

 

 

 
 

Note: Create the line segments by finding the free edges for the component and 

creating a set for the same from Analysis>Contact Surfaces and choose card image 

as LineSeg. 

 

 

7.3 Interface Type 19: Combination of Type 7+11 

• Combination of two symmetric TYPE7 interfaces and one TYPE11 interface 

• Common input based on the same slave/master surfaces.  

• Useful for complex contact problems such airbag unfolding  

• Computationally expensive so only problematic segments should be defined 

• Edges to edge contact flag Iedge: 
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               Iedge = 2: all edges are generated  

Iedge = 1: only external edges are generated 

 

 

7.4 Interface Type 24: General Linear Contact 

• Penalty stiffness is constant and therefore, the time step is not affected (for 

standard penalty stiffness). 

• Solid elements are given a zero gap. 

• Three types of inputs contacts can be defined: single surface, surface to surface, 

or nodes to surface. 

• Recommended for all models where there is no physical gap (solids to solids) or 

there is initial interference between parts (e.g. mobile phone) 

• Type 24 is not recommended for airbag modeling when using FVM as some 

intersection may occur because of linear stiffness and may lead to negative 

volume for the polyhedron elements 

 



    
 

182 

 
 

A General Remark About Master & Slave: 

The coarser the mesh, the stiffer the structure will be provided the material and 

structural properties are same. Hence, the Master is typically meshed coarser so 

that the Slave does not penetrate into master. That is why we choose stiffer 

structure as master and compliant as slave. 

 

Soft Part against Hard Part 

The default stiffness value computed by Radioss is often suitable to avoid very high 

penetration, leading to the time step dropping. When contact occurs between 

similar materials, there is no problem using the default stiffness; except when the 

materials are different. For instance, when mild steel impacts soft foam, the default 

stiffness may be too low to avoid a large penetration. When such contacts are 

willing to occur, it is advised to first compute the ratio of the slave material stiffness 

over the master material stiffness. If this ratio is greater than 100, a scale factor 

(Stfac) equal to this ratio should be used to increase the interface stiffness. 
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Example of a contact between mild steel and soft foam. The ratio of stiffness is 

greater than 380, in such a case where the master side is the soft side, the flag Stfac 

may be set to 380 to avoid very high penetrations. 

 

Interface Post-Processing 

Animation file 

• contact forces :  /ANIM/CONT 

• contact pressure: /ANIM/PCONT 

Time history file 

• Total contact energy in the global parameter 

• Detail of the forces and energy for each contact, forces in the global frame, 

normal force and tangential force (friction): /TH/INTER 

 

Interface Surface Definition 

• Variety of ways to define interface surface 

• Best way, if possible, is to use /SURF/PART 

• This way, if the part is modified, the surface definition remains intact 
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Overview On Contact Interfaces In RADIOSS by Rahul Rajan (3 minutes) 

 
 

How Sliding Contact Works by Rahul Rajan (9 minutes) 

 
 

 

 

 

 

https://altairuniversity.com/learning-library/vii_a_interfaces-in-radioss/
https://altairuniversity.com/learning-library/vii_c_sliding-contact-in-radioss/
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Summary on Contact Type 7 by Rahul Rajan (23 minutes) 

 
 

Procedure to create TYPE24 Contact in RADIOSS (5 minutes) 

 

 

 

s) 

7.5 Frequently Asked Questions (Contact 

Interfaces) 

When Defining An Interface Type 7 With Solid Element Parts On The Master Side, 

Is It Necessary To Put Shells On The External Surface Of The Part?  

https://altairuniversity.com/learning-library/vii_d_sliding-interface-type-7-in-radioss/
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No, only the external surface of the solid should be defined. 

As of RADIOSS V9.0, it is possible to define the surface of an external skin of a solid 

part (or a subset, a material, a property, and so on) with the option 

/SURF/PART/EXT. 

With older RADIOSS versions, this surface should be built using segments (a surface 

type / SURF/SEG will be created but no additional element added). 

 

When Defining An Interface Type 7, Which Is Neither Self-Impacting Nor 

Symmetric, How Are The Master Side And The Slave Side Chosen?  

It is recommended to choose the coarse mesh on the master side for better contact 

detection. 

In the following example, contact is not detected if the fine mesh is chosen on the 

master side. 

 

           
 

In case both meshes are of the same size, the stiffer structure on the master side 

should generally be chosen. 

 

What Is the Meaning Of: WARNING ID 94?  

WARNING ID: 94 

** WARNING IN INTERFACE GAP 

INPUT GAP xxx 

HOWEVER GAP IS RECOMMENDED TO BE LESS THAN xxx 
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This message is especially important in case of a self-impacting interface. The 

recommended value corresponds to the smallest side length of shell elements on 

the master side, divided by 2. 

Shown below is a self-impacting interface for which the GAP equals half the side 

length of an element. 

 

         
 

If this element is compressed more than 50%, the red node enters into the gap of 

the neighboring element. A self-contact is then detected (which may not happen). 

This leads to over stiffening of the structure. 

So the message means that at least one element on the master side has a side 

length less than twice the GAP and there is a risk of over stiffening. 

If the side length L of an element is lower than the GAP, a self-contact will be 

computed from the beginning of the computation. 

Such a situation can be accepted if it is local enough, but not if it is a frequent 

situation over the self-impacting interface. It is possible to find the source of this 

message by using a preprocessor and selecting the elements through size criteria. 

In case the interface is not self-impacting, possible consequence of this message will 

be low performance, but the model behavior will be correct. 

  

What Is the Meaning Of: “Infinite Loop Detected”?  

This message can be written by RADIOSS Starter or by RADIOSS Engine. It 

corresponds to a contact interface (Type 7, Type 11, etc. ). 
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This message means that RADIOSS has found too many possible impacts2 for a given 

interface, with respect to the memory it has allocated for the storage of these 

impacts. 

Increasing parameter Multimp (default value is 4 for SMP and 12 for SPMD) in the 

interface will workaround this problem. 

Due to memory decomposition, it might be necessary to increase Multimp when 

using a large number of processors in SPMD. 
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8 Kinematic Conditions 
Kinematic constraints are boundary conditions that are placed on nodal velocities. 

They are mutually exclusive for each degree of freedom (DOF), and there can only 

be one constraint per DOF. Numerical methods available in Radioss that apply to the 

kinematic conditions are: 

• Penalty method: Rigid walls 

• Master slave kinematic condition: Interface TYPE2, rigid body 

• Local kinematic condition: Rigid link, cylindrical joint 

• Lagrange multiplier: Old and new interfaces, rigid wall, rigid body, etc. 

In this chapter the following will be discussed: 

• Tied Contact /INTER/TYPE2 

• Rigid Walls /RWALL 

• Rigid Bodies /RBODY 

• Boundary Conditions /BCS 

• Imposed Displacement /IMPDISP 

• Moving, fixed coordinate system /SKEW 

• Imposed Velocity /IMPVEL 

• Incompatible Kinematic Conditions 

 

Tied Contact /INTER/TYPE2 

Tied Contacts define an interface that kinematically connects a set of slave nodes to 

a master surface. It can be used to connect coarse and fine meshes, model 

spotwelds, rivets, etc. 
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A tied contact is defined by a group of slave nodes and a master surface. The slave 

nodes are kinematically tied to the master surface within a defined search tolerance, 

dsearch  

 

 

 

 

The slave node need be projected inside the master segment, that is the nodes of 

the slave surface are assumed to be connected to the faces of the master surface 

and the distance of the slave node from the master segment should be small 

enough. Close proximity between slave node and master segment is necessary for 

Interface Type 2 to work normally and will help getting a lower added mass when 

using Spotflag=1. 

The slave nodes forces and moments are transferred to the master nodes, and then 

slave nodes are positioned kinematically according to the motion of the master 

nodes. Warnings are displayed in the starter listing file (_0000.out) if a slave node 

cannot find a master segment with the search tolerance.A slave node cannot have 

another kinematic condition; unless such condition is applied in an orthogonal 

direction. 

 

Optional Penalty Method 

RADIOSS has an option to define Type 2 interface with the penalty method which 

removes potential incompatible kinematic conditions with Spotflag = 25 
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A spring element is defined between the slave node and its projection. The penalty 

stiffness is constant, calculated as the mean nodal stiffness of master and slave side. 

 

 

 

 

 

Tied Contact /INTER/TYPE2 Formulations 

 

 
 

If option Spotflag =1 is used in the Interface Type 2, then there are added mass on 

master nodes at the first cycle of RADIOSS Engine. Indeed the slave node inertia with 

respect to the center of the closest master segment – let Is + msd2 where, Is is the 

slave node inertia; ms is its mass and d is its distance to the center of the segment - 

is equilibrated by added mass on master nodes. When creating a spot weld with 

spring and Interface Type 2, it is important to check that the springs inertia (I =m*L2) 

are not too large - that is to say, that they correspond to the physics – and that the 

slave nodes height with respect to the master segments is as small as possible. 
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Tied Contact /INTER/TYPE2 Ignore Option 

 

 
 

The flag Ignore is available to automatically remove all slave nodes which cannot be 

projected on the master surface 

 

 
 

In case failure (rupture of the shell element) is defined on the master side of the 

interface, it is necessary to update the interface in order to release kinematic 

condition between the slave node and the deleted element. 
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Tied Contact /INTER/TYPE2 Card Image 

 

 
 

 

Tied Contact by Rahul Rajan (12 minutes)     

 
 

 

Rigid Walls /RWALL 

Rigid Walls allows the user an easy way to define an interface between a rigid 

surface and nodes of a deformable body. A rigid wall is a non-yielding retaining wall 

which is defined by the user Master Node and a group of Slave Nodes.  

https://altairuniversity.com/learning-library/vii_b_interface-type-2-in-radioss/
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Four Types Of Rigid Walls Are Available 

• Infinite plane      Infinite cylinder of diameter Ф  

 

• Sphere of diameter Ф      Parallelogram 

 
A Rigid Wall is defined by a Surface Type and a group of Slave Nodes 
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The slave nodes to a rigid wall can be defined as a group of nodes and/or as nodes 

initially at a distance less than the distance (Dsearch) from the rigid wall 

Each wall can be fixed (point M) or moving (node N) 

A Rigid Wall is a Kinematic Condition 

• If a slave node penetrates the rigid wall surface a new velocity is computed 

• From this velocity, the impulse and rigid wall force are determined 

 

Example of fixed infinite planar rigid wall: 

 

 
 

Example of spherical rigid wall with mass and initial velocity: 

 

 
 

Moving Rigid Wall 

A moving rigid wall is defined by a node number, N, and a point, M1. This allows a 

normal to be calculated.  The motion of node N can be specified with fixed velocity, 

or with an initial velocity. For simplification, an initial velocity and a mass may be 

given at the wall definition level.  

A moving wall is a master slave option. Master node defines the wall position at 

each time step and imposes velocity on impacted slave nodes. Impacted slave node 

forces are applied to the master node. The slave node forces are computed with 
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momentum conservation. The mass of the slave nodes is not transmitted to the 

master node, assuming a large rigid wall mass compared to the impacted slave node 

mass. Moving Rigid Wall Defined With Node N And Coordinates Of Point M1: 

 

Some Limitations with Rigid Walls 

Can result in Incompatible Kinematic Condition – a result of nodes belonging to 

another kinematic condition and the rigid wall 

Can only be fixed or have initial velocity – may want to move rigid object with an 

imposed displacement function. 

Solution: 

Best practice is to use rigid body 

connected to a simple mesh 

representing the rigid object: 

• Easy to define more arbitrary shapes 

• Can impose displacements, velocities 

according to function 

• Removes issue with Incompatible 

Kinematic Conditions 

 

Rigid Walls by Rahul Rajan (6 minutes) 

      

https://altairuniversity.com/learning-library/vi_a_rigid-wall-rwall-in-radioss/
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Rigid Body /RBODY 

A Rigid Body (/RBODY) constrains a set of nodes to move together with no relative 

motion and can be used to simplify the modeling of non-deformable objects.  A rigid 

body can be compared to a part with an infinite stiffness.  An example is shown 

below where the impactor and supports are made rigid. 

 

 
3 Point Bending Test. Purple - Rigid Body, Yellow = Rigid Body 

 

Rigid bodies generally have a much higher time step than other finite elements thus 

it is a computationally efficient way to simulate components of which flexibility is 

not critical for the required analysis and its stress and strain results are not needed.  
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• A Rigid Body is defined by a set of slave nodes and a master node 

• Mass and inertia may be added to the initial master node location 

• By default the master node is moved to the center of mass of all nodes 

• Best practice is to create a master node that is not attached to anything 

• The general motion of the rigid body is managed by the master node 

• A Rigid Body is a kinematic condition 

o No relative motion is allowed between the nodes 

o A kinematic condition is applied on each slave node for all directions 

o  
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Rigid Body /RBODY – Typical Applications 

• Rigid Body covering a part of a finite element model 

ICoG = 2: The center of gravity is only computed by taking into account the slave 

node mass; the master node is moved to the computed center of gravity, added 

mass and inertia are placed at the center of gravity. 

 

 
 

 

• Rigid Body Representing A Non-Modeled Component 

ICoG= 3: The center of gravity is set at the master node coordinates; added 

mass and inertia are placed on the master node coordinates; slave node 

mass and inertia are transmitted to the center of gravity. The master node is 

not moved.  

ICoG = 4: The center of gravity is set at the master node coordinates; added 

mass and inertia are put on center of gravity. The slave node mass and 

inertia are ignored. The master node is not moved. 
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• Rigid body used to connect two or more parts  

Ispher =1: A rigid body made of two slave nodes requires using the spherical 

inertia flag  

 

 
 

 

Center of gravity computation flag Icog: 

1 (Default) Mass and inertia are added at the master node coordinates; the 

center of gravity is computed using the master and slave node coordinates, the 

master node is moved to the computed center of gravity 
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2 The center of gravity is only computed by taking into account the slave node 

mass; the master node is moved to the computed center of gravity, added mass 

and inertia are placed at the center of gravity. 

3 The center of gravity is set at the master node coordinates; added mass and 

inertia are placed on the master node coordinates; slave node mass and inertia 

are transmitted to the center of gravity. The master node is not moved. 

4 The center of gravity is set at the master node coordinates; added mass and 

inertia are put on center of gravity. The slave node mass and inertia are 

ignored. The master node is not moved. 

 

 

 

/RBODY Format 
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What Do You Think? 

I have created a block with Hexa elements and shell elements with rigid body at 1 mm 

distance from block. Block is going to impact over rigid shell with 50 N-mm of torque. 

But block is not rotating with respect to the master node. What went wrong? 

 

 

 

Keep the ICOG of the rigid body to 3 and run the analysis. By keeping ICoG=3, the 

master node is not moved 

 

Rigid Bodies by Rahul Rajan (18 minutes) 

 
 

https://altairuniversity.com/learning-library/vi_c_rigid-body-rbody-in-radioss/
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Boundary Conditions /BCS 

A Boundary Condition is a kinematic condition in which the velocity on a node’s 

degree of freedom is set to zero. Boundary Conditions or constraints define nodal 

translational and rotational degrees of freedom that are fixed from moving. Over or 

under-constraining the model will provide wrong results hence the user should 

properly apply the loads and boundary conditions to get meaningful results. 

 

 
 

There are six degrees of freedom at a node that can be constrained: 

 

 
 

 

 

A DOF is free, if the code is set to 0 (default) and fixed, if set to 1. 

Example: 101 111 means the x and z translations, as well as all rotations are fixed; 

the y translation is free. 
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If skew_id is non-zero, then the boundary conditions are applied with respect to this 

local skew (local coordinate system)) 

 

Skew and Frames 

Skews and frames are used to define local directions. These directions can be used 

to apply: 

• boundary conditions 

• concentrated load 

• fixed velocity 

To define: 

• rigid link orientation 

• rigid body added inertia frame 

• general spring reference frame 

• beam type spring initial reference frame 

• nodal time history output frame 

Two types of skew frames are available in RADIOSS: 

 

 
 

Fixed Skew Frame Defined By      Moving Skew Frame Defined By 3                     

Coordinates Of O’, Y’, And Z’                                                Nodes N1, N2, And N3  

X’ = Y’ X Z’ And Y’ Recomputed As Z’ X X’ 

 

Skew Reference 

It is a projection reference to define the local quantities with respect to the global 

reference. In fact, the origin of the skew remains at the initial position during the 
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motion even though a moving skew is defined. In this case, a simple projection 

matrix is used to compute the kinematic quantities in the reference 

Example Of Skew: 

In this example imposed velocity is applied in Y direction. If skew is used in /IMPVEL, 

then the imposed velocity is computed in the Y-axis of global coordinate system and 

then projected onto the Y’ axis of local skew reference. 

 

 
 

Frame Reference 

It is a mobile or fixed reference. The quantities are computed with respect to the 

origin of the frame which may be in motion or not depending on the kind of 

reference frame. For a moving reference frame, the position and the orientation of 

the reference vary in time during the motion. The origin of the frame defined by a 

node position is tied to the node. Frame measures relative motion whereas skew 

measures global motion and projects it to skew. Only few options use frame like 

imposed velocity, TH/NODE and others use skew. 

Example Of Frame: 

In this example rotational velocity is applied around Z axis. In /LOAD/CENTRI frame is 

used, then rotational velocity is around Z’ axis of frame reference not in Z axis of 

global coordinate system anymore. 
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What’s the difference between the two-system creation method, that is using node 

reference and by axis direction?  

Using axis direction method, the user defines the system based on the axis direction. 

But for node reference, based on the node selected by the user the local system is 

created. Moreover, using axis direction method user can select a number of nodes 

and the local system will be created in every node selected whereas this is not 

possible for node reference method. And the most important is for systems created 

by node reference method the local system created is also updated when the node 

is translated whereas for the other method it doesn’t.   

 

A summary about Added Mass and Skew Frame by Rahul Rajan: 

 

https://altairuniversity.com/learning-library/vi_f_added-mass-and-skew-frames/
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Imposed Displacement & Velocity /IMPDISP, /IMPVEL 

Imposed Displacements define nodal translational and/or rotational degrees of 

freedom that are defined to move according to a function 

 

 
 

A metal strip is passed through two rollers aiming at reducing its thickness. Both 

rollers have an imposed angular velocity. 

 

 
 

• The imposed condition will follow the displacement (or velocity) versus time 

curve defined by fct_IDT 

• The direction is defined by Dir and can be X, Y, or Z in translation, and XX, YY, or 

ZZ for rotation in either global or local coordinate system 

• /IMPDISP and /IMPVEL are kinematic condition 

• Possible to assign the BCs to a cylindrical system by selecting the nodes and put 

imposed displacement (/IMPDISP, and keep icoor=1),for each dof with zero 

magnitude function. 
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Guidelines to Apply Quasi-Static Load In Explicit Simulation (8 minutes) 

 

 

 
 

Why We Should Slowly Ramp the Load For Quasi Static Simulation In Explicit 

Solver (5 minutes) 

 

https://altairuniversity.com/learning-library/7-guidelines-to-apply-quasi-static-load-in-explicit-simulation/
https://altairuniversity.com/learning-library/8-why-we-should-slowly-ramp-the-load-for-quasi-static-simulation-in-explicit-solver/
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Three points bending (15 minutes) 

 

 

8.1 Frequently Asked Questions (Kinematic 

Conditions) 

What Is The Meaning Of: WARNING ID 147, Which Appears Often In The Listing File 

Runname_0000out?  

WARNING ID: 147 

*** WARNING: INCOMPATIBLE KINEMATIC CONDITIONS 

2 KINEMATIC CONDITIONS ON NODE 

 

 
Conditions upon node velocity 

 

 

https://www.youtube.com/watch?v=D0cWiaEQrnE


    
 

210 

Two kinematic conditions which apply at the same time along non-orthogonal 

directions are considered incompatible. 

For instance, a boundary constraint on a node in X direction of the global system and 

an imposed velocity in the same direction are not compatible (such a behavior is not 

possible). On the other hand, a boundary constraint on a node in X direction of the 

global system and an imposed velocity in Y or Z direction of the global system are 

compatible. 

Since a rigid body controls the movement of its slave nodes, a rigid body slave node 

cannot use another condition (specifically it cannot belong to another rigid body). 

If flag Ikrem of the rigid body gets its default value =0, the slave nodes of the rigid 

body are automatically removed from the rigid walls; the master node of the rigid 

body will realize the contact with the rigid walls if it is declared as a slave node of 

the rigid walls. 

In case some conditions are incompatible and are applied at the same time on a 

node, the model behavior is not guaranteed, since those conditions will not be 

correctly taken into account. The /PARITH/ON option is not supported in this case, 

so it is necessary to check the source of those WARNINGS and to adapt the model. 

In case of two incompatible conditions that are never applied at the same time (for 

instance, because their activation intervals [Tstart, Tstop] do not overlap); the 

WARNINGS need not be taken into account. 

Moreover, no error is written by RADIOSS Starter better than these WARNINGS, 

which would prevent from running the computation, since the analysis of the 

compatibility of the kinematic conditions is sometimes more complex than RADIOSS 

Starter can manage. In such cases, the WARNINGS provide the only clue to error 

termination of the run and it is the user’s responsibility to check the model. 

 

Why Is It Not Recommended To Set A Node Of The Mesh As The Master Node Of A 

Rigid Body?  

It is not recommended to set a node of the mesh as the master node of a rigid body, 

since: 
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• The local system of the master node is not compatible with options imposing 

rotations (except boundary conditions and imposed velocities). If some elements 

having a rotational stiffness are connected (such as beams, some springs and shells), 

an incompatibility occurs. 

• Depending on the flag ICoG, which is used in the rigid body definition, a lot of mass 

and inertia can be added locally onto the node; as well as the node can be moved to 

the center of mass of the rigid body. 

 

What Is The Meaning Of: **ERROR: RIGID BODY 345886 UNSTABLE, Which Makes  

RADIOSS Engine End 

**ERROR: RIGID BODY 345886 UNSTABLE 

This means that:  

where, vr is the rotational velocity of the rigid body and dt is the time step. 

The rigid body turns more than one radian per cycle. This situation is due to 

divergence in the computation, hence the model and its behavior must be checked. 

If a rigid body has the same order of size or is smaller than the elements to which it 

is connected, using Ispher=1 is recommended in order to ensure the stability of the 

connected elements. 

 

What Do WARNING Id: 345 And WARNING Id 86 Mean?  

WARNING ID: 345 

*** WARNING/CHECK TIED INTERFACE 

93836629    1218  601311  601309  601310  601312  1.0218 -0.0095 1.339E-01 

This message is written for Interface Type 2 using the search formulation for the 

closest master segment Isearch =2 (the default value for this flag as of RADIOSS V4.1). 
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This message is not due to the height of the slave node with respect to the master 

segment. 

In case the Interface Type 2 with Spotflag =0, this can cause an error in RADIOSS 

Engine at the first cycle, due to a negative mass or inertia of a master node of the 

segment. This can also cause an error in RADIOSS Engine during the run due to a 

negative stiffness on a master node of the segment: 

** ERROR : NEGATIVE STIFFNESS NODE … 

In case of the Interface Type 2 with Spotflag =1, the situation corresponding to this 

message can cause a relatively important added mass at the first cycle on the master 

nodes of the segment. 

In case of the following message: 

WARNING ID: 86 

** WARNING: TIED INTERFACE TIED INTERFACE: 

4533 5490 248 5430 5250 5490 5491 1.00734 1.14868 

This message corresponds to search formulation for the closest master segment 

Isearch =1. 

The meaning and possible consequences of this message are the same as for 

WARNING ID: 345. 

 

I Get A Very Bad Energy Balance (The Energy Error Is Large And Positive: There Is 

Energy Creation) The Message: WARNING Id 547, Was Written To The Listing File 

Runname_0000out; Why?  
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WARNING ID: 547 

** WARNING IN RIGID BODY DEFINITION 

NODE ID= 167467 IS MASTER OF RIGID BODY NUMBER 25 

AND SLAVE OF ANOTHER ONE 

The standard formulation for rigid bodies is not working if a master node of a rigid 

body appears as a slave node of another rigid body; except for rigid bodies using 

Lagrange multipliers  

(/RBODY/LAGMUL). 

In the figure below, three rigid bodies A, B and C are defined. The master nodes of A 

and B have an added mass so that the centers of mass of the rigid bodies A and B are 

not centered. 

For representing the rigid body motion of the whole system A+B, a rigid body C has 

been defined using all slave nodes of A and B and also including the master nodes of 

A and B in order to take into account the added mass on these master nodes. 

Then the message is written by RADIOSS Starter and the rigid bodies A, B and C 

absolutely can not be used at the same time (the results would be arbitrary). 

On the other hand, we can stand from the same Runname_0000.rad to study the 

whole system C=A+B rigid body motion by deactivating rigid bodies A and B 

(/RBODY/OFF) and activating rigid body C (/RBODY/ON), whether the independent 

behaviors of A and B by activating rigid bodies A and B (/RBODY/ON) and 

deactivating rigid body C (/RBODY/OFF). 

The activation/deactivation of rigid bodies can be realized by using options 

/RBODY/ON and /RBODY/OFF in RADIOSS Engine or by defining SENSORS. 
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Incompatible Kinematic Conditions 

A kinematic condition results from using a feature in RADIOSS that specifies a 

kinematic constraint on nodal velocities 

These constraints are mutually exclusive for each degree of freedom, and there can 

be only one constraint per DOF 

RADIOSS Starter does not check if the kinematic conditions are really incompatible. 

If they are strictly orthogonal, or if they are not applied simultaneously, just ignore 

the warning. 

 

    
 

In the first case, a node is slave to a moving rigid wall and also has a fixed boundary 

condition. If the wall is moving, it is impossible after impact to respect both 

conditions. 



    
 

215 

In the second case, a node is defined as a slave for two parallel walls that are fixed, 

there are no possible incompatible conditions, as the node cannot impact the two 

walls at the same time. 

 

     
 

An example of the above is shown below. All DOF’s of the sphere are 

constrained/fixed. At the same time an imposed velocity is applied. As a result, 

either of the Kinematic Condition might be ignored depending on which gets 

processed first… 
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9 Load Definition 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this chapter you will be introduced to:  

• Nodal Groups /GRNOD/ 

• Concentrated Load /CLOAD 

• Gravity /GRAV 

• Initial Velocity /INIVEL 

• Pressure Load /PLOAD 

• Initial Velocity about an Axis /INIVEL/AXIS 
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Nodal Groups /GRNOD/ 

Most of the load definitions apply their function through the use of nodal groups. 

Nodal groups are very flexible and can reference nodes directly or via parts 

(components), by box, material, property, etc. 

1. A node group is a set of nodes. It can be defined explicitly by: 

• a list of nodes 

• a list of nodes with generation 

• a list of submodels (all nodes belonging to the listed submodel are included) 

• a list of submodels (all nodes defined by /NODE or /CNODE in the listed 

submodel are included) 

• a list of subsets or parts (all nodes belonging to the listed subset/part are 

included) 

• a list of property sets or materials (all nodes belonging to an element having 

those Property Type’s/MID’s are included) 

• a list of groups of nodes 

• a list of element groups (all nodes connected to those elements are 

included) 

• a box (all nodes within a defined box are included) 

• an unsorted node list: same as list of nodes, but the nodes are not sorted 

(only needed in interface type 8 and /XELEM option). 

2. Node groups are used to define slave nodes of rigid walls, interfaces, rigid bodies 

or nodes to which a load is applied, like a concentrated load or a fixed velocity. 

3. Nodes are stored in this order. For all other input types, nodes are sorted. 

Example of applying initial velocity to all nodes of three parts: 
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Concentrated Load /CLOAD 

• A concentrated load defines a 

concentrated force applied to each node of a 

prescribed nodal group. The load is applied to the 

nodes indirectly by means of a nodal group 

/GRNOD/ 

• The load versus time is defined by a 

function /FUNCT 

• The grnd_ID input is required. The concentrated loads will only be applied to 

the nodal group. The force is applied to each node individually, total force = F(t) * 

number of nodes 

• Torque can be applied by selecting the concentrated load from the BCs 

Manager and selecting the direction plane (XX, YY or ZZ). 

 

 
 

Gravity /GRAV 

Gravity defines an acceleration on a group of 

nodes. The gravity loads are only applied to 

the nodes defined in grnd_ID, which must 

not be null. The gravity versus time is 

defined by a function /FUNCT 
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Initial Velocity /INIVEL 

• Initial Velocity defines an 

initial velocity on a group of nodes.  

• No function is required for this 

option, just velocity in the x, y, and z-

directions 

• Specifying the group of nodes by part is very convenient when making 

changes to the model. 

• An imposed velocity is a kinematic condition, whereas the initial velocity 

definition is an initial condition assigned to the model. 

•  

 
 

Initial Velocity about an Axis /INIVEL/AXIS 

• Initial Velocity about an Axis initializes translational and/or rotational 
velocities on a group of nodes in a given coordinate system. 
• A local frame can be used if the rotation is not around a global axis 
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Note: The unit of velocity in translation is [m/s] In rotation, the angle is in unit [rad] 

and the velocity is in unit [1/s] 

 

Pressure Load /PLOAD 

• The pressure versus time is 

defined by a function /FUNCT 

• A pressure load defines a 

distributed force applied to each element 

face of a prescribed surface group. 

• The pressure is applied to the elements indirectly by means of a surface 

group /SURF/ 
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Note: In 3D analysis, positive pressure acts in direction N = N1 N3, x N2 N4 with N1, 

N2, N3, and N4 being the nodes of the segment in the surface definition. 

In  2D  analysis, positive pressure acts in direction N normal to N1 and N2, 

obtained by a rotation in the counterclockwise direction.  

 

 
Impact analysis Set up for RADIOSS (18 minutes) 

 

 
Procedure to Apply Initial Velocity Around An Axis (3 minutes) 

 

 
Loads & Boundary Conditions summary video by Rahul Rajan (18 minutes) 

 

https://www.youtube.com/watch?v=aDeNhQFvqjE
https://altairuniversity.com/learning-library/9-prodecure-to-apply-initial_velocity-around-an-axis/
https://altairuniversity.com/learning-library/vi_e_loads-and-boundary-conditions-in-radioss/
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9.1 Frequently Asked Questions (Initial Stresses) 

Is It Possible to Begin A Run With An Initial Stress State?  

It is possible to define an initial stress state by using option /INISTA. This option uses 

an OUTPUT file (Runname_0000.sty) describing the structure of the model for which 

a file Runname_nnnn.sty defines a stress state. 

The files Runname_0000.sty and Runname_nnnn.sty can be built in a first 

computation (see ASCII Output File (STY-File)). They can also be written using an 

external program, with respect to their respective formats. 

As of RADIOSS V4.4, it is also possible to enter the initial stress values element by 

element in the Runname_0000.rad file, by using options /INISHE and /INISH3 for 

shells and 3-node shells and /INIBRI for solid elements. 

As of RADIOSS V9.0, it is also possible to write with RADIOSS Engine state files 

Runname_ nnnn.sta for shells. 

Such a file will contain the geometry of selected parts (nodes coordinates and 

element connectivity), plus cards /INISHE and /INISH3 defining the stress, strain, and 

so on, of the shells and 3-node shells belonging to these parts. 

If the file is included in another input deck Runname_0000.rad, the state (geometry, 

stress, strain, and so on) of these parts will thus be retrieved (refer to /STATE in 

RADIOSS Engine Input). 

.sty file is a legacy format thus .sta file should be used instead. 
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10 Monitored Volume 
An airbag is defined as a monitored volume. A monitored volume is defined as 

having one or more 3 or 4 node shell property sets. The defined surface must be 

closed (the normal to shell elements must be all oriented outward. It is possible to 

reverse the shell normals for a given property set (by entering a negative property 

number). Dummy properties (/PROP/TYPE0) and materials (/MAT/TYPE0) can be 

used. There are five types of MONITORED VOLUME and basic equations: 

1. AREA Type: volume and surface output (post processing option, no pressure) 

2. PRES Type: user function defining pressure versus relative volume 

3. GAS Type: adiabatic pressure volume relation. P(V − Vinc)γ = Cst with γ = cp
cv

  

4. AIRBAG Type: Single airbag PV = nRT = mrT 

P = ρrT = ρ (cp − cv) T = (γ − 1) ρcvT = (γ − 1) E
V

 

 5. COMMU Type: Chambered, communicating, folded airbag  

 

 

https://altairuniversity.com/learning-library/v_d_monitored-volumes-in-radioss/
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Typical use of monitored volume is for tire, fuel tank, airbag. 

For tire use PRES or GAS type monitored volume. 

For fuel tank use PRES or GAS type monitored volume. 

For simple unfolded airbag use AIRBAG type monitored volume. 

For chambered airbag use two ore more COMMU type monitored volumes. For 

folded airbag use a set of COMMU type monitored volumes. 

 

AREA Type 

This type is only a post processing option. It allows plotting of the Time History of 

volume and area of a closed surface. 

 

PRES Type 

Describes the pressure load curve monitored volume type.The relative pressure is 

defined as, Prel = pressure inside of monitored volume - atmospheric pressure. 

Relative pressure function flag Itypfun=0 Pressure depends on relative volume.  Itypfun=1 

Pressure depends on time. 

 

GAS Type 

Describes the perfect gas monitored volume type. This option gives an adiabatic 

pressure volume relation. With γ = 1 an isothermal condition can also be applied. It 

is possible to define an incompressible sub-volume to model a volume partially filled 

with a liquid. 

 

AIRBAG Type 

Describes one-chambered airbag with hybrid input of injected gas. Gas materials 

specified in separate /MAT/GAS cards. Composition of injected gas mixture and 

injector properties specified in separate /PROP/INJECT1 or /PROP/INJECT2 cards 
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COMMU Type 

Describes multi-chambered airbag with hybrid input of injected gas. Gas materials 

can be specified in separate /MAT/GAS cards. Injector can be specified in separate 

/PROP/INJECT1 for injector. Scaling of communication area between airbag 

chambers as function of time or relative pressure is possible. 

 

FVMBAG Type 

Describes Finite Volume Method Airbag. Gas materials are specified in separate 

/MAT/GAS cards. Composition of injected gas mixture and injector properties are 

specified in separate /PROP/INJECT1 or /PROP/INJECT2 cards. Automatic Finite 

Volume meshing in specified coordinate system, given by a frame. 

 

Useful checklist for airbag modeling: 

• All airbag fabric components are meshed with tria elements according to 

meshing requirements (3-4mm average size) 

• Airbag is free from intersections 

• If the airbag will be used in a larger simulation, the entity ID numbering is 

correct based on requirements of the larger model 

• The airbag model is divided into /SUBSET representing the airbag external 

surfaces, vents, internal surfaces, housing, and inflator 

• Mass and inertia of the model matches the physical part 

• Fabric material data was validated using biaxial, picture frame and uniaxial 

tests 

• Vent holes are modeled 

• Porous fabric is modeled 

• Gas material for each gas component is modeled 

• Inflator is validated using a tank test simulation and comparing the mass 

flow and temperature curves to the tank test results 
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• Gas injections starts at TTF defined in /SENSOR Tdelay not by offsetting 

massflow and temperature curves 

• The mass flow curve start with non-zero values 

• Cp(T) function is increasing monotonically for each gas 

• Reference geometry is present either as nodal based /XREF or element 

based /EREF 

• The same /SENSOR is used to activate injection and activate reference 

geometry in LAW58 

• Ambient and internal air material properties are specified 

• /FVMBAG1 card is specified 

• Internal airbag contacts defined and HyperCrash penetration check shows 

no intersections and a maximum penetration amount of 10% of the contact gap 

• Stability run is done to check for motion before TTF 

• Uniform pressure run is completed, no anchoring of contact nodes 

• Stand-alone FVM run is completed, no anchoring of contact nodes and 

realistic unfolding 

• Model runs with required time step 

• Number of FV does not reduce to one 

• Visual development of the flow (temperature contour plot, fluid velocity 

vector) is realistic 
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Airbag Simulation Setup in RADIOSS. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://altairuniversity.com/learning-library/airbag-simulation-setup-in-radioss/
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11 Connections 
Bolt Modeling for Crash 

There are different ways for modeling bolt connection, and more detailed model 

accuracy of the results: 

• Rigid bolt 

• Rigid bolt with spring (and pretension) 

• Deformable bolt with spring and pretension 

• Deformable bolt with initial stress 

 

 
 

Rigid Bolt 

Use one rigid body (/RBODY) connected to the parts where the bolt is linked is the 

simplest method. Although this method is very stable and easy to modeling, you 

cannot consider pretension, elasto-plastic and rupture behavior for bolt, and there is 

no force output and model the bolt head passing through the hole is not possible. 

Note: The master node should be a free node. 
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Rigid Bolt with Spring (and Pretension) 

Use two rigid bodies (/RBODY) connected to each set of parts which are linked with 

the bolt and then set one spring element (/PROP/SPR_BEAM) between both rigid 

bodies. With this method it is possible to describe the elasto-plastic behavior 

rupture behavior in any direction, and the force passing through the bolt (normal 

force, shear force, moments) could be output, using /TH/SPRING. This method is 

often used in the automotive crash analysis, but it has limited capability to model 

the pretension. Note: The master node should be a free node. The spring element is 

attached to the rigid bodies as slave node. 

 

To describe pretension with this method another two spring elements 

(/PROP/SPR_PRE and /PROP/SPR_BEAM) need to be added. /IMPDISP or /CLOAD 

could be used to simulate preloading. Auto-balance state is calculated by Radioss. 
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Deformable Bolt with Spring and Pretension 

Meshed bolt with solid elements 

(/BRICK or any other solid element 

type) and cut in the middle. Two 

rigid bodies connected to each side 

of meshed bolt and spring series 

(two springs with /PROP/SPR_BEAM 

and one spring with 

/PROP/SPR_PRE) like above between 

rigid bodies are used to describe the 

pretension. With this more detailed 

model, the bolt head passing through the hole could be considered in simulation. 

 

Deformable Bolt with Initial Stress 

With this method, bolt is fully-meshed with 

solid elements (/BRICK), which is more 

realistic, and the material and failure 

character could be easily defined. Use /SECT 

to get section force/moment (/TH/SECT) in 

bolt. To define the pretension, initial stress 

(/INIBRI/STRS_F) is needed to get an initial analysis (tensile test on the bolt). Note: 

The rupture and stress accuracy depend of the mesh size. Section force in the bolt is 

necessary to measure the forces passing through the hole. 

 

Spotweld (Bolt or Adhesive Connect) 

There are three different ways for modeling spotweld:  

1. Node connect 
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2. Spring (/PROP/TYPE13) connect  

3. Solid connect 

Spring (/PROP/TYPE13) connect and solid connect could also model bolt or adhesive 

connect (glue). 

 

Node Connect 

A single interface TYPE2 with the first surface as master side and some nodes from 

second surface as slave nodes: With this solution the mesh of the master surface can 

be independent of the spotweld location. Hourglass problems disappear on the 

master surface. On the second shell, the surface mesh has to respect the spotweld 

location and the hourglass problem will remain. The main problem with this 

modeling approach is the undeformability of the connection and its infinite strength. 

Example of Connection between 2 Shell Surfaces: 

 
 

Spring (/PROP/TYPE13) Connect 

Two tied interfaces and a spring: The use of two tied interfaces will provide a full 

symmetrical solution allowing a free mesh on the two surfaces and avoiding 

hourglass. The spotweld is modeled with a beam type spring element. The element 

uses independent nodes not connected on the shell elements. One of the two nodes 

is located on the first surface (or near, there is no need to be located exactly on the 

shell surface) and the second node is located on the second surface. One tied 
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interface connects one spring node with the first surface and a second tied interface 

does the same on the second surface. 

 

 
 

To create a spotweld using this method is a good alternative solution with this 

approach the connection location is independent from the shell mesh. It is accurate 

since the spotweld properties are input directly to Spring TYPE13. Below is a basic 

input for Spring TYPE13 to model spotwelds. 
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Two different way for modeling rupture of the spotweld: 

1. Use failure criteria which available for a Spring TYPE13. For more details, see 

the comments on failure criteria  in /PROP/TYPE13 (SPR_BEAM). 

2. Use Spotflag= 20, 21, or 22 in Tied Contact (Tied Contact (/INTER/TYPE2)). 

Note: The modeling technique for the spotweld can also be used for other kinds of 

connections as welding lines, hemming, glue and bolts. For bolt modeling the use of 

tied interface is not necessary, as the shell nodes can be put directly in the rigid 

bodies. Glue and Bolt Modeling Examples: 
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Solid Connect 

Use 8-node brick element (with /PROP/TYPE43) and /MAT/LAW59 +/FAIL/CONNECT 

(or /MAT/LAW83+/FAIL/SNCONNECT) to modeling solid spotweld, which could 

provide more accurate results. 

The brick element use /PROP/TYPE43 and it has 4 integration point on the shear 

plane, which is between plane (1, 2, 3, 4) and plane (5, 6, 7, 8). One integration point 

in normal direction t. This element does not have time step itself and its stability is 

done by the nodal connection. So the thickness of a spotweld could be very small. 

This character is very useful for modeling glue. 

 

 
 

• INTER/TYPE2 used to connect solid spotweld with two upper and lower 

master surfaces. 

• For this modeling /MAT/LAW59+/FAIL/CONNECT  

(or /MAT/LAW83+/FAIL/SNCONNECT) could be used for solid spotweld. 
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12 Output Requests 
This is the content of this chapter: 

• Summary of Post-Processing Files 

• Animation Output Requests & Best Practices 

• Time History Output Requests & Best Practices 

 

Summary Of Post-Processing Files 

 
  Animation Output (A01, A02, … Ann)   Time History Output (T01)  

  Requested in Engine        Defined in Starter 

  For viewing animations & contours     For plotting X-Y data 

 

Animation Output Requests 

/ANIM/Keyword2/Keyword3/Keyword4 

  Request defined in Engine 

Output is written to runnameA01, runnameA02…runnameAnn file at a frequency of 

Tfreq 

Define Tfreq with /ANIM/DT in Engine 

One Ann file for each output step 

A runname.h3d file is also generated at the end of a successful run  
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/ANIM/Keyword2/Keyword3/Keyword4 

 
 

Creating Animation Output Request /ANIM 

In HyperMesh > View Solver Browser > Right click > Create > Engine Keywords > 

ANIM> option 
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In HyperCrash > Model > Control Card 

 
 

Animation Output Best Practice 

Around 20 to 50 animations are necessary to analyze correctly the model behavior:  

   e.g.  Tfreq = Final time / 20. 

Recommended requests in the animation files include: 
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Additional outputs can be set to get more information for shell elements 

 
Additional outputs can be set to get more information for solid elements 

 
* Information for each integration point in also available 

 

Time History Output Requests 

/TH/Keyword 

  Request defined in Starter 

Data is written to runnameT01 file at a frequency of ΔThis  

  ΔThis defined with /TFILE in Engine 

Needs usually around 1000 points for the full run to get enough information. 

  ΔThis = Final time / 1000 

Restarts will generate additional time history files: 

runname_0002.rad => runnameT02 

runname_0003.rad => runnameT03 etc. 
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Global Variables are always output by default 
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Example of typical energy balance, mass and time step display 

 

 
 

 

Requesting output for entities 

• /TH/Keyword/th_groupid 

• Var_IDn = DEF default output 

for that type as defined in help. 

• Obj_IDn  = Entity ID(s) to be 

output 

• HyperMesh: Create using 

Output Blocks 

• HyperCrash: Create using 

Data History > Time History 
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Time History Output Requests: Example for Rigid Wall 

 

 
 

Individual variables can be requested for output, or groups of variables 

The variable group, DEF, can always be requested to output a set of default variables 

 

 
 

Option For Time History File 

If /ABF (Altair Binary File) option is used, then graphs will automatically have axes 

and units plotted appropriately 

Output is to *.abf 
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 /TH/PART:   request default output for all parts to monitor energies 

/TH/INTER:   request default output for all interfaces to monitor contact 

forces  

 

 
 

Other outputs : 

/TH/MONVOL:  request default output for all monitored volumes 

/TH/SECT:  request default output for all section forces 

/TH/ACCEL:  request default output for all accelerometers 

/TH/RBODY:  request default output for the major rigid bodies where constraints are 

set on the master nodes. 

/TH/SPRING:  request default output for the springs which important connection 

between components (bolts). 

/TH/NODE:  request default output for the reference nodes (imposed displacement, 

measurement points,…) 

 

Additional Time History: /ATH, /BTH, … /ITH 

In case outputs are defined for a large number of elements, they can be stored in 

different time history files (T01a, T01b,…,T01i) with a smaller storage frequency in 

order to avoid very large time history file. 

/ATH/SPRING:  request default output for the connection springs (spot-welds, seam-

weld). 
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What Do You Think? 

In explicit dynamic run using RADIOSS, I am trying to output energy plot. I have defined 

TH/ PART in a deck file. Whenever I am trying to load *.T01 file into HyperGraph, its 

showing following error: 

The time history file type was changed to Type 4, that is TFILE/4 was the change made 

(Binary Format) in the engine file and the file is readable now (see image below). 
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12.1 Frequently Asked Questions (Post-processing) 

Using Shell Elements, I Asked for Strain Time History Output (Runnamet01) And 

Animation Files, But The Values Remain Equal To Zero; Why?  

The strain tensor is not computed by default; it must be asked for in the RADIOSS 

input file (Runname_0000.rad) by setting flag Istrain (flag to compute strains for 

post-processing) to 1 in option /DEF_SHELL or in the shell property set. 

On the contrary, the strain tensor is always computed and available for Law 25 and 

Law 27. 

 

What Are the Stresses SIGX, SIGY, And VONM In Animation Files If I Use 

Integration Points For The Shells?  

The stresses SIGX, SIGY… in Animation files represent the mean stresses through the 

thickness of the shell element. The VONM stress represents the Mises criteria 

applied to these mean stresses SIGX, SIGY… In the same way the stresses F1, F2, F12, 

Q1 and Q2 given in Time History correspond to these mean stresses. 

These mean stresses are computed by summation of the stresses at each integration 

point, averaged by the integration weights (refer to the integration weights table in 

the RADIOSS Theory Manual). They are used for the internal forces calculation. 

 
 

Where Is the Plastic Strain Value Computed If I Ask For /ANIM/ELEM/EPSP for 

Shell Elements?  

This value corresponds to the plastic strain value on the neutral fibre. 

 

 

 

Is It Possible to Get More (Or Less) Animation Files While A Computation Is 

Running?  



    
 

246 

Yes, it is possible to write an Animation file by writing a control file in the data 

directory. 

For the run number nn (/RUN/Runname/nn in the RADIOSS Engine input file), you 

have to write the file Runname_nn_0000_[C].rst with the process /ANIM in it. 

RADIOSS Engine writes an Animation file at this time. 

The other options available with control files are described in the Control File (C-File) 

file. 

In order to change the Animation files writing frequency, you have to stop your 

RADIOSS computation while writing a RESTART file, by using a control file (option 

/STOP). Then you can chain a second run with a different frequency for the 

Animation files writing. 

 

How Can I Plot Deleted Elements to Understand The Propagation Of A Fracture?  

Select Preferences > Option > Visualization menu in HyperView to display Eroded 

Elements. This will help you to understand the propagation of a fracture 

 

Using Shell Elements With Qeph Formulation (Ishel=24), The Hourglass Energy Of 

The Part And The Subset Are Not Equal To Zero In Time History; Why?  

When looking to the SUBSET or the PART in Time History, the hourglass energy is not 

zero. 

This is because energy absorbed due to the numerical damping is output there. This 

means, in output the place of hourglass energy has been used to present this viscous 

energy. 

The viscous energy is related to coefficient dn for shell property which using QEPH 

(Ishel =24) and QBAT and DKT18 (Ishel =12 or Ish3n =30). 

The energy corresponding to the physical stabilization of hourglass is counted as 

internal energy for this formulation.  
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13 Time Step Control 
An explicit is solved by calculating results in small time increments or time steps. The 

size of the time step depends on many factors and is automatically calculated by 

Radioss.Results are calculated for each time step or cycle in a simulation. Therefore, 

the smaller the time step, the longer a simulation will take to solve because more 

cycles and calculations are done. For a discrete finite element simulation, the 

solution remains stable if the shock wave traveling through the mesh does not travel 

through more than one element during one time step. In this way, the shock wave 

does not miss any nodes when traveling through the mesh and thus excites all the 

frequencies in the finite element mesh.  The step used for time integration (or 

moving forward in time) can be calculated using two different methods. The method 

used depends on the type of simulation being performed. 

The two time step methods are: 

• the element time step, 

• the nodal time step. 

The time step used by the solver is the largest possible time step, as determined by 

the Courant condition that will maintain stability. If the default large strain 

formulation is used, the time step is computed at each cycle. Large element 

deformation can give a large time step decrease. If the deformation is too large, 

negative volumes can result, which make it impossible to invert the Jacobian matrix 

and to integrate the stress over the volume. If the small strain formulation is used, 

assuming a constant Jacobian matrix during time and also a constant volume, all 

spatial variables are defined at t = 0. This is either the beginning of the analysis or 

the time at which the small strain formulation is initiated. If the sound speed is 

constant, the time step thus becomes constant. Using this formulation, the time 

step has no effect on the computation since the initial volume is used. 

The following topics are addressed in this chapter: 

• Analysis Stability Condition 

• Time Step Calculation 



    
 

248 

• Time Step Checking in Pre-Processor 

• Time Step Checking in RADIOSS Starter Listing File 

• Time Step Checking during the run 

• How to Speed up Computation 

• Time Step Control 

• Time Step Control Limitations 

• Element Time Step 

• Nodal Time Step 

• Global Time Step  

• Contact Interface Time Step 

• Parallel Processing 

• Extended Single Precision 

• Advanced Mass Scaling 

• Multi-Domain Technique 

• General Recommendations 

 

Analysis Stability Condition 

Critical Time Step – The time needed for information (stress, pressure wave) to cross 

the smallest distance in an element 

Stability – The model is stable if it is computed with a time step less than the 

smallest critical time step of the model 

Stability Condition depends on two factors: 

Size of the smallest element > Numerical 

Sound propagation speed  >  Physical 

 

Element Time Step Control 

The stable element time step is as:  

where: 

l is the element characteristic length 

 c is the speed of sound in the material. 
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This is the default setting. The element time step is computed at the same time as 

the internal forces. The characteristic length and the sound speed are computed for 

each element in every cycle. 

The computed time step is compared to a minimum time step value and a scale 

factor is applied to ensure a conservative bound. Different minimum time step 

values can be given to different element types by using the option: /DT/Keyword 

where Keyword is defined in the user manual as the element type. 

If deformation is large enough for the time step to reach the minimum defined 

value, three options are possible under the user’s control: 

1. Stop the analysis when the minimum time step value is reached. This is the 

default for brick and quadrilateral elements. 

2. Delete the element(s) defining the time step. This is the default for shell 

elements. 

3. Implement small strain formulation using a constant time step. This only works 

for shell and brick elements 

These options are defined using a third keyword: STOP, DEL, CST, AMS or SET 

 

Shell Element Time Step  

Critical length: 

 

 

 

The critical length can vary with: 

• Shell formulation 

• Hourglass control parameters 

• Numerical damping 

• Membrane damping 
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Solid Element Time Step 

Time Step 

 
Critical Length 

 

 

Nodal Time Step Control 

The nodal time step is calculated after the computation of all the internal forces at 

each node using the following equation: 

 

where m is the nodal mass and k an equivalent nodal stiffness. 

The nodal stiffness is one half of eigen value from element stiffness matrix; for a 

truss element this value is equal to the diagonal term of the stiffness matrix. It is 

computed from the accumulation of element and interface stiffness’. These 

stiffness’ are obtained during internal force computation. For a regular mesh, the 

element time step and nodal time step conditions are identical.  

To select the nodal time step when running RADIOSS the option /DT/NODA has to be 

used. As for the element time step, minimum time step and scale factors are 

required. The default value for the scale factor is 0.9. If the minimum time step is 

reached, the analysis can either be stopped or a mass scaling formulation can be 

applied. In the latter case, mass is added to the affected nodes so that the time step 

remains constant at the minimum value. This option can be enabled using the same 

third keyword as used in the element time step control. It must be checked that 

added masses do not affect the accuracy of results. 

Note: If one uses the nodal time step, the element time step is ignored. 
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Time Step Control Limitations 

Many of the time step control options influence the solution results. The solution of 

the nonlinear dynamic response of a finite element system accurate is the numerical 

model correctly represents the physical model. The critical time step given for finite 

element system is determined by a theoretical approach in which the highest 

frequency of the discretized system controls this value. Therefore, the time step 

limitations are related to the model and cannot be changed without influencing the 

quality of results. 

Using the “DEL” option can significantly alter the model, since elements and nodes 

are removed without replacement. In fact, mass and/or volume is lost. Using either 

/DT/NODA/CST or / DT/INTER/CST will add mass to the model to allow mathematical 

solution. The added mass will increase the kinetic energy. This should be checked by 

the user to see if there is a significant effect. Switching to a small strain option using 

brick or shell elements also introduces deviations. 

The use of mass scaling (/DT/NODA/CST) may lead to a mass instability. As a node 

penetrates, its global stiffness increases (the instantaneous interface stiffness, Kt is 

added); therefore, its nodal time step decreases. In order to match the minimum 

time step, Radioss adds the needed mass to the node. Unfortunately, this added 

mass increases the kinetic energy and the penetration gets bigger. Unless the 

interface is able to stop the penetration, the added mass (due to mass scaling) will 

keep on getting bigger and bigger in a vicious cycle. Therefore, the computation is 

likely to stop, since the mass variation may get huge very quickly (few cycles). If this 

is the case, the interface should be modified: 

• Gap should be increased 

• Initial stiffness can be increased 

• Mesh should be modified to be refined and uniform in the contact zone 

Effect of Mass Scaling on Interface TYPE7: 



    
 

252 

 
 

Generally, in the study of the nonlinear dynamic response of a system, three physical 

laws have to be respected: 

• Conservation of mass, 

• Conservation of energy, 

• Conservation of momentum dynamic equilibrium. 

The last one is generally respected as the equation of motion is resolved at each 

resolution cycle. However, in the case of adding masses especially when using 

/DT/NODA/CST option, it is useful to verify the momentum variation. The two other 

conservation laws are not explicitly satisfied. They should be checked a posteriori 

after computation to ensure the validity of the numerical model with respect to the 

physical problem. 

 

Time Step Checking In Pre-Processor 

The element time step can be checked with HyperMesh (or HyperCrash).  Example 

with the quality panel of HyperMesh for shell elements: 
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Time Step Checking In RADIOSS Starter Listing File 

The estimated smallest time step are printed in 

the starter output file (runname_0000.out) for 

each type of element (solid, shell, spring,…) and 

also the smallest estimated nodal time step. The 

time step for the computation is reduced by the 

scale factor (default=0.9) and can be smaller than 

the estimated one according the loading. 

A histogram showing the distribution of the nodal time step in the model is also 

printed in the Starter output file: 
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Time Step Checking during the run 

• When the Radioss Engine is running, the nodal time step can also be written 

to the animation output files using the output option /ANIM/NODA/DT or 

/H3D/NODA/DT. The element time step is available using /ANIM/ELEM/DT or 

/H3D/ELEM/DT. The animation file can then be contour plotted in HyperView to 

observe the time step of the elements in a simulation. 

• The time step can also be viewed in the Engine output file. The frequency 

can be set using the /PRINT/#, where the time step is written every # cycles, or the 

time step information of the current cycle can be output using the /INFO command 

in a Control File (C-File). 

From the engine out file we can check which entity is causing the low time step. It 

can be an element, a node or an interface: 

• For an element, check the related material (especially its Young modulus 

and density in case of an elastic-plastic material; and its viscosity in case of a visco-

elastic material). There must not be an error in the units system that this data is 

given in. Check the size of the element, since elemental length is proportional to 

time step. 
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• For a node, check the characteristics of connected elements. If the node is 

on the master side or the slave side of an interface, this interface must be verified. 

• For an interface, the gap of the interface must be verified if some failure 

happens on the master or the slave side of the interface. 

Once this is cleared you can run the simulation without time step being dropped. 

You can also impose a time step in order to control the time step drop. 

 

How To Speed Up Computation: Time Step Control For Impact  

Theoretical best solution: 

• No time step control in the model (element time step) 

• The computation can take lot of time because the time step will drop due to 

the element deformation 

 

Element Time Step Control: 

• /DT/Eltyp/CST : switch to small strain when the element is deformed, Where 

Eltyp is BRICK or SHELL 

• /DT/INTER/CST : add mass on the contact when time step drops 

E.g. The shell elements will switch to small strain formulation when their time step 

become smaller than target time step (1E-06) / scale factor (1.11E-06 in the example 

below) 

 

 
 

Nodal Time Step Control: 

• /DT/NODA/CST : add mass on the node when time step drops 

• Most often used option 

• Initial Added mass estimation printed in starter out file 

• Added mass progression printed in engine out file 
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• The added mass will increase the kinetic energy 

• Need to check amount of mass added and where it is added: 

• Total mass of the model from time history file (T01) 

• Animation : /ANIM/NODA/DMAS and /ANIM/MASS 

 

 
 

Adding too much mass can affect the physics by increasing the kinetic energy of a 

drop or impact simulation. This is because the object being simulated weighs more 

than the real part. Increased mass can also change the high frequency behavior of a 

model which can be very important in very high speed impacts such as ballistics, or 

explosions. 

 

In general, it is recommended to keep the amount of mass added to less than 5%. 

However, larger mass increases may be acceptable in some types of simulation. For 

example, in quasi-static simulations the velocities are usually small, so adding mass 

does not greatly increase the kinetic energy. For those reasons, it is recommended 
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to check the mass increase in the model by running a simulation without or with 

reduced mass scaling and comparing the results. If added mass results in added 

kinetic energy, the energy error calculated by Radioss will be positive. 

E.g. Mass will start to be added on the node when its time step becomes smaller 

than target time step (1E-06) / scale factor (0.67) = 1.5E-06. 

 

 
 

Scale Factor 

The time step scale factor value is set to 0.9 by default to ensure the stability, taking 

into account the approximations made in its evaluation. However, in some special 

cases, a smaller value is required. For example, if the structure becomes stiff 

suddenly (Fig. 1), due to the material behavior, the critical time step computed for 

the next step will be smaller than the current one. Therefore, the critical value 

computed by RADIOSS may be greater than the theoretical critical time step. 

 

 
Typical Behavior of Foam 

 

To avoid this problem, the time step scale factor is reduced. The numerical 

experience shows that a scale factor around 0.66 may be small enough to avoid time 

discretization stabilities. Another typical case is when only one element is used in 

the model. The shock wave propagation for a mesh with only one element cannot 

be studied correctly, the time step approximation by RADIOSS may return a higher 

value, which can be found by theory. In this case, the use of DTsca= 0.1 is suggested.  
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Recommendations:    

• For foams:  DTsca = 0.66 

• Model with one element:  DTsca = 0.1 

• Model with two finite elements:  DTsca  = 0.2 

• Model with more than three finite elements: DTsca = 0.9 (good in general) 

• Never use a scale factor greater than 1.0 

 

Global Time Step Control: 

The global time step (GTS) method can be used to calculate the time step of a 

model based on the natural frequency of the model. For some models the global 

time step method results in a higher time step when compared to calculating the 

time step based on each element or node. An iterative algorithm is used to 

calculate the global time step which is more expensive than calculating the element 

or nodal time step. Therefore, the global time step calculation is done every 20 

cycles by default. The global time method is useful in models without a large 

change in stiffness such as drop test simulations. 

 

Contact Interface Time Step 

The contact interface time step is calculated in two different ways: 

1. The contact interface time step based on stiffness is only calculated with TYPE7, 

TYPE10, TYPE11, TYPE19, TYPE21, TYPE24 and TYPE25. No matter which time 

step method is used, nodes that are involved in contacts have an increased 

stiffness which make it necessary to calculate a nodal contact interface time 

step using the nodal mass, interface stiffness and element stiffness. 

2. The kinematic contact time step of interfaces TYPE7, TYPE11 and TYPE19 is used 

to make sure that a slave node does not penetrate past a master segment 

during one cycle. 

The contact interface time step can be controlled using the 

/DT/INTER/Keyword3/Iflag (only contact interfaces with nonlinear stiffness) 
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Advanced Mass Scaling 

• Typical speed-up from 3 to 5 times natural time step 

• Additional terms on the mass matrix to increase the time step without 

changing the physical mass and inertia 

• The mass matrix can no longer be inverted, thus the equation of motion is 

solved using the conjugated gradient  

• Method not recommended for dynamic load-cases (crash, high speed 

impact,…) 

Applications: 

• Quasi-static load-case 

• Roof Crush  

• Seatbelt anchorage test (ECE-R14) 

• Loading with imposed displacement 

 

Starter deck (_0000.rad) 

Add /AMS to model along with a group 

of parts to which AMS will be applied 

If no part group is defined, AMS will be 

applied to the full model 

 

Engine file (_0001.rad) 

Add /DT/AMS with: 

Recommended scale factor: 0.67 

Target minimum time step value: 10 to 

20 times the natural element time step 

 

Comments: 

• The AMS treatment has an associated CPU cost, so this method becomes 

efficient when the target time is > 10 times the elementary time step 

• AMS is compatible with Single Precision 
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• AMS is not compatible with all RADIOSS options. In these cases, the target 

time step will not be honored 

• In the case that contact interface TYPE7 and TYPE11 are defined in the 

model, the target time step should not be larger than 1.0E-05 seconds to avoid 

numerical issues. However, this is case dependent. 

• AMS is not recommended for crash simulations. The conventional mass 

scaling, that is /DT/NODA/CST (mass error preferably less than 2 percent) is 

advisable for crash simulations whereas AMS is recommended for quasi static 

simulations. AMS modifies high frequencies in the system and in a dynamic event 

this can change results.  In quasi-static simulation this isn’t an issue. 

• Output the number of AMS iterations per cycle via /DT/AMS/Iflag - I =2 may 

help monitoring convergence quality at no extra CPU cost. Maximum allowed 

iterations before the divergence stops is 1000. 75 to 100 iteration per cycle is a sign 

of a poor convergence 50 still may provide some speedup, 30 iterations or less is 

considered a good convergence. 

 

Multi-Threading SMP 

• Multi-threading on a single socket (or physical CPU) : SMP 

• Use option to define the number of thread for the computation:-nt #threads 

• For efficiency, the number of threads should equal or less than the number 

of cores in the socket (CPU) 

 

Extended Single Precision 

• By default RADIOSS is computed with double precision 

• Extended single precision allows reduction of the CPU cost from 10 to 40% 

depending on the load-case and the model. 

• Results may be different than running with double precision, but care is 

taken still use double precision on critical RADIOSS calculations 
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Multi-Domain Technique 

The objective of the Multi-Domain technique (also referred to as RAD2RAD) is to 

optimize the computing performances of large scale Radioss models that meet 

certain criteria: 

• Possibility of sub-dividing the whole model into a number of distinct 

subdomains with clearly defined interfaces/connections between them. 

• Different subdomains should be characterized by different mesh sizes and 

consequently very different minimal time step. 

The goal is to improve prediction accuracy at reasonable, possibly advantageous, 

computation time for models with domains of very different time step sizes. For 

example, it is appealing to use Multi-Domain technique to compute large models 

that have one or more parts finely meshed to capture specific local phenomena such 

as cracks localization/propagation. It is even more appealing to use Multi-Domain 

technique to compute large fluid-structure interaction models, as in aircraft ditching 

or landing simulations, where fluid elements with high time steps are numerous 

compared to Lagrange structure elements with very small time steps. In the explicit 

integration scheme used by Radioss crash solver, the time step of the global model 

is penalized by the elements having the smallest time step. The concept is to replace 

this global model with physically equivalent subdomains, separating parts with 

different minimal time step. Each subdomain is resolved as a distinct Radioss model 

using its own time step, the force and momentum transfers between them being 

calculated by a separate master program (RAD2RAD), assuring stability constraints.  
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Multi-Domain efficiency is based on two types of discrepancies: 

• Time step sizes 

• Domains relative sizes 

 

 
 

It is particularly adapted to models with main and subdomains of: 

• very different mesh densities hence very different time steps 

• different formulations like Lagrange, ALE or Lagrange, and SPH, provided the 

ALE or SPH domain is larger than the Lagrange domain 
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Model Setup 

The two possible model setups are: Single Input File Format Multiple Input File 

Format. The Radioss runs are completely independent and do not communicate 

directly with each other. Each subdomain uses its own time step as outlined below: 

 

 
 

The time step of each subdomain is arbitrary; but to allow the best gain in terms of 

speedup they should be significantly different from each other. 

The best manual decomposition will be obtained by dividing global model into parts 

with a large number of elements having a big time step on one side, and a small 

number of elements with small time step on the other side. 

All communication, data transfers, time step synchronization, equilibrium and 

stability conditions on the domain frontiers are assured by the master program. 
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Hints for better computational performances: 

• The subdomain should be less than 30% of the full domain (main _ sub-

domains) in terms of nodes or elements and the natural (or acceptable mass scaling) 

time step ratio between subdomain and main domains should be below 1/3. 

• Apply the same rule for pure Lagrange or FSI models, which is to put the 

parts with a significantly smaller time step in the subdomain. 

• For pure Lagrange Multi-Domain models, the RAD2RAD workload must be 

minimized as much as possible by reducing the communication flow between 

domains, with this aim, contact interfaces and connections between sub and main 

domains should be minimized as much as possible. 

• It is important to check that the subdomain is not part of a global contact 

interface, but has its own subdomain self-impact and to create cross domain 

contacts not larger than needed. 

• It is strongly recommended to symmetrize each created cross domain 

contact interfaces. 

• For Multi-Domain with ALE or SPH, there is no need to minimize the contact 

interfaces between fluid and structure. 

• For models with a subdomain having a relatively small amount of elements, 

the number of allocated CPU should respect the empirical rule of at least 2000 

element per CPU and it is advised to use the maximum possible number of threads 

per node of the used cluster. 

• In one model, scattered parts with low time steps do not necessarily justify 

multiple subdomains. If these parts have similar low time steps, they must be put 

into one subdomain. 

• If connections between subdomains and main domains also have a small 

time step, these connections should be part of the subdomain. 

• Subdomains essentially composed of Lagrange 3D elements, make the 

Multi-Domain less efficient than if it was composed of 2D and 1D elements. 
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• For Multi-Domain FSI, it is advised to use the main domain as an elementary 

free time step with a scaling factor of 0.5 for ALE and a nodal free time step with a 

scaling factor of 0.6. 

 

General Recommendations 

Every time step control method has advantages and limitations. Good engineering 

judgement should be used to evaluate if the method used applies to a simulation. 

When in doubt, a simulation without time step control can be compared to a 

simulation with time step control to make sure the results are acceptable. 

 

Structural Dynamic Simulations 

Nodal Time Step and Mass Scaling 

For non-uniform meshes, the nodal time step method will lead to a slightly higher 

time step then the elementary method. This can be activated with the default 

options using: 

 /DT/NODA 

0.9 0 

Most simulations can benefit from a small amount of mass being added to the nodes 

with the lowest time step. The following option will activate the nodal time step 

with mass added to meet the minimum time step entered: 

 /DT/NODA/CST 

0.9 ΔTmin 

The process of finding a specific time step that adds a reasonable amount of mass 

can be done by running a model a short amount a time without any mass scaling to 

find the time step of the simulation. This is also a good time to see how long Radioss 

estimates the simulation will take to run. Next, increase the entered minimum time 

step and start running the model again to note the amount of mass added. Continue 

this process until a reasonable amount is added at the beginning of the simulation. 

Depending on the simulation, more mass may be added later, which would require 

another modification of the entered minimum time step. 
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Good engineering judgement must be used to determine how much mass is an 

acceptable amount to be added to a model to reduce the runtime. Adding too much 

mass can affect the physics of a drop or impact simulation. This is because the object 

being simulated weighs more than the real part. In general, it is recommended to 

keep the amount of mass added to be less than 5%, but more may be acceptable 

depending on a particular simulation. 

 

Contact Interface Controlling the Simulation 

When a contact has the minimum time step in a simulation, the Engine output lists 

INTER and the contact interface number that has the minimum time step. This 

indicates the time step was reduced to prevent a slave node from passing through a 

master segment in one cycle. A contact can occasionally have the minimum time 

step during a simulation. 

However, if the contact controls the time step for an extended amount of time, then 

the following possible causes should be investigated. 

• Initial intersections in the model  

• Incorrect penetrations in the model 

• Incorrect material definition, which leads to too soft of a contact stiffness  

• Small contact thickness or gap 

Another possible solution is to use /DT/INTER/DEL to remove from the contact the 

slave nodes that are causing the time step to drop. This is typically done by setting 

/DT/INTER/DEL ΔTmin to 10 to 100 times less than the ΔTmin used in /DT/NODA/CST. 

 

Switch to Small Strain Formulation 

If the default large strain formulation is used, large solid element deformation can 

give a cause a decrease in the time step. To prevent this from happening, the 

/DT/BRICK/CST can be used to switch to a small strain formulation at the entered 

minimum time step for elements whose property uses Ismstr= 2 or 12. 

Example: /DT Engine Input 

 For a typical simulation, using a combination of the following time step control 

commands can help maintain a reasonable time step in the simulation. 
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/DT/NODA/CST 

0.9 ΔTmin 1 

/DT/BRICK/CST 

0.9 ΔTmin2 

/DT/INTER/DEL 

0.9 ΔTmin3 

With ΔTmin2 being two to four times smaller than ΔTmin1 and ΔTmin3 being ten to a 

hundren times smaller than ΔTmin1. 

 

Quasi-static Simulations 

For quasi-static simulations either traditional nodal mass scaling, /DT/NODA/CST, or 

Advanced Mass Scaling, /DT/AMS could be used. If the event is slow, then using 

larger amounts of nodal mass scaling often will not affect the results. Or using 

/DT/AMS per recommendations works well. 

Time Step Control (32 Minutes) 

 
(Video by Rahul Rajan, Altair India) 

 
Procedure for Mass Scaling in RADIOSS (13 minutes) 

https://altair-2.wistia.com/medias/o0bfml9ah5
https://altairuniversity.com/learning-library/considerations-about-time-step/
https://www.youtube.com/watch?v=VWCcwranpqY
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13.1 Frequently Asked Questions (Time Step) 

Why Is The Cycle Time Step Very Small?  

First, check which object is responsible for the low time step in the listing file 

(Runname_nnnn. out) of RADIOSS Engine. It can be an element, a node or an 

interface. 

• In case of an element, check the related material (especially its Young modulus and 

density in case of an elastic-plastic material; and its viscosity in case of a visco-elastic 

material). There must not be an error in the units system that this data is given in. 

Check the size of the element, since where, lc is the characteristic 

length of the element; c is the material sound speed; and dtsca is the scale factor. 

• In case of a node, check the characteristics of connected elements. If the node is on 

the master side or the slave side of an interface, this interface must be verified. 

If a master node of a rigid body gives the time step, check the rigid body inertia 

reported in the listing file (Runname_0000.out), at: 

Rigid Body Initialization (for a rigid body made of only a few nodes, it may be 

necessary to set a spherical inertia). 

• In case of an interface, the gap of the interface must be verified if some failure 

happens on the master or the slave side of the interface. 

 

How Is It Possible That The Time Step Is Controlled By A Node Even While Using 

Elementary Time Step (ie Did Not Specify /DT/NODA)?  

 
The input file probably includes an Interface Type 7, Type 10 or Type 11. 
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In case of an impact between a slave node and a master segment, the stiffness of 

the penalty spring for this impact is applied to both slave and master nodes, in order 

to ensure stability. 

More precisely, Interface Type 7 associates a penalty spring and damping, so that an 

equivalent stiffness to the whole system is considered. The nodal stability time step 

is computed as follows: where, M is the nodal mass and K is the nodal 

stiffness 

 
is the sum of the stiffness applied to the node by all elements and contact interfaces. 

In case the deck includes Interface Type 7, Type 10 or Type 11, this time step is 

always computed at all nodes of the deck, in order to ensure stability even if an 

elementary time step is used. 

But when the time step is taken onto a node, this node is probably impacting 

(otherwise nodal time step computed with is greater than elementary 

time step). 

 

What Is The Difference Between The Messages “Delete Slave Node” And “Remove 

Slave Node” Concerning Interfaces Type 7 In The Listing File (Runname_0001out)?  

These messages are related to the option /DT/INTER/DEL. They both consist in the 

slave node suppression from the interface. This node will no longer impact any 

master segment for this interface. 
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The message “Remove Slave Node” is written when the interface kinematic time 

step is lower than the minimum time step; which was specified in option 

/DT/INTER/DEL. For the slave/ master couple which is considered, the kinematic 

time step is: 

 

 
 

If it is such that Dtsca Dt ≤ Dtmin, then the slave node is suppressed from the interface. 

The message “Delete Slave Node” is written when the stability time step of the 

interface for the slave/master couple; which is considered is lower than the 

minimum time step which was specified in option /DT/INTER/DEL. 

The stability time step for the slave/master couple is computed as follows: 

 

 
 

where, M is the minimum nodal mass among the slave node and the nodes of the 

master segment, and Ki is the interface stiffness for the slave/master couple which is 

considered (Ki is an equivalent stiffness to the penalty spring and the damping which 

are applied between the slave node and the master segment). 

When the stability time step for the slave/master couple is such that Dtsca Dt ≤ Dtmin, 

then the slave node is suppressed from the interface. 

It is possible that those messages would be written several times within the same 

cycle for the same node and the same interface (if the node impacts several master 
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segments within the same cycle and several contacts get a lower time step than the 

minimum time step which was specified in option /DT/INTER/DEL).  
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14 Helpful Tools 
In this chapter you will learn more about the following helpful tools: 

• Functions /FUNCT 

• Table of Functions /TABLE 

• Added Mass /ADMAS 

• Group of Nodes /GRNOD 

• Group of Elements /GRoption 

• Nodal random noise /RANDOM 

• Surface Definition /SURF 

• Sections /SECT 

• Deactivation/activation /ACTIV 

• Type of analysis /ANALY 

• Sensors /SENSOR 

 

Functions /FUNCT 

Functions are used to define X – Y curves. Examples are material curves, failure 

models, and imposed motion. 

 

 
 

For values that are outside the domain defined, the function is linearly extrapolated 

with a slope defined by the last two points of the function. This behavior is different 

than some other explicit solvers. 
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Table Of Functions /TABLE 

Tables are used for some specific materials that may have temperature and/or strain 

rate dependencies. Up to 4 dimensions are available for some table types. 

 

 
 

Added Mass /ADMAS 

Added Masses are used to model non-structural mass such as connectors, wires, 

carpet, etc. A number of options are available for how the mass is distributed, 

defined by the ADMAS Type: 
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Added mass representing instrumentation is added to selected nodes in trunk:  

 

 
 

Group Of Nodes /GRNOD/Keyword 

Node Groups are used to define a list of nodes needed for any option that requires a 

group of nodes. An example is a group of nodes to which an initial velocity is 

applied. Some most often used keyword options are shown below. 
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Example Card Image: 

 
 

Group Of Elements /GRoption 

Element Groups are used to define a list of elements needed for any option that 

requires a group of elements. An example is a group of elements which is needed for 

a section definition. Typical options: 
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Surface Definition /SURF 

A surface is a set of 3-node or 4-node segments. Surfaces are used to define 

interfaces and pressure loads. All nodes must belong to a 3- or 4-node shell or to a 

brick element. 

/SURF/Keyword/EXT – Take 

the outer surface of the solid 

blocks (even it is made with 

several parts) 

/SURF/Keyword/ALL – Take 

all the facets of the shell and 

solid elements. 

*Some keywords have additional options 

 

Nodal random noise /RANDOM 

Describes the nodal random noise to check stability of model by introducing random 

noise on nodal coordinates. Used for modeling geometric imperfection in nonlinear 

buckling analysis. 

 

Sections /SECT 

A section is a cut in the structure where forces, moments or energy will be 

computed and stored in output files (using /TH/SECTIO). 

In RADIOSS /SECT, /SECT/PARAL and /SECT/CIRCLE can be used to define a section. 
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Sensors /SENSOR 

A sensor can be used to activate or deactivate a variety of features within RADIOSS.A 

variety of sensor types are available:  

 
 

Examples of sensor usage: 

• To deactivate the global rigid body defined 

on the car during the “flying” phase just 

before the impact on the ground 

• To define fire time of safety devices 

(seatbelt pretensioner, airbag,..) 
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Deactivation/activation of element groups. /ACTIV 

• Iform= 1: all elements belonging to specified groups are deactivated when 

the sensor is activated (ON). These elements are not deleted. They may be 

reactivated when the sensor is deactivated - see /SENSOR criteria. 

• Iform=2: All elements belonging to specified groups are activated when: 

T>Tstart 

or T>Tstart+Tsensor if a sensor is given 

All elements belonging to specified groups are deactivated when: 

T>Tstop 

or T>Tstop+Tsensor if a sensor is given 

• Deactivated elements must not belong to any rigid bodies. 

 

Type of analysis /ANALY 

• Defines the type of analysis and sets analysis flags 

• If N2D3D ≠ 0, for example; for axisymmetrical and plane strain analysis, the 

elements must be defined in YZ plane and their normals have to be in the positive x-

position. 

• In axisymmetrical analysis (N2D3D =1), Y is the radial direction and Z is the axis 

of revolution. In plane strain analysis (N2D3D =2), X is the plane strain direction. 

• Use 2D solid QUAD elements for Axisymmetrical and Plane strain analysis 

 

How Can I Do It? 

I need the simulation to terminate when the contact force reaches 100kN.Can I 

perform it in  

RADIOSS? 

You can do this using /STOP/LSENSOR option, which stops the engine due to sensor 

activation when the first sensor in the defined list is activated. Define 

/SENSOR/INTER in the model and provide the normal force (100 kN) to activate this 

sensor. Recall this sensor in /STOP/ LSENSOR which will stop the engine when the 

/SENSOR/INTER sensor is activated 
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Restarting A Run In RADIOSS  

If you need to continue the calculation without modifying any definitions in Starter, 

run the (i+1)th Engine file (Runname_000(i+1).rad). 

For Example: 

run Starter: TEST_0000.rad run the first Engine: TEST_0001.rad 

run the second Engine: TEST_0002.rad > to continue the run after TEST_0001.rad 

RADIOSS could restart the calculation from the last restart file which was created by 

running TEST_0001.rad 

 

Procedure To Restart A RADIOSS Run 

  

https://altairuniversity.com/learning-library/5-procedure-to-restart-a-radioss-run/
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15 Checks During & After 

Analysis 
A computation may be wrong even if the run does not fail. If the calculation goes to 

the end, it illustrates a good numerical behavior but not inevitably a good physical 

response. However, it is required to receive the message "Normal termination" at 

the end of the Engine output file, to validate numerical resolution procedures. The 

validity of results can be demonstrated by satisfying the following conditions: 

• Numerical stability 

• Physical behavior 

• Physical reliability 

The numerical stability is ensured if a message "Normal termination" and energy and 

mass balance are verified. If the numerical model does not really represent the 

physical problem, the wrong results may be obtained. To understand the problem, 

first you need to ask good questions, which should be answered to put in evidence 

the reliability of results: 

• How dependent is the result on friction? 

• How dependent is the model on rupture phenomena? 

• How dependent is the result on unknown material parameters? 

• How dependent is the model on other phenomena that are difficult to 

simulate? 

If the results are highly dependent to a given parameter, then the experimental test 

must be realized to use high precision values for computation. 

Note: The best model is that for which you know the values of physical parameters! 

 

Divergence 

Divergence occurs when one of the following conditions is observed: 

• Positive energy error (except for the first cycle) 

• Negative energy error by more than 15% (except for the first cycle) 
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• Kinematic time step activation in interface Type 7 

• Time step given by a rigid body 

• Unexplained changes in time step 

• Quick increase of mass 

 

There are three types of divergence: 

Quick divergence; Energy error increase is often exponential. The calculation fails in 

few cycles. Potential causes are: 

• Incompatible kinematic conditions 

• Negative stiffness in spring 

• Negative stiffness in tabulated material law 

• Slave nodes too far from the master surface in interface TYPE2 

Late divergence 

• Time step is too low. The structure is distorted and high penetrations in a lot 

of interfaces are observed. 

• Potential cause is the mesh quality 

Slow divergence; The final error is not necessarily the cause of divergence. Potential 

causes: 

• For a linear divergence, the cause can be the existence of incompatible 

kinematic conditions. 

• For a sinusoidal divergence, it is typically liberated or generated energy 

(example: initial penetrations and spring stiffness functions). 

• Too soft of a material can also be the cause. 

It is important to find which event triggered the problem. The event just before the 

divergence needs to be checked. If a strange behavior is observed for a given part, 

the connected parts and previous events also have to be studied. 

 

Run Problems 

Run Stops At Cycle 0 

The data is not written in the Engine output file runname_0001.out. This is generally 

due to bad running procedure when the Restart file cannot be read properly. 
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Run Stops After Few Cycles 

The data is written in the Engine output file runname_0001.out. The origin of the 

problem can either be the incompatible kinematic conditions (for example: rigid 

bodies with a common slave node) or out of bounds values in material or element 

properties; although, initial penetrations may be the cause. 

Run Stops During Computation 

First check the required disk space, then the behavior just before and after 

divergence can be studied. The time step evolution and the energy error need to be 

observed. 

Negative Volume Message 

This is mainly due to high deformation of solid meshes. Fully-integrated brick 

elements are especially affected by this problem which may be caused by a bad 

interface behavior or bad material definitions. In any case, the use of co-rotational 

formulation is recommended to avoid bad shear deformation response. The Stress-

Strain Computation Options (/PROP) assumption can be used with /DT/BRICK/CST to 

avoid negative volumes (refer to Time Step and Finite Elements for more details 

about this option). 

 

Numerical validation includes the following steps which will be discussed below: 

a) Starter output file diagnostics 

b) Engine output file diagnostics 

c) Review of simulation energies 

d) Typical debugging scenarios 

e) Validation 

 

In general: 

• Many modeling errors can be checked in the pre-processor 

• The RADIOSS Starter will check the model completely 

• All errors need to be corrected for the simulation to run 

• All warnings must be reviewed to ensure a valid simulation 

• Review penetrations 
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• Fix real incompatible kinematic conditions 

• Check time step (element and nodal) 

• Check mass and center of gravity calculated by starter 

 

a) Review The Diagnostics In Starter Output File 

Check Mass And Inertia: 

• Total mass and inertia should conform to expected values 

• Mass of the parts (if necessary) 

 

 
 

Review Element And Nodal Time: 

• Minimum time step value should conform to what is expected 

• Otherwise check element shape, material and/or property 

 

 
 

Examine any Incompatible Kinematic Condition (IKC) warnings: 

• The RADIOSS starter does not check if the IKCs are really incompatible 

• For example, if they are strictly orthogonal or if they are not applied 

simultaneously, ignore the warning 

• If the IKC involves nodes that are slave to a rigid wall which are also part of a 

Type 2 interface, the nodes will be automatically removed from the rigid wall 
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Initial Run Checks For RADIOSS 

 
 

b) Review Diagnostics In Engine Output File 

Once the RADIOSS starter file check is completed without errors, the model can be 

computed and the Engine output file should be reviewed. 

 

 
 

 

https://altairuniversity.com/learning-library/3-initial-run-checks-for-radioss/
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In this Example Engine there is mass scaling & only gravity loading (no initial energy): 

 

 
 

Time Step:  Notice at t=0 the natural time step is reported, then at cycle=100, the 

time step shown is that set on /DT/NODA/CST in engine file (0.100E-05). Note: If the 

time step decreases and then it goes up quickly, there is not a problem. If it varies 

greatly from one cycle to another, it is maybe due to the interface stiffness. If the 

time step remains low, a problem has occurred. In this case, you have to find the 

node (or element) controlling the time step and try to understand why the decrease 

occurred. 

Mass Error:  Non-zero value printed because of mass added to meet specified time 

step 

Energy Error: In the first cycle of a run for which the initial energy of the system is 

null, a false energy balance introduces large relative error which can be ignored 

 

 
 

Check at the end of the computation in the engine output file: 

• Time step 

• Energy error 

• Mass error 
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“NORMAL TERMINATION” message should be printed.  

 

 
 

c) Energy Error 

• If the error is negative, it means that some energy has been dissipated. 

• In case of under integrated elements (Belytschko shells, solids with 1 integration 

point), the Hourglass Energy can explain a negative Energy Error since it is not 

counted in the energy balance. The normal amount of Hourglass energy is about 

10% to 15%. 

• If the error is positive, there is an energy creation. 

• In case of using QEPH shell formulation or fully integrated elements, the Energy 

Error can be slightly positive since there is no Hourglass energy and the 

computation is much more accurate. An error of 1% or 2% will be acceptable. 

• In case of a larger positive energy, the source of this energy has to be identified. 

Incompatible kinematic conditions can lead to such a situation. 

• If the error reaches ±99%, the computation has diverged; except in the first cycle 

of a run for which the initial energy of the system was null, so that a relatively 

false energy balance often introduces large relative error. 
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• It is recommended that  

 

 
 

• If using mass scaling to control time-step, the mass variation should be smaller 

than 1%  

• (Above 1%, check whether the nodes with added mass are moving and 

• consequently increasing kinetic energy), use /ANIM/NODA/ DMAS, /ANIM/MASS 

• Check Energies of parts critical to your analysis (Specify critical parts in Time 

History) /TH/PART, /TH/SUBS 

• Review animations closely along with stress and strain contours 

• If simulating a quasi-static loading then, ideally: 

 

 
 

Check Simulation’s Energy Balance 

Energy balance (from time history file - T01) 

 •  Plot all available energies on the same graph to evaluate globally the results  
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In Case Of Imposed Motion Or Loading: 

• Energy is added during the computation --> External work. 

• The external work is transformed to kinematic and internal energy.  

• Total energy will follow the external works 

• Numerical energies should be as small as possible. 

Remark : Due to its formulation, the energy error in the engine listing file can show 

±99% if there is no initial energy in the model. 

 

 
 

If The Energy Is Initially Set In The Model: 

• Translational Total Energy (TTE) should be constant or slightly decreasing (loss of 

energy) 

• TTE = IE + KE + RKE + CE + HE 

• If energy absorption is the goal then most of the kinetic energy should be 

transformed to internal energy. 

• Numerical energies should be as 

small as possible: 

o Contact energy, CE 

o Hourglass energy, HE 

o Spring energy 

o Rotational kinetic energy, 

RKE (except rotary 

machine application) 
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What If Contact Energy Is High? 

Normal value for contact energy is 0% to 5% of the total energy 

Contact internal = penetration value * contact force 

High contact energy in case: 

• Too soft contact stiffness 

• Too stiff contact stiffness 

To avoid high contact energy: 

• Set physical material parameters (young modulus, thickness) 

• Set recommended parameter for the contact definition  

• Set “physical” contact interface gap value. 

• Large contact energies relative to total energy can cause large negative Energy 

Errors because contact energy is not part of the Energy Error equation. If the 

simulation has friction and a lot of sliding contact, then the large contact energy 

and resulting energy error can be considered acceptable (verify by running 

simulation without friction). 

 

What About Hourglass Energy? 

Normal value for hourglass energy is 10% to 15% of the total energy when using 

under integrated elements (Belytschko shells, solids with 1 integration point). 

Hourglass Energy is not counted in Energy Error, so negative energy error can occur 

High hourglass energy in case under integrated elements without optimized 

parameters are utilized. 

To avoid high hourglass energy: 

• Set recommended parameter for the property definition 

• Fully integrated elements or 

• HEPH for solid elements 

• QEPH for shell elements    (HEPH & QEPH can result in slightly positive energy 

error, 1 to 2%) 
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Energy Balance 

Taking into account the external works, the total energy must remain constant or 

decrease slightly. The total energy can increase at the end of the computation, 

during the spring back or at the beginning during the first cycles. 

Internal energy + Kinetic energy + Hourglass energy + Contact Energy + … = Variation 

of the External Work 

If under-integrated elements are used, the total hourglass energy must remain lower 

than 10% of the total energy. If this is not the case, the mesh should be reworked or 

elements with physical stabilization method should be used. The contact energy is 

not really physical. For each subset and for each part the following limitation is 

recommended: 

 
 

The energy error is computed by RADIOSS as follows: 

Ek: Translational kinetic energy 

Ekr: Rotational kinetic energy 

Ei: Internal energy 

Ek1: Initial translational kinetic energy 

Ekr1: Initial rotational kinetic energy 

Ei1: Initial internal energy 

Ewk: External work 

Ewk1:Initial external work 

The Energy Error computed by RADIOSS is a percentage. If the error is negative, it 

means that some energy has been dissipated. In case of under integrated elements 

(Belytschko shells, solids with 1 integration point), the Hourglass energy can also 

explain a negative Energy Error since it is not counted in the energy balance. The 

normal amount of Hourglass energy is about 10% to 15%. 

Energy  error  should  be  0.0  <    Energy  Error  <  -5.0% 
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If the error is positive, there is an energy creation. In case of using QEPH shell 

formulation or fully integrated elements, the Energy Error can be slightly positive 

since there is no Hourglass energy and the computation is much more accurate. An 

error of 1% or 2% will be acceptable. 

In case of a more important positive energy, the source of this energy has to be 

identified. Incompatible kinematic conditions can lead to such a situation. 

If the error reaches +/-99%, the computation has diverged; except in the first cycle 

of a run for which the initial energy of the system was null, so that a relatively false 

energy balance often introduces large relative error. 

 

Mass Balance 

If the mass increases, its variation must remain smaller than 1% for each subset and 

for each part (dM/M < 1%). If the mass variation is between 1% to 3%, you have to 

check if the nodes with the added mass are moving or not. If this is the case, the 

added mass results in an increase in kinetic energy. For more than 3% of variation, 

the results are probably bad. 

• The added mass can be due to Interface Type 2, Spotflag =1.  In this case, the 

added mass is totally made at time t=0. 

• In case of added mass in the model, it is necessary to check if it is insignificant 

with respect to the total mass of the model (see the DM/M value in the last 

column in the RADIOSS Engine listing file (Runname_nnnn.out)). 

• It is also important to post-process this added mass in order to check that it is 

not too large locally, since this could mean false results (for checking this, the 

Animations written with /ANIM/NODA/DMAS have to be visualized). 

 

Momentum Balance 

The dynamic equilibrium of each node is satisfied by the Newton law at the end of 

each cycle. As RADIOSS resolves the equilibrium equations at each cycle, normally 

the momentum balance is satisfied. However in case of a problem, a cross-check 

between nodal accelerations and the impactor forces (interface, rigid wall, barrier, 

etc.) can help to better understand problems. 
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Visual inspection of Deformed Parts 

After getting some animation files, the overall deformation of the structure can be 

compared to the physical behavior. You can inspect the deformed shape to ensure: 

• There are no flying nodes (parts). 

• The deformed shape is smooth. 

• The chord angle between adjacent elements is sufficiently small. 

• There are no intersections. 

Good physical behavior is obtained when:  

• The plastic strain is less than 30%   

 

 
 

Meaningless Results 

Contact forces, von Mises stress, nodal velocities and accelerations have to be 

checked carefully. If the values are meaningless (for example: von Mises stress = 1 

GPa), the first check may be the unit system consistency. Refer to the Unit Systems 

conversion table below for more information. 
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Basic Relations 
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Unit System 
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d) Typical Debugging Scenarios 

Energy Error 

• Check the last animation file (written before the computation stops with option 

/STOP in the engine file). 

• Usual issue : 

• Imposed time step too high 

• Material badly defined 

• Elastic material with large deformation 

• Contact interface (stiffness, gap, contact penetrations and intersections) not 

correctly defined 

Mass Error 

• Check the last animation file (written before the computation stops with 

option /STOP in the engine file). 

• Usual issue : 

• Imposed time step too high 

• Material and property (spring) badly defined 

• Elastic material with large deformation 

• Contact interface (stiffness, gap) not correctly defined 

Negative Volume  

• The material is not correctly defined for large deformation (densification phase) 

Countermeasure: 

• Improve the material definition 

• Add a self impact interface in the solid block with a gap value corresponding to 

the maximum compression value of the solid element. 

• Add failure in the material model 

Time Step is Negative 

• Issue in the tied interface (/INTER/TYPE2). The slave node is not correctly 

projected to the master surface 

• Improve the projection or the interface master and slave group definition 

• Set the flag Spotflag=1 in the contact interface TYPE2 
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d) Validation 

• Numerical validation is necessary, but not sufficient for a valid simulation 

• Build confidence by comparing to physical tests 

• Animations of results should be compared to what’s expected to check for: 

o Boundary conditions 

o Loading 

o Material modeling 

o Proper contact 

definition 

o Etc. 

 

In the following video series Rahul Rajan describes some typical debugging 

techniques  

 

 
Starter Crash (14 minutes) 

 

https://altairuniversity.com/learning-library/vii_e_issues-with-the-starter-file-in-radioss/
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Engine Crash Before First Cycle (5 minutes) 

 

 

 
      Engine Crash After Several Cycles (8 minutes) 

 

 

https://altairuniversity.com/learning-library/viii_b_issues-with-the-engine-file-in-radioss/
https://altairuniversity.com/learning-library/viii_c_issues-with-engine-file-after-several-cycles-in-radioss/
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      Troubles With Energy and Time Step (7 minutes) 

 

 
     Troubles With Material Definition (4 minutes) 

 

 
Troubles with Interfaces (7 minutes) 

https://altairuniversity.com/learning-library/viii_d_issues-with-energy-and-time-step-in-radioss/
https://altairuniversity.com/learning-library/viii_e_issues-with-materials-in-radioss/
https://altairuniversity.com/learning-library/viii_f_issues-with-contacts-in-radioss/
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Basics on Post processing RADIOSS results (9 minutes) 

 

 
Initial Run checks for RADIOSS (7 minutes) 

 

 

Results Checking 

How Is The Energy Error In The Listing File (Runname_0001Out) Computed?  

 
Ek is the translational kinetic energy at current time 

Ekr is the rotational kinetic energy at current time  

Ei is the internal energy 

Ewk  is the work of external forces (energy brought to the system) 

E,1 is the energy at beginning of the RUN (not at time t=0) 

https://www.youtube.com/watch?v=Mme78aIhMOY
https://www.youtube.com/watch?v=OFQUW-yzbVs
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The Hourglass energy is not counted in this energy balance, so that a negative 

energy error generally occurs (except if using QEPH or BATOZ shells, and fully 

integrated solids, for which there is no Hourglass). 

It is bounded to symbol_plus-minus99%. The energy error is reset after each 

RESTART. 

It is possible to stop a job and rerun it by using a control file containing /CHKPT. In 

this case, error and energy values will restart from their last value. 

  

How to Understand  The Energy Error, And Which Values Are Reasonable Values?  

The Energy Error computed by RADIOSS is a percentage. 

If the error is negative, it means that some energy has been dissipated. 

In case of under integrated elements (Belytschko shells, solids with 1 integration 

point), the Hourglass energy can also explain a negative Energy Error since it is not 

counted in the energy balance. The normal amount of Hourglass energy is about 

10% to 15%. 

If the error is positive, there is an energy creation. 

In case of using QEPH shell formulation or fully integrated elements, the Energy 

Error can be slightly positive since there is no Hourglass energy and the computation 

is much more accurate. An error of 1% or 2% will be acceptable. 

In case of a more important positive energy, the source of this energy has to be 

identified. Incompatible kinematic conditions can lead to such a situation. 

If the error reaches symbol_plus-minus99%, the computation has diverged; except in 

the first cycle of a run for which the initial energy of the system was null, so that a 

relatively false energy balance often introduces large relative error. 
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16 Best Practice 
Meshing Recommendations 

The shell mesh must be as homogenous as possible. For very fine meshes, it is 

recommended to use fully-integrated elements or a physical stabilization method. 

Triangle shells are avoided. If the mesh includes triangles due to a difficult mesh, it is 

recommended to reduce its number to 5% per part. 

In Radioss what kind of mesh quality given often depends on the robustness of the 

elements. Often, an explicit run has different exigencies than an implicit one, for 

example, homogeneous mesh is more important for explicit (due to time step), than 

implicit and positive Jacobi warpage, skewness and aspect ratio are more important 

for implicit (due to convergence), than explicit. Initially, getting a good mesh quality 

condition is necessary for a good simulation result. 

It is not recommended to use different kinds of element formulation in a given 

physical part. Fully-integrated and under- integrated elements do not have the same 

stiffness matrices; but they do have the same mass matrix. The transition of 

momentum between these two kinds of elements may be a problem. To reduce the 

number of triangles and to improve the consistency of the mesh, the following 

transition patterns should be used 

 

 
 

It is recommended to use elements as regular as possible with an angle typically 

between 45 and 120 degrees. The ratio between the largest and smallest edge is not 

critical for explicit formulation. A uniform mesh is recommended to distribute mass 
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uniformly over the structure. It is possible to avoid triangle creation, even for a 

triangular geometry or a circle. 

 

 
 

The minimum number of elements in the width is: 

• 1 for the parts working with quasi- 

uniform stress distribution as pressure and shear loading without bending 

• 2 for elastic behavior, including 

bending 

• 3 for low accuracy elastoplastic behavior 

• 5 for good accuracy elastoplastic 

behavior 

• 10 for good accuracy elastoplastic behavior, including local loading or local 

discontinuities 
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Warping 

• Warping = h/L 

• Avoid zones with majority of warped 

elements 

• Warped elements introduce weak spots 

in the structure and may lead to Buckling at unphysical locations                 

         

Aspect Ratio 

• Aspect ratio = L/l 

• Bad aspect ratio can generate 

membrane instability with nodal time step control 

 

Number of Elements Per Wave Length 

• Minimum of 6 elements per wave length in the 

energy absorbing parts, preferably 10 to 12 

• Less elements may not capture buckling correctly 
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Element Size to Target a Time Step of 1 Microsecond 

• If the element is too small time step can be low  

• Minimum recommended size for shell elements = 5 mm 

• Average size for shell elements = 10 mm 

 

Percentage Of Triangles 

• Triangular elements have no hourglass modes 

• Membrane stiffness is too high 

• Recommended percentage  <  10% 

• Used for : mesh transition, replace highly warped 4 node shells 

 

Number Of Elements Per Side Length 

• On flanges, parts with holes 

• Minimum of 3 elements per side of any section 

• If less, bad behavior in bending 

 

 
Note The Different Numbers Of Elements  

 

Meshing On Neutral Plane 

• Keep the true geometry of the part (section, inertia …) 

• Keep the true distance between the different parts (contacts) 
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Keep All Flanges 

• Need for welding and keep the true geometry 

 

Suppress The Small Details 

• Delete holes smaller than the reference mesh size 

• Remove the shape details which are not necessary 
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Variable Mesh Size Not Recommended for Crash but Recommended for Structural 

Analysis 

 

 

 

 

 

For crash analysis, constant mesh size (by using trias) is preferred (due to a 

minimum element length and a time step criteria 
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Follow the mesh flow line requirement 

Rotating Quads 

Recommended for Strutural Analysis 

Not Recommended for Crash Analysis 

 

Mixed mesh type 

Recommended for Crash Analysis 

Not Recommended for Structural Analysis 

 

 

Diamond elements are not allowed 

 

 

 

Quality Model 

• Follow the meshing recommendations 

• Average mesh size: 10mm 

Shell 

• Q4 Belytchko & Tsai (BT)  

• 5 IP through the thickness 

• Ishell = 4 (improved hourglass formulation) 

• Ismstr = 0 (default value) 

• Ithick = 1  (thickness changes) 

• Iplast = 1 (Iterative plasticity) 
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Solid 

• Isolid = 0 (default with 1 IP) 

• Ismstr = 0 (default value) 

1 Pay Attention To The Mesh Size (For Time Step Issues) 

2 Simplify The Model (Geometry, Symmetry) 

Example: Remove or simplify details (fillet, edges..) which are << than mesh size 

 

 
 

3 Adjust Your Meshing Style As A Function Of Part Dimension 

if mesh size > 4* thickness then use shell mesh 

We recommend using QEPH elements for shells on the critical parts with the 

following options 

• IPLAST set to 1 

• N = 5 (number of integration point through the thickness) 

if mesh size < 4* thickness then use solid mesh  

If you have:  

• element through the thickness (not recommended) then use fully 

integrated solids (HA8) or thick shells 

• more than 1 element through the thickness then use HEPH 
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4 Choose A Unit System And Be Consistent With It 

Most commonly used unit system :  

  [mm][ms][kg] => [Gpa][KN] | g=0.00981 mm/ms2 

  [mm][ms][g] => [Mpa][N] | g=0.00981 mm/ms2 

  [mm][s][Mg] => [Mpa][N] | g=9810 mm/s2 

 

5 Always Check The Model Before Running It (Listing File) Here Is List Of 

Check That Should Be Performed: 

• Check the mass and center of gravity 

• Time Step of different entities 

• Check for free parts and the connectivity of the model (Tools>Find 

Connectivity) 

• Penetrations and intersections should be removed from the model with 

Tools>Penetration Check in Hypermesh or Quality>Check All Solver Contact 

Interfaces in Hypercrash  

• Use Quality> ModelChecker in HyperCrash or Tools>model 

checker>Radiossblock in Hypermesh 

• Common mistakes :  

o loose nodes of spring,  

o incompatible kinematics conditions,  

o nodes in multiple rigid bodies,  

o master node of rigid body on elements,  

o null thickness… 

 

6 Always Check Your Energy Balance And Added Mass Percentage 

For common structural problems (frontal crash, Impact,…): 

• Added mass < 2% ; Energy error negative and < 5%   

• Watch for sudden changes in time step and energy spikes 
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7 Energy Balance In Initial Velocity Problems: 

• Energy Balance is not respected in Imposed Conditions 

 

8 Check Energies Of Parts Critical To Your Analysis 

• Specify parts critical to your analysis in Time History 

 

9 Review Animations Closely 

• Review Stress and Strain contours and perhaps other contours relevant to 

your analysis 

• Some CAE Engineers have a bad habit of just reviewing the time history plots 

and making a decision or changing the model – Not Recommended 

 

10 Process of elimination technique helps debugging 

• If you cannot identify problem with input deck, keep deleting entities or 

disabling options to rule out possibilities 

 

11 Track Changes And Document Results 

• You could loose track of changes very easily – Recommended to document 

in the Header Card of the RADIOSS Deck 

• Programs like Xdiff (linux/unix) and Compare (Windows) sometimes help 
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Model Preparation 

Dedicated Altair pre-processor tools integrate a large number of model checkers. 

These tools also include automatic correction algorithms. The most common checks 

before running a model are related to: 

 

• Mesh quality: mesh with 2D>Automesh>QI optimize and set min size in Edit 

criteria. Use the 2D>qualityindex, 2D>elem cleanup, tools>check elem to check and 

modify the mesh. 

 

• Spring definition: Non-physical or bad definition of springs is a common 

problem in crash models. In fact, the properties of springs must be consistent in 

mass, inertia, stiffness and length. 

 

• Intersections and penetrations in interface definition: Initial mesh 

intersections create unrealistic connections. Moreover, this can cause locking 

situations leading to computation failure. Initial penetrations are due to the 

interface gap definition. They lead to unrealistic and uncontrolled internal forces 

which may cause local plastic strains in the beginning of the computation. The 

structure is then locally less stiff. 

 

• Checking the incompatible kinematic conditions: Incompatible conditions 

may results in an increase of the total energy and non-reproducibility of results in 

parallel computation. Radioss Starter detects the potential incompatible conditions 

that must be checked by you. 

 

• No common slaves nodes between rigid bodies Only "free" master node 

Spherical inertia for the small ones 

 

• Mass and center of gravity 
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• Thickness of the parts 

 

• Initial velocity value and direction 

 

• Rigid wall normal 

 

• Material law: units system consistency 

 

• Free nodes 

 

• Monitored volume: Closed volume Positive volume 

 

• Connectivity between parts 

 

• Mesh sizes between connected parts
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17 Postprocessing - 

Crashworthiness 
This chapter will cover the necessary tools for post processing a crash analysis 

(transient dynamic event). 

The topics covered include: 

·    Measures – Distance Between and Position 

·    Section cuts 

·    Vector plots 

·    Tracking 

·    Tracing 

·    Exploded views 

·    Synchronizing data 

·    Video/Image overlay 

·    Export deformed shape 

·    Crash Tools for Plotting 

·    Collision detection 

 

17.1 Measures – Distance Between and Position 

This section will focus on how to use the Measure panel to 

measure the Distance Between two entities and also to measure 

an entities Position. 

Measure Panel. Click on “Add” to add a new measure entity. 

Alternatively, right mouse click in the Result Browser.   
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Distance Between 

By setting the Measure Type to “Distance Between”, we can measure the distance 

between two entities over a period of time. 

You can measure the distance between either two Nodes or two Systems. Create a 

measure using Results browser > Model View + Entity Editor. 

In the example below: 

Standard > Entity IDs > Nodes, the right front tire and the right rear tire nodes are 

selected. 

 

 
 

Then the Standard >Items > Select … > Create Curves option was selected. 
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This opened a new dialog box to set Axis and Live Link option > OK and a curve was 

created. 

 

 
 

This curve has the magnitude as the Y axis and time as the X axis. 

Once the model is animated, the curve is created and plotted: 

 

 
 

Position 

Setting the Measure Type to “Position” allows you to measure the X, Y and Z position 

of a Node or System. 
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For example, the position of 1 or multiple nodes over a crash event 

Set the Measure Group type to “Position” and select 1 or multiple nodes. 

 

 
 

 



    
 

317 

Using the same model and nodes as in the image above, a Measure Group was 

created at each node.  Notice how in the Graphics Area the X, Y, and Z positions are 

reported. 

Curves are created for each Measure Group as well using the X position as the Y axis 

and time as the X axis: 

 

 
 

17.2 Section Cuts 

The Section Cut panel allows you to cut planar or deformable sections through a 

model. This is useful if you want to see details inside a model. 

Create a section cut using Results browser > Model View + Entity Editor. 

To access this panel, click the Section Cut icon         , on the Display toolbar to display 

the Section Cut panel. 

You can also use the Results Browser > Model View > Create > Section Cut to set the 

section cut in the Entity Editor. 
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The section cuts defined for the current model are listed in the Section Cuts list. 

 

 
 

You can add and delete section cuts in the list using the Create and Delete. The 

browser allows you to display one or more section cuts. 

To create a section cut, you must first define the plane of the section that you want 

to view. 

A plane is defined by using one of the following methods Standard > Type > Section 

Plane dialog box: 

• X, Y, or Z Axis: Cuts the model along the designated axis.  The base node is optional if 

you want to specify a certain location to cut the model. 

• Vectors:  Uses a predefined vector. 

• N1 N2 N3:  Defines the normal direction of the cutting plane when nodes are picked 

on the model for N1, N2, and N3 using the mouse. 

• Normal to screen:  Specify a plane normal to the screen by picking a base node on 

the model. 
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• Base:  Allows you to check the current position of the section cut. Double-click on 

Base to enter a Base Node ID or enter user-defined X, Y, and Z coordinates. 

 

 
 

Once a plane is defined, Standard > Position and Manipulator (drag it with your left 

mouse button) in the graphic area can be used to examine your model by controlling 

the position of the section cut. 

 

 
 

You can also choose how you want the section cut to be applied to the model.  By 

default, it displays a section cut of the model when the model passes through the 

plane. 

Display > Deformable allows the sections cut to be deformed, along with the 

components, during animation. 
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There are also various display options available for a section cut. The section cut can 

be displayed as:  

Cross Section Only 

 
 

Cross Section Width Widths 

 



    
 

321 

 

Clip Elements 

 
 

This will clip the elements that pass through the section cut so that a smooth section 

cut is shown. Unchecking this option will not clip the elements so that the whole 

element is shown. 

The Section color option allows you to assign a color to the cross section. The Grid 

option simply adds a gridline to the section cut. 

There are also options for displaying the clipped geometry as: 

 

Feature Lines 
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Transparency Mode 

 
 

Cross-Section Measurements and Path Plots 

Measures can be defined on the nodes of a cross-section enabling a deeper analysis 

of the deformation of the section. 

Typical applications of measuring values on the cross-section include plotting the 

position or distance between nodes on the cross-section (as measuring the intrusion 

shown in the image below). 

A distance between measures on the opposing sides of the vehicle B-pillar section 

shows how close the structure is intruding into the occupant compartment. 

The measurement on a cross-section can be helpful in identifying the minimum 

distance separating the two sides that may not be possible by considering only the 

mesh nodes. 
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In addition to making position based measurements on the nodes of a cross section, 

you can also graph the section or any portion of the continuous segments by 

defining a node path on the cross-section cuts and cross plotting node X, Y, or Z 

locations (or the distance between them). 

Result variations along a section cut can also be studied by defining a node path 

along the cut. This helps engineers to assess the variation of a result along a user 

specified path on a cut section. 

For stamping, it is often necessary to validate simulation against test data. 

One of the common ways to obtain test data is to cut the stamped part into two 

pieces and then measure the thickness along the length of the cut. 

To be able to compare FEA results against such data, a path needs to be defined 

along the cut section of the FEA model and must be able to plot a selected FEA 

results type as illustrated below: 

 

  
 

The nodes on the section cuts are also accessible from the Notes panel to attach any 

text based annotations to the cross sections. 
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17.3 Vector Plots 

The Vector panel allows you to create vector plots that can be used to display any 

vector data associated to nodes. Examples include displacement, velocity, and 

acceleration. 

To access the Vector panel: 

• Results browser > Result View 

• Click the Vector button,          , on the Results toolbar 

• From the main menu select Results > Plot > Vector 

 

 
 

The Vector panel works in the same way that the Contour or Tensor panels work. 
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First you must define the Result Type. 

For the Vector panel, all results are nodal vector results, and when available the 

Layers can also be specified. 

You can also select the Components that should be shown. Once the Result type and 

Components are selected, the Selection can be made as Nodes, Elements, or 

Components. 

If a cross section has been created and is active, there will be a Section selection 

available. When entities are not selected for the Selection, the entire model has the 

vector plot applied to it. 

 

 
 

The Resolved in system also works the same as in the Contour panel. 

Once you have created a vector plot, you can change how the vectors are displayed 

using the Display tab options. 

 

 
 

The Size scaling sets how the vectors are scaled or sized.  The three options are Auto, 

By Magnitude, and Uniform. 

• Auto:  Automatically scales the vector length at approximately 2% of the model size. 

• By Magnitude: The vector size is displayed relative to the value of the vectors.  The 

Scale value text box allows you to increase or decrease the size according to a 

scaling value. 
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• Uniform:  This displays all vectors in a uniform size. You can increase or decrease the 

size using the Scale value text box. 

 

 
 

The Color by option either shows the vector colored by the Value of the vector or by 

the Direction.  When Direction is selected, the X component is colored red, the Y 

component is colored green, and the Z component is colored blue. 

 

         
 

The next Display option sets how the vector is displayed.  The Vector heads can 

either be set to None or Arrow and the vector head can either be placed at the 

vector Tail, Tip, or Center. 
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The options included in the Plot tab. 

 

 
 

The available settings are Resultant or Components.  This shows the vectors as 

either a single resultant vector or the components. 

The final option, Show values, allows you to display the vector values in the graphics 

area. 

The options included in the Legend tab and Result display control options, behave 

the same as in the Contour panel. 

This includes the Plot Styles and accessing the plot styles from the Results Browser. 

 

     
 

Once the Selection and Display options have been selected, there are additional 

options available under the Section tab, where you can select options for projecting 

the vectors to the cross section plane. 
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A section cut has been applied to the model: the Selection input collector is set to 

Sections and the Resolved in system is set to Global. 

 

There are two additional options available in the Section tab. 

 

 
 

These are Projected and Evenly distributed. 

Projected will project the vectors onto the cross section. Below is an example of 

velocity vectors before and after the projection: 

 

 
    No Projection        Projected to the Cross Section 

 

Evenly distributed will evenly distribute the vectors on the cross section by the 

specific Number of rows and Number of columns. 
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Below is an example of the default distribution of vectors and an evenly distributed 

set of vectors. 

 

 
    Default Distribution        Even Distribution 

 

17.4 Tracking Systems 

The Tracking panel allows you to track any entity during animation. When an entity 

is tracked, the view remains constant with respect to the selected displacements 

and rotations of that entity. This enables you to view the dynamics of a model as the 

selected entity remains in the same location. 

To access the Tracking System: 

·    Results browser > Model View > Create > Tracking System 
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Click the Tracking icon            , on the Results toolbar 

Right click in the graphic area 

 

 
 

Main menu Results > Create > Tracking System 

 

 
 

HyperView now supports both model based and window based tracking systems. 

Tracking systems still belong to a particular model and are still defined using entities 

from a particular model, however the mode for a tracking system can now be set to 

either model based or window based. 

By default, a newly created tracking system will be model based. To change the 

mode to window based, activate the Window track option (located on the right side 

of the panel). 

 

Tracking Systems 

The tracking systems defined for the current model are listed in the Tracking 

Systems list or in the Results > Model View browser. 
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Tracking systems can be added to the Tracking Systems list (using the Add button) 

and then defined using a node, plane, component, or system. 

Keyboard shortcuts are also available for selecting items within the list: 

• Press the SHIFT or CTRL key on the keyboard + the left mouse button to select 

multiple items from the list. 

• Press the CTRL + A keys on the keyboard to select all items in the list. 

• Press the DELETE key on the keyboard to delete the selected tracking system(s). 

A tracking system is activated, or deactivated, using the radio button. 

In addition, you can access the following context menu options by right-clicking 

anywhere within the Tracking Systems list: 

 

 
 

Delete - Deletes the selected tracking system(s) from the list. 

Rename - Displays the Rename dialog, which allows you to rename the selected 

tracking system. 

Make Current - Allows you to select which tracking system will be activated and 

displayed in the graphics window. This option performs the same action as clicking 

the radio button “on” next to a tracking system. 

You can sort the items in the Tracking Systems list by clicking on the list heading. 

If Clear Tracking System is selected, no tracking system will be applied to the model. 

Activating the Clear Tracking System option clears the contour, and deactivates all of 

the tracking systems listed. 

A tracking system is associated with a model. When overlaying two models in the 

same window, you need to define a tracking system for each model for model shape 

comparison. 
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Tracking systems from other models in the window will be displayed in the Tracking 

Systems list provided those tracking systems are “window” based. 

For example, the first tracking system (T1) from the first model (M1) will be 

displayed as M1:T1 in another model’s tracking systems list. 

 

Track 

The Track options allow you to set the parameters that define a tracking system. 

 

 
 

Select an option from the drop-down menu and then define a Node, Plane and Plane 

type, Component, 

The model is animated with respect to the selected entity. A new node, plane, 

component, or coordinate system can be defined and tracked at any time during 

animation by picking different nodes or components in the window. 

Plane type - This option is activated for Plane tracking systems only! 

For tracking systems defined by a Plane, the local axis of the tracking systems can be 

aligned with any specific global direction by specifying the Plane type (available 

options are: OXY, 

OYZ, and OZX). This is useful in situations where the global coordinate system 

alignment differs from the model coordinate system. 

This option allows you to specify the local plane defined by three nodes. The normal 

vector of the plane is computed by a cross product of planar vectors formed by N1, 

N2, and N3: 
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• The first node (N1) always defines the Origin of the local coordinate system (the 

tracking system). 

• The direction from the first node (N1) to the second node (N2) defines the local axis. 

Use the Plane type drop-down menu to select one of the following: 

OXY - X-axis 

OYZ - Y-axis  

OZX - Z-axis 

• The third node (N3) lies in the plane of interest. 

Input Collector - The input collector allows you to select, or change, the entities 

which will be used to define the tracking system. You can do this by picking entities 

directly from the screen or by clicking the Nodes, Components input collector. 

 

Displacements 

 
 

Use the check boxes to select which displacements remain fixed within the window. 

• Global X - locks the view to the X position of the selected entity as it moves. The 

entity appears to remain stationary along the global X direction during animation. 

• Global Y - locks the view to the Y position of the selected entity as it moves. The 

entity appears to remain stationary along the global Y direction during animation. 

• Global Z - locks the view to the Z position of the selected entity as it moves. The 

entity appears to remain stationary along the global Z direction during animation. 

For example, selecting Global X locks the view to the X position of the selected entity 

as it moves. The entity appears to remain stationary along the global X direction 

during animation. Entities can also be tracked with respect to rotation. This is done 
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by activating the Lock rotations check box to lock the rotation movement of the 

selected entity. 

 

Rotations 

Entities can be tracked with respect to rotation. Activate the Lock rotations check 

box to lock the rotational movement of the selected entity. 

 

Window Track 

Activate this option to change the tracking system mode from “model” based to 

“window” based. Window based tracking systems from other models in the window 

will be displayed in the current model’s tracking systems list (provided the current 

model also contains window based tracking systems). 

For example, the first tracking system (T1) from the first model (M1) will be 

displayed as M1:T1 in another model’s tracking systems list. The entity definition for 

other models cannot be changed, however other properties of the tracking system 

can be changed (even though they are not part of the current model). 

A tracking system will be removed from another model’s tracking systems list 

whenever the Window track option is deactivated (changing the mode from 

“window” based back to “model” based). 

Once a tracking system is created, the Use Tracking System option will become 

available on other panels. For example, this option is available in the Contour panel. 

This allows you to create a contour plot with respect to this tracking system. Below 

is an example with and without a tracking system in a contour plot: 
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17.5 Tracing 

System, component, and node entities can be traced during animation. Line tracing 

for metal forming can also be performed by selecting nodes directly on the model or 

by importing a trimmed line definition. When an object is traced, an outline of the 

object is left behind at certain intervals along the path of motion. 

To access the Tracing: 

• Click the Tracing icon           , on the Annotations toolbar 

• Main menu Annotations  > Tracing 

 

 
 

You can trace nodes, components, systems and line by selecting one of the following 

Trace options: Node, Component, System or Line. Select the entity you want to trace 

By ID using the input collector or by picking them from the screen. 

The selected entities are displayed in the list box below the input collector. 

You can remove highlighted entities from the list by clicking on the Delete button. 
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You can also trace lines by activating the Line option, under Trace, and selecting 

either nodes or a trimmed line definition file as the line source. 

 

 
 

The image below shows a couple of examples. 

 

 
 

Once the entities are selected, the Tracing mode is defined. 

When From first step is selected, the selected entities are traced starting at the first 

step to the current step as the model is animated. 

For components, an outline of the selected entities is left behind at each time step. 

The traced path is erased when the animation starts over. 

If you are tracing nodes or systems, a line is drawn to illustrate the traced entities. 

When All steps is selected, all steps of the selected entities are traced. 

The final option, Last, restricts the traced path to the last user-specified time steps 

before the current step. 

This gives the appearance that the path is following the selected entities. 

Finally, the Display options are set. This allows you to see the Color and Thickness of 

the trace (except when component is selected). 



    
 

337 

Move with tracking system allows the trace to move along with entities relative to 

an active tracking system. 

 

 

17.6 Exploded View 

The Exploded View panel allows you to explode a model or selected components for 

improved visualization. 

You can then continue to select entities and perform post-processing procedures on 

the exploded model. 

Multiple explosions can be saved as part of a session file (*.mvw file) to be used later 

for design review or presentations. To access the Exploded View: 

Click the Exploded View icon           , on the Visualization toolbar 

 

 
 

By default there are two options available in the Explosions listing; Clear Explosion 

and Automatic Explosion. 

When Clear Explosion is selected, no explosion is applied on the model. 

When Automatic Explosion is selected, the explosion is applied to the entire model 

using pre- defined settings for center of gravity, direction, and magnitude. 

Below is an example of the Automatic Explosion: 
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The explosions defined for the current model are listed in the Explosions list. 

Customized explosions can be added and deleted using the Add and Delete buttons. 

 

 
 

The radio buttons allow you to select which explosion will currently be displayed in 

the graphics window. 

You can also select multiple explosion(s) and click the Delete button, in order to 

delete the selected explosions from the Explosions list. 

To create a custom explosion, the Components to be included in the explosion need 

to be selected under Selection. 

Then the Mode needs to be selected to determine the origin and orientation of the 

explosion: 

• Translate allows you to define the direction and distance (measured in model units) 

of the model translation. 

• Explode from model center sets the origin of the explosion at the model center 
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• Explode from selection center sets the origin at the center of the selected 

component. 

For both, the orientation of the explosion is defined using the Scale factor. 

 

 
 

The Scale factor can either be set to Uniform (all 3 directions translated uniformly) 

or Component (each direction can be translated a specified distance). Below is an 

example where a single component is exploded: 

 

    
 

 

Finally, to translate the components in the explosion, is selected. 

This moves the model explosion in (-) and out (+) based on the mode and distance 

(measured in model units) or the designated scale factor. 

There are two final options; Auto fit and Reset. 
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When Auto fit is activated, each time an explosion is added or deleted, the view is 

adjusted so that the exploded model fits in the window. If this option is not selected, 

the view is not adjusted and parts of the model could move out of the window. 

Reset simply returns the components to their default locations. 

 

17.7 Synchronizing Data and Windows 

The data obtained from a solver is generally on a different time scale than that of 

videos captured while prototype testing. 

In order to correlate the two, it is essential to bring them both to the same time 

scale and then apply the necessary changes so that they can be synchronized and 

studied together. 

This chapter outlines the procedure on how to synchronize data obtained from a 

solver to that of video captured while actual testing. 

 

Synchronizing Data 

To access the Synchronize Animation: 

• Tools menu > Synchronize Animation to display the dialog 
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• Visualization toolbar > Animation Controls icon > Time Scales… button 

• Click the Image Planes icon           , on the Annotations toolbar 

 

 
 

The Synchronize Window Animation dialog allows you to synchronize the animation, 

plot, and video windows on a page by applying appropriate scaling and offset values. 

This tool is useful for synchronizing windows that contain animation results in 

different units and/or begin at different time steps. 

Each window in the current page is listed in the Synchronize Window Animation 

dialog. 

The slider bar represents the global time line for all windows. It reflects all window 

time frames regardless of whether they are active or inactive. Each time frame is a 

subset of the range represented on the slider bar. 

Current time displays the current slider bar setting. 

 

 
     Synchronize Window Animation Slider Bar 

 

There are two methods you can use to synchronize multiple animations: 
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Using the slider bar 

Use the slider bar to specify a time for all active Time A and Time B fields. 

When the desired value is displayed in a specific field, click the lock button to set the 

value. After all fields have been defined, click Apply to automatically calculate and 

synchronize the animations. 

When you click Apply, the scale factors for the time values for each window are 

automatically calculated. The scale factor is calculated by subtracting Time A from 

Time B for each window. The end result is all the frames specified for Time A will 

appear at the same time during the animation. Similarly, all frames for Time B will 

appear at the same time. All other frames will be scaled accordingly. 

In this mode, you cannot enter data in the Scaling and Offset fields. They are used 

for reference only. 

 

 
 

Editing Scaling and Offset 

• Scaling - Multiplies the total running time of the animation by the specified amount. 

• The animation is then scaled to run within the new time boundaries.  An animation 

file that runs from 0 to 10 seconds scaled by a factor of 2 runs from 0 to 20 seconds. 

Likewise, if the scale factor is 0.5, the animation is adjusted to run from 0 to 5 

seconds. 

• Offset - Specifies how long to wait before animating the corresponding window. 

• When the page reaches the specified time value, animation starts in the delayed 

window. 
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• T1-T0 - Allows you view the time scale before the scale factor is applied (for 

reference only). 

• Scaled T1-T0 - Allows you view the time scale after the scale factor is applied (for 

reference only). 

 

 
 

The check boxes in the animate column              allow you to select the animations to 

be included in the synchronization. You can select all or select none of the 

animations, as well as reverse the current selection. 

 

Master Animation 

One of the animations listed in the Synchronize Window Animation dialog can be 

selected as the master animation with which all other animations will be 

synchronized. The time scale assigned to the master frame skips steps that are not 

relevant. 

An activated radio button indicates which window contains the master time frame 

and the Master check box designates that the master window should be used to 

synchronize all the windows in the list. 
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Synchronizing Windows 

The Synchronize Windows feature allows you to manipulate the view matrix of 

multiple models in multiple windows at the same time. To access the Synchronize 

Animation: 

 

   
 

 

Start/Set Synchronization 

The Synchronize Windows dialog allows you to set the synchronization settings and 

begin the synchronization. 

The number of available windows on the current page is represented by colored 

rectangles (which are arranged in the same page/window layout), and the active 

window is also displayed. 

By default, all windows are displayed in the current graphics window background 

color, indicating that these windows are active for view synchronization.  You can 

click on each of these rectangles (which represent a page window) to exclude it from 

the synchronization.  The background color of the window will change to the same 

color as the dialog for all windows that are excluded. 
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Synchronized Windows Dialog with Three Excluded Windows 

 

To include a currently excluded window, simply click on the rectangle again (and the 

background color will change back to the current graphics window background 

color). 

The Synchronize Windows dialog remains on top until you click OK, or close it. All 

activated windows will synchronize the view with the active one.  You can now use 

keyboard shortcuts and also the 3D view controls to move (rotate, zoom, etc.) the 

model.  Models in the linked windows will rotate or obey the same view upon 

applying view actions. If a selected window is a plot, text, or video window, then it is 

ignored. 

Changes to the window, page, and window layout (for example, adding new 

windows or pages) can still be made while the view synchronization is running.  If a 

new page is added using the add page or cut/copy/paste options, and the 

synchronized view mode was “on” prior to the addition, then the new page (and all 

the windows in that page) will be linked by default - until the mode is changed or 

stopped. 

 

Stop Synchronization 

Stops the synchronization across all windows/pages. 

To stop the view synchronization, click on the active Synchronize Windows icon              

on the Page Controls toolbar. 

Note:  No pop-up dialog is associated with this option. 
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17.8 Overlaying Images and Videos 

The Image Plane tab allows you to select and overlay images (such as company 

logos, watermarks, etc.) or videos in the graphics area for correlation and 

presentation purposes. Static positioning of these images with the model is 

available, as well as synchronization of the videos with HyperView model 

animations. 

 

Multiple images and videos can be loaded into HyperView, and each of these can be 

edited in the Image Plane tab. 

It is possible to load static images and video files at the same time (AVI, PNG, BMP, 

etc.) interchangeably on the image planes. 

 

The image planes can be 2D or 3D: 

• A 2D image plane places the media in the graphics area as a foreground or 

background to the models that are loaded. 

• A 3D image plane embeds the media in the model space so that when the model 

view is rotated or panned, the related media will also change correspondingly. This 

is particularly useful for correlating simulation with multiple videos or static images 

that are captured with various views. 
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Example Model With 2D And 3D Image Planes 

 

To access the Image Planes: 

 

• Click the Image Planes icon on the Annotations toolbar 

 •  Results Browser > Model View > Create > Image Plane 

      
Image Plane Tab 
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The width of the entire Image Plane tab can be resized to adjust for the image/video 

resolution. To resize the width of the browser, click on the vertical line which 

separates the tab from the graphic display area and drag and release the mouse 

button when the width is the desired size. 

 

You can save, and later restore, the settings of image planes (position and 

orientation with a given model) by saving your work session as a Session File. 

To enable comparison of multiple sets of simulation results with each other, or 

against various physical test data, Report Templates will accept the image/video files 

as parameters for every instance of comparison. 

 

This is useful for comparing the test and simulation results, as well as comparing 

across variants of a design. 

 

In addition, you can use the Apply Style To option to apply a 2D or 3D Image Plane to 

multiple windows. 

 

This has the effect of copying the image planes from the source window to all the 

target windows that require the image planes. 

A background image like a company logo or a test video positioned in one animation 

window can be quickly copied to all relevant animation windows using the Apply 

Style option. 

 

H3D Export is also supported for static images. 

All image planes that contain background or foreground, as well as 3D planes, will be 

embedded in the H3D file for visual display in HyperView Player. 

Only static images are supported at this time. 
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The main Image Plane tab options and sub-tabs that are available are dependent on 

the type of image plane selected: 

• 2D Image Planes 

• 3D Image Planes 

 

2D Image Planes 

The 2D Image Plane tab is primarily used for displaying static images and videos in 

the foreground or background of the graphics window. The image planes can be 

stacked on top of each other, or against the model. To accommodate multiple media 

files in the graphics to be clearly visible, the 2D image planes can be resized and 

positioned in the graphics area. Various image processing filters and transparency 

settings allow you to adjust the media visibility to achieve a desired effect. 

Select the 2D option from the Type drop-down menu to display the 2D Image Plane 

tab. 
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2D Image Plane Tab 

 

A Label is then entered which is used to reference the image plane in the Results 

Browser. Labels can also be updated using the Rename option on the Results 

Browser context menu. Then the file containing the image is selected in the File 

field. 

Many file types are supported including JPEG, TIF, BMP, AVI, and AMF (please refer 

to the online help for a full listing of the supported file types). 

Once the file is loaded, the image is shown in both the Image Plane tab > Viewing 

Area and the graphics area. 
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The Crop              tool allows you to crop an image so that only a desired portion of 

the media can be seen in the graphics window.  The content that is displayed in the 

image plane is controlled by what is cropped. Click the Crop icon to activate the crop 

tool inside the Image Plane tab viewing area, and use your mouse to select the crop 

area (a rectangle which defines what part of the image you want to keep). The 

image in the graphics area will be updated immediately upon release of the mouse 

button, however the image in the Image Plane tab viewing area will remain 

unchanged. Click the Crop icon again to deactivate the Crop tool. Right-clicking on 

the Crop icon resets the crop tool and draws the full picture in the image plane. 

The other tools in the viewing area include the Zoom tool            . This tool allows you 

to zoom the image in the Image Plane tab viewing area in or out.  Left-click on the 

Zoom icon to zoom in on the image, or right-click on the image to zoom out. The 

current zoom percentage is displayed to the Zoom field. You can also manually enter 

a zoom percentage directly into the Zoom field. The Zoom tool does not have an 

effect on the image in the graphics area. The size of the image in the graphics area is 

controlled by the graphical manipulator. To resize the image in the graphics area, 

simply left click on one of the corners of the image and drag the corner to resize the 

image. 
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There is also a Time Scales tool. Click this button to display the Synchronize Window 

Animation dialog, which allows you to synchronize windows that contain animation 

results in different units and/or begin at different time steps. Both model and video 

animations will be displayed in this dialog. The Time Scales option is only valid for 

use in the Transient animation mode. 

Sync Mode - The drop-down menu allows you to adjust the scale used to 

synchronize the video time scale with the animation by selecting one of the 

following options: 

• Manual - The default setting in which no changes or adjustments are made.  The 

mode will automatically return to Manual whenever you manually update the scale. 

• Length - Adjusts the scale so that the video starts and finishes at the same time as 

the animating model. 

• Framerate - Adjusts the scale so that the video and model play at the same speed.  

In other words, during animation the index of the video frame will correspond with 

the index of the animation frame. 

Length and Framerate adjustments can be seen in the row of the image plane file 

and the column labeled Scaling in the Synchronize Window Animation dialog. The 

time scales for the video are automatically adjusted whenever the Sync Mode is 

changed from Manual to Length or Framerate, or when switching between the 

Length and Framerate modes. The Manual mode simply retains whatever is the last 

setting of the time scales. 

To undo any Sync Mode adjustments, you can manually change the scale or click the 

Reset button in the Synchronize Window Animation dialog. 

Adjusting the scale of any image plane will have an effect on the overall speed of the 

animation. 

Sync Model - The automatic sync modes of Length and Framerate are dependent on 

the animating frames of the model to which they are referenced. If more than one 

model is present in the animation window, you can choose the reference model 

from the Sync Model dropdown menu. The scales are adjusted based on the number 

of frames in the selected model to synchronize the video. 
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Each image plane has a mode set for synchronization and depending on the mode, a 

reference model to sync with. No model reference is available when the Sync Mode 

is set to Manual. If a model that is referenced by an image plane is deleted, the Sync 

Mode will be set back to Manual. 

The Sync Mode and the model to which an image plane is referenced, Sync Model, 

are rightly propagated when the information is copied to other windows in a session 

using the Apply Style or Copy/Paste operations. 

At the bottom of the Image Plane tab there are additional sub-tabs available. 

For 2D Image Planes, these tools include Anchor, Display Options, Z-Stack, and Filter. 

 

 
 

Anchor allows you to select or change the location of the image plane relative to the 

graphics area. The options available are listed below: 

 

 
 

The Reset option will return the image/video in the graphics area to the state when 

it was originally loaded. 

In addition to the Anchor tools, the graphical manipulator can be used to reposition 

the image/ video. In the lower left corner of the image there is a 2D manipulator 

(shown above in the Altair image). Each arrow can be freely dragged along a straight 

line. The entire rectangular area will be translated accordingly, while its size and 
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shape will remain the same. The square handle can also be dragged on the plane of 

the area to reposition the rectangular area for any in-plane movements. 

The Display Options sub-tab allows you to control how the image or video is 

displayed on the image plane and in the graphics area.  There are four options 

available. 

 

                                 
 

When Maintain aspect ratio is activated the aspect ratio of the image will be 

maintained while the image is being manipulated by the graphical manipulator. 

When Stretch is activated, the image will be stretched to fill the graphics area. 

Backface visibility is only available for 3D Image Planes. Transparency allows you to 

control the transparency of the image plane using the slider bar. This is particularly 

useful for applying watermarks onto the graphics area, as well as controlling the 

visibility of the stacked images. 

The Z-Stack sub-tab is used to control the stacking order of all of the image planes 

and the model. The arrows located on the right side of the dialog can be used to 

move the items up and down the list. The item at the top of the list will be placed on 

the foreground with the other items are placed in the background (based on their 

order in the list). The analysis model loaded is represented by <<MODEL>> in the 

list. Other image planes are listed with their Label. 
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The final sub-tab is Filter. This sub-tab contains tools allowing for certain colors can 

be filtered out, and the media can be enhanced by applying the appropriate filters 

and pixel mapping algorithms. Please refer to the online help for a complete listing 

of the available features in this sub-tab. 

 

                                   
 

Above, the options have been set so that the color white is removed from the image. 

This makes the Altair logo appear to have a transparent background. In order to 

remove all of the color white, the Type has been set to ColorAlpha, the Pixel 

mapping has been set to Linear2, the Mode has been set to Greater Than, and the 

Color white has been selected. 

This just leaves the lighter grey surrounding the letters and removes the white from 

the image: 

 

                                   
 

3D Image Planes 

The 3D Image Plane panel is primarily used for positioning the static images and 

videos in the model space. 

A 3D image plane embeds the media in the model space so that when the model 

view is rotated or panned, the related media will also change correspondingly. 
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This is particularly useful for correlating simulation with multiple videos or static 

images that are captured with various views, as in correlating a crash test video or a 

drop test captured from different angles. 

Each of the views can be positioned with respect to the model in 3D space such that 

the view of the model is tied to an image plane for best correlation. 

The 3D image planes that are embedded in model space can be incrementally 

adjusted to match the model dimensions. 

In addition to using the 2 Point and 3 Point alignment modes for scaling the image 

planes to the model size, the image planes now allow minor adjustments to the 

rectangular plane by the sizing manipulators available on the periphery. 

This helps in making small size adjustments without necessarily going through 

picking alignment and scaling points again. 

Small changes to plane orientations can of course be adjusted by the tripod 

manipulator attached to the image planes. 

Also, once the scaling and view alignment of the 3D image plane is accomplished, 

the plane can be moved in or out of the model to match with any section cut views. 

As the 3D image plane is scaled in the model space, the measurements applied on 

the model are valid for the media as well, and are thus no longer dependent on the 

accuracy of picking points based on the pixel resolution. 

This provides a close to accurate measurement in film analysis tasks. 

With appropriate image processing filters, a good correlation (or the lack thereof) 

can be determined easily with 3D planes. 

In addition, an image plane can be tied to a model, so that any tracking system 

based deformations are considered on the media as well. 

The tracking mode is extended to reference points on the video as well, so that the 

image plane’s relative position to the model is maintained. 

See the Model tab section (below) for additional details. 

Select the 3D option from the Type drop-down menu to display the 3D Image Plane 

tab. Many of the options available when for 2D image planes are also available for 

3D image planes. 

When the Type is set to 3D, additional options are added. 
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There is a new sub-tab named Alignment that is added. Here the inputs required for 

scaling and aligning of the image plane with respect to the model are entered. The 

available options allow you to align the image plane in 3D space with respect to the 

models.  The alignment uses a simple two or three point input scheme for scaling 

the image plane to the model size and orienting it in the appropriate view. 

 

 
3D Image Plane Tab 

 

For example, to align a video file and a model file of a crash event, you might choose 

to select the center point of two tires to align the two. 
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First the Alignment mode would be set to 2 Point, and then the appropriate Plane 

would be selected to align the model and video in. Then the two reference points for 

the model (N1 and N2) would be selected and then the two reference points for the 

video file (IN1 and IN2) would be selected. 

Within the Display Options sub-tab, the Backface visibility option is available. When 

this option is activated the backside of image plane regardless of the image plane 

orientation is always shown. Also, the Cull angle option is added. This option allows 

you to adjust the fading of the image (using the slider bar). The combination of 

settings within the Transparency, Backface visibility, and Cull angle options allow you 

to effectively control the manner in which the media is displayed on the image plane 

(with model rotations and pan) without obscuring important details. 

 

 
 

The final sub-tab added is the Model sub-tab. This allows you to associate an image 

plane with a tracking system. This option is only applicable if a tracking system has 

already been added to a model. When a model is selected the tracking behavior of 

any associated model based tracking systems will be applied to the image plane. This 

is useful for studying the deformation motion with the tracking system applied 

(provided that there is no out of plane rotation in the video). 
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Also, with the 3D image plane is the 3D graphical manipulator. 

 

 
 

The 3D manipulator allows you to make incremental adjustments to the rotating 

plane or move the image plane in 3-D space. 

This manipulator is created based upon the nodes specified using the 2 Point node 

input collector (N1N2 and IN1IN2) or the 3 Point node input collector (N1N2N3 and 

IN1IN2IN3). Each arrow can be freely dragged along a straight line. The arc handle 

connecting arrows can also be grabbed to allow rotation of the arrows and the 

image plane.   

In addition, the square handles connecting arrows can be freely dragged in space for 

planar translations to modify the location of the image plane. 

 

17.9 Exporting A Deformed Shape 

The Export Deformed Shape feature allows you to export the deformed shape as 

follows: 

• Abaqus 
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• DynaKey 

• OptiStruct Analysis/Nastran 

• RADIOSS 

• STL 

These files can be read into a pre-processor, such as HyperMesh, or into a CAD tool 

to view the deformed geometry. 

To access the Export Deformed Shape: 

 

 

• Menu bar File > Export > Solver Deck  

This utility writes out unscaled coordinated only. If scaled coordinates are needed, 

use the Linear Superposition utility to create a subcase, and then use this utility to 

export the deformed shape (with scaled coordinates). 
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17.10 Crash Tools For Plotting 

This section will cover the Vehicle Safety Tools available in HyperGraph 2D as well as 

some of the basic information for creating a bar chart. These are two common 

plotting tools that are used for post processing crash results. 

 

Vehicle Safety Tools 

The Vehicle Safety Tools (VST) is a collection of over 200 macros, Templex functions, 

and external functions for use by a vehicle safety engineer. The toolkit contains 

many basic curve operations, current injury assessment mechanisms, and several 

additional data transformation features. After opening the VST file, seven new 

menus that contain the macros and functions are displayed: Math, Filter, Units, 

Injury, Misc, Transforms, and Safety Tools. 

 

To load the Vehicle Safety Tools 

• File > Load > Preference File from the menu bar.  Then within the Preferences dialog, 

select Vehicle Safety Tools and click Load. 

 

 
 

The VST macros and functions can also be accessed from the Macro list on the Plot 

Macros panel          in addition to the menu bar. 

The parameters associated with the selected macro or function are displayed in the 

Parameters list. Before executing some macros and functions, you may need to 

enter additional parameter information. When you execute a plot macro or function 

by clicking Apply, the macro or function uses the parameters to create curves and 

notes within the session. Undo reverses the implementation of the plot macro. 

See Plot Macros for more information on working with macros. 
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Below is a brief description of each menu. For a full description of the menu items, 

please refer to the online help. 

 

Math Menu 

The vehicle safety tools’ Math menu allows you to perform basic math operations on 

one, two, or three curves at a time. The operations include curve addition and 

multiplication and resultants, for example. The start, end, or sample frequency of 

the various curves is not an issue - the VST automatically crops and samples the 

input curves as needed. The curves must be using the same units, in most cases. 

The Math menu contains three secondary menus: one curve, two curves, and three 

curves. 

 

Filter Menu 

The vehicle safety tools’ Filter menu provides curve filtering functions, including 

Butterworth, FIR, and a new SAE 1995 that are not available to regular HyperGraph 

2D users. Filtering requires the time unit of seconds. You must convert your data to 

seconds before applying a filter. 

 

Units Menu 

The vehicle safety tools’ Units menu allows you to convert to/from common unit 

sets. It is often necessary to convert data when comparing disparate sources (for 
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example test vs CAE). This menu provides a simple and fast way to convert one or 

many data curves simultaneously.  All conversion constants are displayed for you to 

review before applying the conversion. 

The Units menu contains secondary menus. From each menu, you can convert 

various units of measure. 

 

Injury Menu 

The vehicle safety tools’ Injury menu offers calculations for all known injury 

assessment tools. Each of the assessments may be used to generate either a note or 

a curve at your discretion. The assessments clearly indicate the required units for 

input data.  If your data does not match the required input, you can use the Units 

menu to convert the data or, optionally, supply conversion factors directly to the 

input. 

 

Misc Menu 

The vehicle safety tools’ Misc menu provides some functions that are not commonly 

used. For example, you can simulate a bar chart or histogram using this menu. 

 

Transforms Menu 

The vehicle safety tools’ Transforms menu provides several functions to calculate 

running statistics, regressions, FFTs, etc. 

 

Bar Charts 

The Bar Chart toolbar is displayed when you select HyperGraph 2D from the 

application menu and the active window is set to the Bar Chart mode,          . 
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    Select An Application From The Menu    Plot Type Options 

 

Most of the panels available for plotting bar charts are similar to the ones available 

for XY plotting, although there are a few differences. 

 

 
 

Define Curves 

The Define Curves           panel allows you to edit existing bar charts individually and 

add new bar charts to the current plot. The panel also provides access to the 

application’s curve calculator. 
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Define Bars Panel With Values As A Data Source Enabled 

 

The curve list displays the names of all the bar charts in the active window. 

The Cut, Copy, Paste, and Add buttons under the bar chart list are used to maintain 

the bar chart list for the active window.  Bar charts can be copied and pasted into 

other bar chart windows or within the current bar chart window. Bar charts can be 

also be added and deleted from the list, and they can be renamed. 

Individual bar charts can be turned on or off. To turn a bar chart off, select the bar 

chart from the window and deactivate the Series check box next to the bar chart 

name. To turn a bar chart on that was turned off, activate the Series check box. 

 

Data Sources 

Bar charts are comprised of data and categories.  Data can be read from an external 

file, defined as a mathematical expression, or entered as values. A label identifies 

categories and tic marks are used to separate them from other categories. If there 

are more data points than there are categories, the application adds blank 

categories to accommodate the extra data points. 

If Values is selected as the source (as shown above), the Values table is displayed, 

allowing you to directly enter data point values. 

The bar chart display is divided into Categories. Categories can be renamed by 

selecting a cell, typing a new name, and clicking Apply. 

You can have more than one bar series in each category. Data point values can be 

entered directly into the Curve column in the Values table. Enter numbers in the 

Curve columns and click Apply. 

After adding a curve to the Curve list, a Curve column is displayed next to the 

Categories column. 
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By default, a new curve is named Curve 1, Curve 2 etc. If you change the name of the 

bar chart curve in the Curve list, the heading for the Curve column in the Values 

table also changes. 

 

Collision Detection 

The Collision Detection panel can be used to perform collision interference checking. 

It allows you to define a collision set, select components (parts) in the collision set, 

and then detect penetration between two groups. The ability to define multiple 

collision sets allows you to quickly perform design reviews. To access the Collision 

Detection panel: 

• Tools toolbar > Collision Detection  

• Tools > Collision Detection from the menu bar. 

 
The options within the panel allow you to add collision sets and define the 

properties of each set individually. 

 

Collision Sets 

The collision sets defined for the current model are listed in the Collision Sets list. 

You can add or delete collision sets using the Add and Delete buttons. You can also 

select multiple collision sets and click the Delete button, in order to delete the 

selected collision sets from the list. 

Keyboard shortcuts are also available for selecting items within the list: 

Press the SHIFT or CTRL key on the keyboard + the left mouse button to select 

multiple items from the list. 

Press the CTRL + A keys on the keyboard to select all items in the list. 

Press the DELETE key on the keyboard to delete the selected collision set(s). A 

collision set is activated, or deactivated, using the radio button. 
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In addition, you can access the following options by right-clicking anywhere within 

the Collision Sets list: 

• Delete - Deletes the selected collision set(s) from the list. 

• Rename - Displays the Rename dialog, which allows you to rename the selected 

collision set. 

• Make Current - Allows you to select which collision set will be activated and 

displayed in the graphics window.  This option performs the same action as clicking 

the radio button “on” next to a collision set. 

You can sort the items in the Collision Sets list by clicking on the list heading. 

 

 
Hyperworks for Pre and Post Processing of FEM

https://youtu.be/Q1t3bWMoMHQ?t=1503
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18 Tutorial: Crash Tube 
In the following we look rather “blindly” (because we don’t know much about 

RADIOSS) at a ready to solve RADIOSS model. This exercise is meant to give you an 

idea on how to carry out a RADIOSS run. Details about parameters / settings are 

provided in the subsequent chapters. Thus, we don’t worry about element quality, 

size, element type, predefined contacts, type of contact formulation etc. at this 

point.  

Note: It is a good practice to check a given model for possible modeling errors with 

Tools>Model Checker>RadiossBlock in the menu bar. 

Model Description 

The model simulates an impact of a thin-walled, closed hat section on a rigid wall. 

 

 
 

• Simulation time: [0 – 50] ms 

• Uniform thickness = 1.5 mm 

• Initial velocity of node 81500 (Master node) Vx= -15.6 m/s 

• Input files for this tutorial: FIRST_RUN_0000.rad and FIRST_RUN_0001.rad 

• Units: Length (mm), Time (ms), Mass (g), Force (N) and Stress (MPa) 

• Results requested: 

/ANIM/VECT/DISP Displacements 

/ANIM/VECT/VEL Velocities 

/ANIM/ELEM/EPSP Plastic Strain 

/ANIM/ELEM/VONM VonMises Stress 

http://training.altairuniversity.com/wp-content/uploads/2015/08/Exercise_3.1_First_Run_with_RADIOSS.zip
http://training.altairuniversity.com/wp-content/uploads/2015/08/Exercise_3.1_First_Run_with_RADIOSS.zip
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/ANIM/ELEM/ENER Energies 

/ANIM/ELEM/HOURG Hourglass Energy 

• Johnson-Cook Elasto-Plastic Material /MAT/LAW2 

ρ = 7.8e-3 g/mm3    [Rho_I] Initial density 

E = 210,000 MPa    [E]    Young’s modulus 

ν= 0.29      [nu]    Poisson’s ratio 

sy= 180 MPa     [a]    Yield stress 

Κ= 450.0 MPa     [b]    Plasticity hardening parameter 

n = 0.5      [nu]    Plasticity hardening exponent 

sMAX= 350 MPa     [SIG_max]  Max Stress 

 

Objectives 

1. Become familiar with format of RADIOSS Engine and Starter files 

2. Know how to use HyperWorks Solver Run Manager to execute a RADIOSS simulation 

3. Analyze starter and engine output files 

4. Be able to post-process key results from an explicit analysis with HyperView 

 

Step 1: Scroll through the RADIOSS Engine (FIRST_RUN_0001.rad ) and Starter Files 

(FIRST_ RUN_0000.rad) in a text editor and observe Keyword cards denoted with a 

“/”. 

With a modulus of 210,000 MPa and a density of 0.0078 g/mm3, calculate the speed 

of sound in the material. 

 
Speed of sound in steel rail 

=_______________________________________________ 

The length of the rail is about 1,000 mm. Calculate the time it takes for a shock wave 

to travel from one end of the rail to the other. 
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Time for sound to travel length of rail = 

______________________________________ 

Edit the Engine file so that the stress wave can be monitored, moving from one end 

of the rail to the other during impact—this will require a termination time equal to 

the time it takes for the sound to travel the length of the rail (set on /RUN card).  

Set the frequency of animation output to a time that will give 20 animation steps 

(/ANIM/DT). 

 

 
Engine File 

 

Step 2: Open RADIOSS Run Manager 
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Step 3: Input the STARTER file (*0000rad) and Run with –starter option 

 

 
 

Notes:  Option “-nt 2” denotes that there are 2 CPU threads on the machine for 

parallel processing 

  Option “-starter” tells RADIOSS to only run the starter and stop (if not specified, then 

the engine will run automatically if  the starter finds no fatal errors) 

 

Step 4: Review the listing file FIRST_RUN_0000out and verify the model: 

1. Check if the starter finished with no errors and/or warnings. 

2. Find the minimum shell, spring and nodal time steps and write them down. 

Shell time step = _____________________ 

Spring time step = ____________________ 

Nodal time step = _____________________ 

 

Step 5: Run the ENGINE file using the RADIOSS Run Manager 
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Step 6: Review the starter output file FIRST_RUN_0001out with a Text Editor 

1. Check the % (Energy) Error and Mass Addition at the end of the computation 

 

 
 

Note: In one of the following chapters we discuss “errors” in some detail. The 

following information is meant to give you a first idea: 

The error must be negative and decreasing (except for the first cycles or in spring 

back stage). The error must be less than 15% at the end of computation (5% for a 

good model). If the error increases a little, then decreases may be normal. If the 

error increases, this means that a problem has occurred. Then, the error may grow 

to 99.9% with computation failure message.”  

So ideally the error should be at most -15% and better to have -5%. The closer to 0% 

error the better. For QEPH shell formulation or fully integrated elements, the Energy 

Error can be slightly positive since there is no Hourglass energy and the computation 

is much more accurate. An error of 1 or 2% will be acceptable. Otherwise any 

positive energy error means energy has been created which indicates a model issue. 

 

 

 



    
 

373 

Step 7: Review the results file (FIRST_RUNh3d) with HyperView 

Open HyperView, load the file FIRST_RUN.h3d, make the Rigid Wall transparent in 

the Result Browser and contour the velocities at Time=0 to verify initial conditions. 

 

 
Initial velocity (T=0) 15.6 mm/ms 
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Contour VonMises stress and step through the animation of the Stress Contour to 

see the stress wave propagating from the front of the rail to the rear of the rail. 

Check the time it takes the stress wave to reach the back end of the rail. How does it 

compare to your calculation? 

Note that in the first part of this exercise, the end time of the run was set to the 

estimated time the stress wave needs to travel from one end of the rail to the other. 

To view the individual steps activate the Animation Controls (highlighted icon 

below). then browse through the simulation by clicking the “forward” button 
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Create a copy of the RADIOSS engine file with the same name, but with the 

_0002.rad extension. Update the engine file with a new end time of 50 msec and an 

animation output of 2.5 msec. Re-run the model with this new engine file. 

Notice that the animation files continue numbering from where the first run left off. 

Also notice that a second time history file (T02) is created. 
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To view the new results, reload the *.h3d file and repeat the steps from above.  

 

time: 22.7 ms 

 
 

time: 50 ms 

 
 

Step 8: Review the time history files (T01, T02) with HyperGraph 
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Open HyperGraph (e.g. Start Menu > HyperGraph) or if you are using HyperWorks 

Desktop by splitting the Page in multiple  windows (for the course of this exercise we 

would need 4 windows) 

Plot the Rigid Wall Force as a function of time. 

• load the Time History File FIRST_RUN_T01 (note that the second file FIRST_ 

RUN_T02 will also be loaded). 

• Select the Y-type, Y-Request, and Y-Component as Rigid wall > RIGID WALL 1 > 

Resultant and click Apply. 

 

 
 

Plot energy curves using the Build plot panel: 

• select the Global Variables, then Internal Energy, Kinetic Energy, Hourglass Energy, 

and TTE-Total Translational Energy  

Plot Time Step versus Time 

• select the Global Variables, then Time Step and Apply. 
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Step 9: Save the session to a file 

Once the post-processing done, it can be saved by writing a session file: 

• A *.mvw file reloads exactly your post-processing; Click on File > Save > Session 

enter the name Rail_Results and Save 

• A *.tpl file reloads your post-processing, with the possibility to modify some 

parameters (input file, results file, etc.); Click on File > Save as > Report Template 

enter the name Rail_Results and click Save 

Note: A comprehensive introduction into post-processing with 

HyperView/HyperGraph with a special focus on crashworthiness is provided in the 

chapter- Postprocessing Crashworthiness  
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19 Tutorial: Honeycomb Crash-

Box 
This tutorial shows how to simulate a honeycomb crash-box as quite often used in 

student race cars. The tutorial was revised to standard Hypermesh and Hypermesh X 

preprocessors by Simon Križnik. The original Hypercrash tutorial written by Moritz 

Guenther (a former student at Altair Engineering GmbH) can be found on Altair 

university webpage.   

 

 
 

We start this project by launching HyperMesh in order to mesh the given geometry. 

The geometry is available as a HyperMesh binary file: Model_start.hm. The unit 

system followed in this tutorial is kg, mm, ms. 

 

Meshing 

1. Start HyperMesh and select the RADIOSS in the User Profile dialog. Open the file 

Model_start.hm from file > open>model. 

https://www.altairuniversity.com/wp-content/uploads/2013/09/Crashbox_rm_w_Post_Marco_MG.pdf
https://www.altairuniversity.com/wp-content/uploads/2013/09/Crashbox_rm_w_Post_Marco_MG.pdf
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2. Check the Model Browser for details about the loaded model. There are four 

components. Anti-Intrusion Plate, Barrier, and Bulkhead contain surface geometry. 

The Crashbox is a solid geometry.  

 

 
 

Note: Model Browser is turned on/off in the menu bar View>Model Browser  

 

3. To mesh the crashbox component go to 3D>solid map>one volume in the Panel 

area. Under volume to mesh pick the Crashbox solid geometry. Change source 

shells: to quads and set the elem size to 10mm. Finish this operation by clicking 

mesh and return.  

 

 
Note: The panel area is turned on/off in the menu bar View>Panels 
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4. Now we have to mesh the surfaces. In the panel area got to 2D>AutoMesh and set 

the element size to 19mm and quads as mesh type.  Pick the Barrier surface and 

click mesh then return. 

 

 
 

 
 

5. Repeat the previous step, except the Anti-Intrusion-Plate needs to be meshed 

with an element size of 6mm and the Bulkhead surface needs to be meshed with an 

element size of 10mm ( both should have mesh type as mixed). The meshed model 

should eventually like the one displayed: 
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Materials 

1. Now we define two different materials. There are many ways to create entities 

and the following approach is shown as it applies to both standard Hypermesh 

and Hypermesh X. Right click on empty space in the Model browser and select 

Create>Material. In the Entity Editor rename as “EN AW 7075”, change the card 

image to M36_PLAS_TAB and insert the values in the following image: 

 

 
 

We next need to define the yield stress function for the material. Right click on the 

field next to N_funct>fct_ID and select Create. Name the function as “EN AW 7075 

(strain rate 1)” and close the Create curve dialog. Right click the newly created 

curve and select Plot Curve. Now manually insert the data points/pairs of the 

function from the image below:  
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Note: Before closing the Curve editor window make sure to click Update. 

Now assign this material to the relevant components in the model, namely Anti-

Intrusion-Plate, Bulkhead and Barrier. Select those components in the Model 

Browser while holding the ctrl key. In the Entity browser click the field next to 

Mat_Id and select material named “EN AW 7075”. 

 

 
 

2. Now we will define a honeycomb material for the crashbox. Right click on empty 

space in the Model browser and select Create>Material. In the Entity Editor 

rename as “Honeycomb”, change the card image to M28_HONEYCOMB and 

insert the values in the following image: 
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Important: The Initial Density is 9.13E-8! Notice there are six different functions. 

You can define the yield and shear stress functions by right-clicking in the respective 

field and selecting Create and then entering the coordinates in the Curve editor (as 

shown before) or import an existing curve, which will be shown next. 

We will first import Yield Stress Function 11. From the menu bar select 

XYPlots>Create>Curves>Single Curve. In Hypermesh X go to Post>xy plots>edit 

curves in the panel area. Click the icon load… and choose the file HoneycombT.txt 

from your working directory. Click the y= radio button and switch the comp= to 

Column 2. To import the curve click create. The Edit Curves Panel should look like 

below: 

 

 
 

Also provide a function name by right clicking + Rename in the Model browser  
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Define the other five functions by importing the following curves and assign to the 

appropriate fields of the Honeycomb material: 

Yield stress function 22    HoneycombLW.txt 

Yield stress function 33    HoneycombLW.txt 

Shear yield stress function 12  HoneycombF3.txt 

Shear yield stress function 23  HoneycombF4.txt 

Shear yield stress function 31  HoneycombF3.txt 

  

 
 

Now assign this material to the crashbox component by picking the crashbox 

component in the model browser. In the Entity browser click the field next to 

Mat_Id and select material named “Honeycomb” (similar working step as with the 

material EN AW 7075). 

To review whether the material was correctly assigned, in the Model Browser select 

the material of interest and then hit the “Q” key (or right click + Review). Only the 

component the material is assigned to will be shown.  

 

Properties 

1. Right click on empty space in the Model browser and select Create>Property. In 

the Entity Editor rename as “Anti-Intrusion-Plate” and insert the values in the 

following image: 
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Assign this property by picking the Anti-Intrusion-Plate component in the model 

browser. In the Entity browser click the field next to Prop_Id and select property 

named “Anti-Intrusion-Plate” 

 

 
 

2. For the components Barrier and Bulkhead, similar properties are needed. Follow 

the same steps as in (1) but with the entries as shown in the image below: 
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3. The Crashbox needs a different property type as it is a solid component. Right 

click on empty space in the Model browser and select Create>Property. In the 

Entity Editor rename as “Solid_HC” and change the card image to P6_SOL_ORTH 

then insert the values in the following image: 
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Assign this property to the Crashbox component as shown before. 

Note: QEPH/HEPH is not recommended for orthotropic materials because the 

stabilization forces are computed based on isotropic assumptions. This formulation 

is chosen for computational efficiency, however fully integrated elements are more 

accurate. The Vx, Vy, Vz are global reference vectors used to to define orthotropy 

direction, which can alternatively be defined with Vector base node and Vector end 

nodes.  

 

Some General Questions And Explanations About Property Settings 

Why QEPH Shell Formulation? 

• QEPH (Quadrilateral ElastoPlastic Physical Hourglass Control) element 

• QEPH is the best compromise between cost and quality. Generally, it costs no more 

than 15% of a BT element and the results obtained by this element are close to 

those of QBAT. 

• With one-point integration formulation, if the non-constant part follows exactly the 

state of constant part for the case of elasto-plastic calculation, the plasticity will be 

under-estimated due to the fact that the constant equivalent stress is often the 

smallest one in the element and element will be stiffer. Therefore, QEPH, defining a 

yield criterion for the non-constant part seems to be a good ideal to overcome this 

drawback. 

• QEPH shells are more accurate for elastic or elasto-plastic loads, whatever the 

loading type - quasi-static or dynamic 

• QEPH shells will give better results if the mesh is fine enough. It is not recommended 

for coarse mesh.  

 

Why Use 5 Integration Points In The Thickness Of Shell Elements? 

• In case of an elastic behavior, one gets the exact solution from three integration 

points – that is to say that the bending moments are exactly integrated through the 

thickness of the shell – and it is not necessary to use more integration points. 
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• In case of a plastic behavior, the bending moments are not integrated exactly. Using 

more integration points, the solution becomes more accurate; so it is recommended 

to use five integration points. 

 

Why Ithick =1 ? 

• By default, shell thickness is supposed constant during shell deformation. Initial 

thickness is used to compute strains and to integrate stresses, but the thickness 

variation is still computed for post-processing reasons.  If a variable thickness (Ithick 

=1) is used, true thickness is computed not only for post-processing, but also for 

strain computation and stresses integration 

 

Why Iplas =1? 

• In plasticity computation, two fundamental assumptions must be satisfied. First, the 

stress in the plastic region must verify the plasticity criteria (for example, von Mises 

criteria). Second, in the principal stress space the direction (Ds), due to work 

hardening, is normal to the yield surface. 

• An iterative orthogonal projection is used in this tutorial, this method enables to 

satisfy the second assumption using an iterative algorithm, the main reason we use 

iterative projection is to achieve a high accuracy on stress distribution after 

projection.   

 

Contact 

1. Right click on empty space in the Model browser and select Create>Contact. In 

the Entity Editor rename as “Crashbox vs Barrier” and change the card image to 

TYPE7 and insert the values in the following image:  
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Next to Grnod_Id(S) switch the entity type to component and pick Crash Box as 

slave. Next to Surf_Id(M) switch the entity type to component and pick Barrier as 

master.  

Note: Stiffer component should be assigned as the master. If both have the same 

stiffness then the more coarsely meshed component should be master.   

 

2. Do the same procedure for the contact between Bulkhead and Anti-Intrusion-

Plate. Recall that you can review the contact definition in the Model browser by 

right clicking + Review (or “Q” key). 

 

3. The third contact is a tied kinematic condition. Right click on empty space in the 

Model browser and select Create>Contact. In the Entity Editor rename as “Tied” and 

change the card image to TYPE2 and insert the values in the following image: 
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Next to Grnod_Id(S) switch the entity type to component and pick Crashbox as slave. 

Next to Surf_Id(M) switch the entity type to component and pick the Anti-Intrusion-

Plate as master.  

Note: The Ignore=1 allows picking the whole Crashbox component as slave. The 

slave nodes without master segment are automatically removed from the interface. 

 

Why Type 7? What Is Interface Gap? 

• This interface simulates the most general type of contacts and impacts 

• Impacts occur between a master surface and a set of slave nodes 

• It is a fast search algorithm without limitations. Interfaces have a gap that 

determines when contact between two segments occurs. 

 

What Is Coulomb Friction? 

• Type 7 interface allows sliding between contact surfaces. Coulomb friction between 

the surfaces is modelled 

• Coulomb’s friction law is a classic friction law which states that FT < m* FN  with  m = 

Fric 

 

Rigid Body 

1. Right click on empty space in the Model browser and select Create>Component. 

In the Entity Editor rename as “rigid” and check the box next to Rbody:  
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With the newly created component as current go to 1D>rigids. Next to nodes 2-n: 

switch to multiple nodes and next to primary node: switch to calculate node. The 

Rigids Panel should look like: 

 

 
 

Click on the nodes field to invoke extended entity selection then pick by collector to 

select Barrier Component and click create.  

Next we will add mass to the rigid body. Click the Card Edit icon and select the rigid 

body on Barrier component: 

 

 
 

Type in 305kg in the Mass field and set Icog=1 (Mass and inertia are added at the 

master node coordinates; the center of gravity is computed using the master and 

slave node coordinates, the master node is moved to the computed center of 

gravity): 
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2. Create a new Rigid Body similar to the previous step, except this time select all  

nodes around the four boreholes of the Anti-Intrusion-Plate in addition to the 

Bulkhead component: 

 

 
 

Boundary Conditions 

1. In the menu bar go to Tools>BCs Manager. In Hypermesh X use the Ctrl+F search 

function and input “BC's Manager” in the upper right corner. 

 

 
 

Enter the name “spc_barrier” and make sure the type is set as Boundary condition. 

Next to GRNOD switch the entity selector to nodes and pick the master node of the 

Rigid Body on Barrier component. Check the box next to all boundary condition 
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components except Tx and hit Create. Now the Barrier can only move towards the 

Crashbox along the global X axis. 

 

 
 

2. Do the same with the second Rigid Body (on Bulkhead component) but select 

every translation and rotation. 
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3. In this step we will define initial velocity to the Barrier component. Enter the 

name “inivel” and set the type as Initial Velocity. Next to GRNOD switch the entity 

selector to nodes and pick the master node of the Rigid Body on Barrier component. 

In the Vx field enter 7 and hit create. 

 

 
 

4. In this step Gravity load will be defined. Enter the name “Gravity” and set the type 

as Gravity Load. Next to GRNOD switch the entity selector to Parts and pick all 

components and set gravity load components direction to X. Click on the 

Create/Select curve button to invoke Curve editor and select New… to define a new 

function. Give the name as Gravity and hit Proceed. Input the values following unit 

consistency: 
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Close the Curve editor and switch the Curve ID to Select curve and pick the gravity 

curve and finally confirm by clicking Create. 

 

 
 

What Is A Rigid Body? 

a. A rigid body is an idealization of a solid body in which deformation is neglected. In 

other words, the distance between any two given points of a rigid body remains 

constant in time regardless of the external forces exerted on it. 

b. Rigid body elements are used to: 

i. impose equal displacement to a set of nodes;  

ii. model rigid connections and pin-joints;  

iii. enforce symmetry;  

iv. model transitions, connections, spot-welds, seam-welds between non-

matching (dissimilar) meshes;  

v. distribute concentrated loads/masses to a set of nodes 

Output Blocks 
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1. To be able to measure the acceleration you have to create an accelerometer. For 

this purpose, right click on empty space in the Model browser and select 

Create>Accelerometer then pick the master node of the Rigid Body on Barrier 

component and enter Fcut=1.65 

 

 
 

2. Right click on empty space in the Model browser and select Create>Output Block 

then switch entity IDs to Accelerometer and select the accelerometer. 

 

 
 

3. In this step we will create output requests for components.  Right click on empty 

space in the Model browser and select Create>Output Block then switch entity IDs 

to Components and select Crashbox, Barrier and Bulkhead components. 
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Mass Check 

To check if you entered correct values in the Material, Property and Rigid Body 

definition (i.e. density, shell thickness, rigid body mass) click on Tools>Mass details> 

Mas only. In Hypermesh X go to Validate>Mass>Compute in the menu bar. Here is a 

summary of the model masses: 

 

 
 

Control Cards 

With the control cards you define important and necessary solver run settings like 

total run time, ouput frequency for time history plot and animation,…. 

Tools>Engine File Assistant in the menu bar is a great time saving tool which allows 

users to import an existing engine file or create new with just few clicks in Radioss 

user profile. In Hypermesh X go to Analyze>Radioss Solver Run >Engine File Assistant 

in the menu bar. Use the inputs from the following image: 
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/RUN defines termination time 

 

 
 

/ANIM/DT defines start time and frequency to write animation files 

 

 
 

/TFILE defines start time and frequency to write time history files 
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/ANIM/ELEM Generates animation files containing element data for the selected 

result type. These types of data are typically contoured in HyperView. 

 

 
 

/ANIM/VECT Generates animation files containing vectorial data for the specified 

variable. Here the variables are velocities, contact forces, forces and moments for 

rigid bodies, rigid walls and sections 
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/MON Provides an estimation of the CPU time spent for each processor 

/PRINT Printout every “Nprint” cycle on file “Runname_nnnn.out.  If Nprint is negative, 

printout is made in the standard output as well as in the list file 

Start Of Simulation 

Now you can solve your model. For this go to Analysis>Radioss in the panel area: 

 

 
 

Make use of options for the solver run like number of CPU cores, single precision, ...  

More options are shown in the image below. 
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To check how many CPU’s are available on your laptop/PC - start the Windows Task 

Manager. Here we see there are 4 CPU available. 

 

 
 

Start the analysis by clicking the Radios button. Once the run is completed, we draw 

our attention to Postprocessing.  
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Postprocessing 

Before we are going to review some results, please note that we explain some basic 

principles about HyperView (contouring) and HyperGraph (plotting) in the Appendix 

“PostProcessing With HyperWorks Desktop - Crashworthiness”. In addition, please 

view the course material available in the Learning & Certification Program 

(http://certification.altairuniversity.com/) 

Click on the results button to open HyperView, and load the *h3d file from the 

working directory.  

Note, that the initial distance between Barrier and Bulkhead is 202,2 mm. 

 

 
 

 

 

 

 

 

 

 

 

http://certification.altairuniversity.com/
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The displacement plot of the system 

 

 
 

The distance between the barrier and the bulkhead is shown in upper right graph. It 

starts with its initial value of 202,2 mm. After 55 ms the distance is reduced down to 

59 mm. The graph indicates, that the crashbox “relaxes” (jumps back) at 44 ms 

(minimum value of 57,1 mm) 

 

 
 

In the graph below, the displacement of the Master node of the Barrier is shown. 

The “relaxation” is somewhat more obvious in this representation (of course, we 

could also zoom in the other graph) 
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The energy balance of the system is shown in the lower right corner in the image 

above: 

The total energy remains constant (no loss or generation of energy), kinetic energy 

decreases while internal energy increases. Hourglass energy and Contact energy are 

negligible small. Note that because of the initial velocity condition applied to the 

Master node of the Barrier, the maximum kinetic energy of the system is at t=o ms 

(no deformation at that time). 

The velocity “profile” of the Master node of the Barrier is shown below. Again, the 

“jump back” of the system at 44 ms is more apparent to see in the representation. 
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20 Tutorial: Three Point Bending 

(HyperMesh) 
 (Tutorial from the Online Help - RD-T: 3595 Three Point Bending with HyperMesh) 

This tutorial demonstrates how to set up 3-point bending model with symmetric 

boundary conditions in Y direction. 

 

 
 

Model Description 

• UNITS: Length (mm), Time (s), Mass (ton), Force (N) and Stress (MPa)  

• Simulation time: in Engine file [0 – 6.601e-002 s]  

• Only one half of the model is modeled because it is symmetric.  

• The supports are totally fixed. An imposed velocity of 1000 mm/s is applied on the 

Impactor in the (–Z) direction   

• Model size = 370mm x 46.5mm x 159mm  

• Honeycomb Material /MAT/LAW28: HONEYCOMB  

• [Rho_I] Initial density = 3.0e-10 ton/mm3 

• [E11], [E22] and [E33] Young’s modulus (Eij) = 200 MPa 

• [G11], [G22] and [G33] Shear modulus (Gij) = 150 MPa 

• Elasto-Plastic Material /MAT/LAW36: Inner, Outer and Flat  

• [Rho_I] Initial density = 7.85-9 ton/mm3  

• [E] Young’s modulus = 210000 MPa 
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• [nu] Poisson’s ratio = 0.29 

 

Strain Curve: 

 

 
 

• Elastic Material /MAT/PLAS_JOHNS: Impactor  

• [Rho_I] Initial density = 8e-9 ton/mm3  

• [E] Young’s modulus = 208000 MPa 

• [nu] Poisson’s ratio = 0.29 

 

Step 1:  Load The Radioss User Profile 

1. Launch HyperMesh Desktop.  

2. From the Preferences menu, select the User Profiles or click the User Profile icon in 

toolbar.  

3. Select RADIOSS user profile and click OK.  

 

Step 2:  Retrieve The Radioss File 

1. Click File > Import > Solver Deck or click Import Solver Deck icon in the toolbar. 

2. Click the Select File icon in the import panel to open the BENDING_0000.rad file 

you saved to your working directory from the Radioss.zip file. Refer to Accessing 

the Model Files.  

3. Click Import.  

4. Click Close to close the window.  

 

Step 3: Create And Assign Material And Property For Hcfoam 

1. In the Model browser, right-click and select Create > Material. The new material 

appears in the Entity Editor.  

2. For Name, enter Foam.  
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3. For Card Image, select M28_HONEYCOMB and click Yes to confirm.  

4. Input values, as shown below:  

 

 
 

5. In the Model browser, right-click and select Create > Property to create a new 

property.   

6. For Name, enter Foam and set the new property Card Image as P14_SOLID. Leave all 

the settings as default, except for ISOLID which should be set to 24.  

7. In the Model browser, right-click on the component HCFoam and select Assign. 

Assign Foam as the Prop_Id and Foam as the Mat_Id.  

8. Click Apply.  

 

Step 4:  Create And Assign Material And Property For The Component Inner 

1. In the Model browser, right-click and select Create > Material. The new material 

appears in the Entity Editor.  

2. For Name, enter Inner.  

3. For Card Image, select M36_PLAS_TAB and click Yes to confirm.  

4. Input the values, as shown below:   
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5. In the Model browser, right-click and select Create > Property to create a new 

property.   

6. For Name, enter Inner and set Card Image as P1_SHELL. Leave all the settings as 

default, except for Ishell which should be set to 4 and Thick which should be set to 

9.119e-01.  

7. In the Model browser, right-click on the component Inner and select Assign. Assign 

Inner as the Prop_Id and Inner as the Mat_Id.  

 

Step 5:  Create And Assign Material And Property For The Component Outer 

1. In the Model browser, right-click on the material Inner and select Duplicate. Name 

the new material Outer. This creates a new material that is identical to the source 

material.  

2. In the Model browser, right-click on the property Inner and select Duplicate. Name 

the new property Outer. This creates a new property that is identical to the source 

property.  

3. In the Model browser, right-click on the component Outer and select Assign. Assign 

Outer as the Prop_Id and Outer as the Mat_Id.  
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Step 6:  Create And Assign Material And Property For The Component Flat 

1. Follow the procedure described in Step 5 with Outer replaced by Flat. 

 

Step 7:  Create And Assign Material And Property For Impactor 

1. In the Model browser, right-click and select Create > Material. The new material 

shows up in the Entity Editor.  

2. For Name, enter Impactor.  

3. For Card Image, select M1_ELAST.  

4. Input the values, as shown below:  

 

 
 

5. In the Model browser, right-click on the property Inner and select Duplicate. Name 

the new property Impactor. This creates a new property that is identical to the 

source property.  

6. In the Model browser, right-click on the component Impactor and select Assign. 

Assign Impactor as the Prop_Id and Impactor as the Mat_Id.  

 

Step 8:  Create And Assign Material And Property For Support 

1. Follow the same procedures as in Step 5. Create a copy of Impactor property and 

material with name support and assign it to component support. 
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Step 9:  Create A Rigid Body To Make Impactor And Support Rigid  

1. In the Model browser, right-click and select Create > Component.  

2. For Name, enter Impact rigid.  

3. Select any color for easy visualization.  

4. In the Entity Editor check the box next to Rbody. 

5. Go to the 1D page, select the rigids panel.  

6. Verify that you are in the create subpanel.  

7. For dependent switch to comps.  

8. For primary node switch to calculate node.  

9. Click comps.  

10. Select Impactor, then click select.  

11. Click create.  

12. Click return to exit the panel.  

13. Similarly, create rigid body for Support component in a collector with the name 

“Support rigid” using Steps 9.1 to 9.12.  

 

 
 

 

Step 10:  Define Imposed Velocity And Boundary Condition For The Impactor 

1. From the Utility page, start the BCs Manager.  

2. For Name, enter IMPOSED_VELOCITY, set Select type to Imposed Velocity and set 

the GRNOD to Nodes.  

3. Click nodes and select the master node of the rigid body of the Impactor, as shown 

in the following image.  
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4. Set the Direction as Z.  

5. Set Scale Y to -1000.0 as the direction of velocity is opposite to the global Z-axis.  

6. Set the Curve ID to Select curve.  

7. Select the predefined curve to Func1.  

8. Click create to create the imposed 

velocity.  

9. For Name, enter Impactor_constraints, 

set Select type to Boundary Condition 

and set the GRNOD to Nodes.  

10. Click nodes and select the 

master node of the rigid body.  

11. Check all the degrees of 

freedom to constrain, except Tz.  

12. Click create to create the 

boundary condition.  

 

Step 11:  Define Fixed Boundary Condition For The Support 

1. From the Utility page, start the BCs Manager.  

2. For Name, enter Support_fixed, set Select type to Boundary Condition and set the 

GRNOD to Nodes.  

3. Select the master node of the rigid body created on Supporter, as shown in the 

following image.  

4. Check all the degrees of freedom.  
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5. Click create to create the boundary condition  

 

 
 

Step 12:  Define Symmetry Boundary Condition For The Foam, Inner, Outer And 

Flat 

1. From the Utility page, start the BCs Manager.  

2. For Name, enter SYMMETRY_XZ, set Select type to Boundary Condition and set the 

GRNOD to Nodes.  

3. Select the nodes of the foam, inner, outer and flat, as shown in the following image.  

4. Check the degrees of translational degrees of freedom Y and rotational degrees of 

freedom X and Z to constraint.  

5. Click create to create the boundary condition.  
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6. Click close to exit the BC Manager.  

 

Step 13:  Define Contacts Between The Beam And The Support 

1. Launch the HyperMesh Solver browser from View > Browsers > HyperMesh > Solver.  

2. In the Solver browser, right-click and select Create > INTER > TYPE7.  

3. Enter the values, as shown below:  

4. Set the Surf_id (M) for the master selection to Components and select the Support 

component.  

5. Set the Grnod_id (S) for the slave selection to Components and select the Flat 

component.  

6. Similarly create the contact for Impactor with Outer, as shown below.  
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Step 14:  Define The Self Contact Between The Beam  

Components 

1. Using the directions in Step 13, create a new Type 7 interface named Self with the 

components Outer, Inner, and Flat as Master and the same components Outer, 

Inner, and Flat as Slave. This will make the components self-contact instead of self-

penetrate. Verify that the interface has a Fric of 0.1 and Gapmin of 0.2.  

 

Step 15:  Create Interface Time History 

1. Right-click in the Solver browser and select Create > TH > INTER.  

2. For Name, enter IMPACTOR.   

3. Switch the entity selector to groups.  

4. Click groups and select the interfaces Impactor and Support from the list.  

5. Click OK.  

6. Set NUM_VARIABLES to 1 and Data: Var to DEF  

 
 

Step 16:  Creating Control Cards And Output Requests 

1. Launch the HyperMesh Solver browser from View > Browsers > HyperMesh > Solver.  

2. Right-click in the Solver browser general area to create the cards shown below with 

the given values for each parameter:  
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Control Cards and Output Requests 

 
 

Step 17:  Export The Model 

1. Click File > Export or click the Export Solver Deck icon. 

2. For File:, navigate to the destination directory where you want to export to.  

3. For name, enter 3BENDING and click Save.  

4. Click the downward-pointing arrows next to Export options to expand the panel.  
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5. Check Merge starter and engine file to export solver deck as one file (or uncheck 

to export separately).  

6. Click on Export to export solver deck.  

 

Step 18:  Open RADIOSS Manager  

1. Go to Start > Programs > Altair HyperWorks 2017 > RADIOSS.  

2. For Input file, browse to the exercise folder and select the file 3PBENDING_0000.rad.  

 

 
 

Step 19:  Review The Listing Files For This Run And Verify On The Results 

1. See if there are any warnings or errors in .out files.  

2. Using HyperView, plot the displacement, strain contour and vectors  
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Verify the Results 

 

 
Contact Force for Impactor Interface  
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21 Tutorial: Bird Strike Analysis 

on an Aircraft Leading Edge  
(Using SPH Bird Model) 

The front facing edges of an airplane, which include the wings, nose cone and 

engine, are more prone to bird strikes. In this tutorial, we simulate the bird strike at 

the leading edge of an airplane wing structure using smoothed particles 

hydrodynamics (SPH) method. The preprocessing of the model is done in Altair 

HyperMesh 2017 and is solved in RADIOSS, which is the highly nonlinear explicit 

solver of Altair. 

Pre-processing of the Model: 

1. Launch HyperMesh 2017. 

2. Choose User Profile RADIOSS 2017 

From File>Open>Select file Aircraft_Wing.hm 
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3. Observe the model file loaded. The model has four components which are the parts 

of an aircraft wing. The parts are modeled with shell elements. 

 

 
 

Creating and Updating Materials 

1. Please notice that the unit system followed for this analysis is Tons, mm, seconds 

and Newton. 

2. We are using Johnson-Cook Material (/MAT/LAW2) in this model, with card image 

M2_PLAS_JOHNS_ZERIL. The material parameters are provided as shown below. 
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3. Now we will create four different shell properties for the components. Right click on 

model browser > Create > Property. The property name is renamed as skin in the 

entity editor. Card image is P1_Shell. The thickness is assigned as 5mm. And also 

updated with other parameters as shown below. 

 

 
 

4. Similarly, for the other three components the above property is duplicated (right 

Click skin property, select duplicate and rename) with change in thickness. That is, 

for ribs-3mm, spar-1mm, ribs_outer-5mm. 

5. The four components are updated with the material created above and with the 

respective properties created in the above step. 

6. Now we are creating a rigid at one side of the aircraft wing, thereby we are 

assuming that this end is fixed on to the aircraft fuselage. A new component 

collector called Rigids is created. Now we will create a rigid body with From 1D > 

Rigids > Create. Multiple nodes selection is invoked and the nodes of the ribs_outer 

component is selected as shown below and the rigid is created. 
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Wing After Creation Of Rigids 

 

7. Please note that for Rigids component no materials or property is assigned, so 

Rbody checkbox should be activated in the Entity Editor. 

8. Now we will create the bird. The bird shape used in this tutorial is a cylindrical model 

with hemispherical ends. As per the regulations, for a leading edge bird strike a 4lb 

(1.81kg) bird is used. 

With this mass, the bird density, length and diameter is calculated (Note: Many open 

web resources are available on this calculation). Density: 9.42e-10 tons/mm3 

Diameter: 98mm 

Length: 189mm 
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Steps for Creating Bird 

1. Create a new component collector for Bird. The bird impact location is selected and 

two nodes are created as shown for creating the cylindrical surface. 

 

  
 

2. The cylindrical body is created with the dimensions as below 

 

 
 

3. Now two circles are created at the cylinder ends with 49mm radius. After that, two 

spheres of 49mm radius are created at the ends of the cylinder as shown next. 
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4. Next, the sphere is trimmed (Geom>Surface edit) with the lines created therefore 

hemispherical ends are created for the cylinder. The inner surface of the sphere is 

deleted. 

 

 
 

5. Now the bird geometry has been created as per the required dimensions. 
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6. With the bird component collector active, go to 1d>SPH. 

Select comps from the selector and select the bird component created. The pitch 

between particles provided is 5 and enter the density value and click Create. A 

property collector, sph_1 is also automatically created now. 

 

 
 

7. Now a material is created for the bird. /MAT/LAW6 material law is used and card 

image is MLAW6 and the input is provided as below. Assign the material and sph_1 

property to the bird component. 
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8. The loads and boundary conditions for the model are created now. From Utility 

Menu, select BCs Manager. Provide a name for the load collector and select type as 

Boundary Condition. From the selector choose nodes and select the master node of 

the rigid body created. Fix all the degrees of freedom and click create. 

 

 
 

9. From BC’s Manager choose Initial Velocity as the type. Parts selection is activated 

and select the Bird component. A velocity of 130000mm/s is assigned in X-direction. 

For that, the value is entered in Vx field. 
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10. From Tools> mass calc option, select the Bird component and check the mass and it 

shows it is equal to 4lbs, that is 1.8kgs or 1.8 e-3 tons. 

 

 
 

11. In the next step we will define contacts between the components. 

From Analysis>Interfaces option is selected. The interface is renamed as Inter_1 and 

type is selected as Type 7. From the Add option, for master, components option is 

selected and ribs, ribs_outer and skin components are selected as master. For slave, 

nodes option is selected and the bird particles are selected as slave and updated. A 

Gapmin value of 10 is provided and Inacti is set to 5. 
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12. From Analysis Menu > Output Block is selected, from selector comps is selected > all 

the parts are selected > then click Create > Edit. For NUM_VARIABLES option 1 is 

given and for Var option DEF is provided. It means, all default outputs for this part 

will be provided in the time history file. 

 

 
 

13. Now the engine file is created which contains the run controls. We will start with run 

time, /RUN. Right click in Solver browser > Create >Engine Keywords > RUN. This 

specifies the run time for this model. We will provide .005 seconds, that is 5 

milliseconds. 
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A good practice is to create 25 - 30 animation files for the simulation. Here we will 

create 25 animation files. For that, right click in Solver browser > Create >Engine 

Keywords >ANIM> / ANIM/DT is selected. 

 

 
 

For frequency of writing time history file TFILE is selected from solver browser and 

frequency is given as .00002. 

 

 
 

From Solver browser > Create >Engine Keywords >ANIM> ANIM/VERS is selected 

and input is given as 44. When the deck includes SPH, one may use /ANIM/VERS/44. 
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Output results like energy density, von mises stress, plastic strain..etc. are requested 

now. As shown above, right click in Solver browser > Create >Engine 

Keywords>ANIM>ANIM/ELEM is selected and required results are checked. 

 

 
 

14. Now all the required output requests and engine control cards are provided. The file 

can now be exported into RADIOSS file type. The model file or deck file will be saved 

as xxxx_0000.rad, which is also called as starter file. If the merge starter and engine 

file option is not checked a separate file xxxx_0001.rad will also be created which is 

the engine file containing the engine controls and output requests created. 

RADIOSS solver is launched and the deck file is uploaded for running the simulation. 

Starter out file will be generated (xxxx_0000.out) which gives the summary of the FE 

model created (property, materials, parts, contacts, time step...) and summary of 

load cases in the form of warnings and/or error messages. Once the FE model runs 

fine, the engine file will run according to control card parameters. The engine file 

will also create an engine out (xxxx_0001.out) file. The engine out file gives the cycle 

summary and termination notification. The user should continuously monitor the 

time step in the engine out file. Check for the abnormal changes in time step. 
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15. Now the run has been completed and the animation sequence is as shown: 

 

 
 

16. User can check for the various results from the contour panel. 

17. The global energy graph for the simulation is plotted: 
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22 Capstone Project: Cell Phone 

Drop 
Objectives 

1. Demonstrate ability to set up proper initial conditions for a drop analysis 

2. Show appropriate use of interface(s) to model contacting parts 

This capstone project is of a cell phone drop. Many parts of the phone are already 

connected. Often, this type of analysis would be done with second order tetrahedral 

elements. This model uses first order elements to save computation time. 

Your task is to review the model for completeness and finish the model setup using 

the information below to get a valid simulation. 

 •  Input file for this capstone: phonedrop_start_0000.rad 
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Typical phone model 

Front cover (plastic) 

Window* with Touch sensor (galss) 

Dus gasket (foam) 

Buttons (plastic, rubber) 

LCD* module (plastic, glass) 

Carrier (steel plate w. plastic parts) 

PCB* (equivalent elastic material) 

Battery (equiv. elastic material) 

Frame (plastic) 

Screws (solid steel) 

Back cover (plastic) 

with membrane cover for accurate stress post-postprocessing 

 

Elements 

Second order tetras (plastic parts)       110 000 

Hex8 full integration (PCB, Window, LCD etc.)     18 000 

Hex8 red. integr. (gasket, battery, buttons etc.)       19 000 

Shell elements (PCB shield lids)           2 000 

Membrane elements (stress cover)          23 000 

 

Already defined:        Materials 

 •  Parts          Elastic (/MAT/ELAST) 

 •  Properties        Elasto-plastic (/MAT/PLAST_TAB) 

 •  Material         Hyperelsatic (/MAT/OGDEN) 

 •  Tie interfaces (part-to-part)    Interfaces 

            Tied interface (/INTER/TYPE2) 

 

 

 

  Contact with friction 

(/INTER/TYPE24) 
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To define: 

1. Contact                                                           Loads 

• Contact Surface                                      Impact with floor (/RBODY, /BCS) 

• Contact Interface                                    Initial Velocity (/INIVEL) 

2.     Loads and Boundary Conditions                 Gravity (/GRAV) 

3.     Engine File 

Complete Connections And Contact 

The screws need to be connected to the front cover. Assume the parts interact with 

each other with a friction value of 0.2. 

 

Loading Conditions 

The phone drops from a height of 1.5 meters in the z-direction to a flat floor on the Z 

plane. The forces between the phone and the floor need to be recovered. 

The total simulation time is 1 millisecond. Animation output requests should include 

plastic strain for solids and shells, vonMises stress, tensor of shell membrane stress, 

and nodal added mass. 

 

Run Analysis and Post-Process 

Run the simulation and postprocess the results, comparing to the results on the 

following page. Look at the force between the phone and the floor as a function of 

time. Compare with the weight of the phone at rest. 
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Expected Results 
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23 Capstone Project: Roof Crush 
 

Objective 

Create a simulation of the FMVSS 216 roof-crush test 

 

 
 

Initial Models: 

• Car 

• Impactor 

 

 
  TAURUS_A00.inc              FMVSS_ROOF_IMPACTOR.inc 
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Step #1- Import and Create Submodels 

• Import the Car. 

• Import the impactor as an include file 

• Create a //Submodel for the impactor 

• Create offsets in the impactor //Submodel that no values are repeated 

 

Step #2 - Transforms 

This will require (in order) 

• A 180° rotation about the global z-axis 

• A 5° rotation about the axis through axis AB 

• A 25° rotation about the axis through axis AC 

• A translation to put point A at global ( -2145.26, 584.822, 1343.06) 

 

              
 

Step #3 - Interfaces 

Create a Type 7 contact interface between the impactor and the car 

• choose an appropriate stiffness definition 

• choose an appropriate minimum gap 
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• change the coefficient of friction to 0.2 

• choose the appropriate friction penalty formulation Save the data from the 

interface to the time history file. 

 

Step #4 - Gravity 

Create a constant gravity load 

 

Step #5 – Impactor Boundary Conditions 

The impactor assembly contains a spring attached for stability.  Create a BCS 

collector to fix the free end of the spring. 

Create a moving SKEW to define the direction normal to the impactor’s face. 

Create a BCS collector to guide the master node of the impactor rigid body so that it 

is free to translate normal to the face of the impactor, but is fixed in all other DOFs. 

 

Step #6 – Imposed Displacement 

Impose the velocity of the impactor starting from 0 mm/s at t = 0.  The displacement 

of the impactor should be 200 mm @ 200 ms. 

Avoid abrupt changes in the acceleration of the impactor. 

 

Step #7 – Control Cards 

Add 

• a  /ANALY card 

• a /DEF_SHELL card, 

• a /DEF_SOLID card, and 

• a /IOFLAG card 

• a /SPMD card 

• a /SPHGLO card 
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• a /ALE/DONEA card  

• a /TITLE card 

 

Step #8 - Engine File 

Create the engine file for the model: 

• Request solver version 13.0 

• Use a constant nodal time step 

• Print time history every 0.0001 seconds 

• Create restart file every 1,000,000 cycles 

• Suppress printing of the list file 

• Solve for 200 ms 

• Create animation file every 0.005 seconds 

• Include selected output in  animation files: 

• Elemental energy 

• Elemental equivalent plastic strain 

• Elemental hourglass energy 

• Elemental von Mises stress 

• Nodal added mass 

• Request output of CPU time for each processor 

• Turn on parallel arithmetic 

 

Step #9 - Solution And Post-Processing 

• Run the model  

• Plot force vs. displacement. Check that the FMVSS 216 target load of 47,000 N (= 3 * 

GVW) has been met. 

• Plot the energy vs. time curves.  
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24 Appendix: Recommended 

Videos 
For your convenience we compiled the introductory videos (by Rahul Rajan) 

embedded in the eBook below: 

 

Why & When To Run An Explicit Analysis (14 

minutes) 

 
 

Effects of Hourglassing (7 minutes) 

 

https://altair-2.wistia.com/medias/wccd1xy5bu
https://altair-2.wistia.com/medias/wccd1xy5bu
https://altair-2.wistia.com/medias/di577pglvl
https://altair-2.wistia.com/medias/di577pglvl
https://altairuniversity.com/learning-library/why-when-explicit-analysis/
https://altairuniversity.com/learning-library/iv_some-remarks-about-hourglass/
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RADIOSS File Structure (14 minutes) 

                 
 

 

1D Elements: BEAM & TRUSS (7 minutes) 

    
 

 

 

 

https://altair-2.wistia.com/medias/9v47veeusj
https://altairuniversity.com/learning-library/what-you-need-to-know-about-radioss-files/
https://altairuniversity.com/learning-library/v_beam-and-truss-elements-in-radioss/
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1D Elements: Spring Type 4 (8 minutes) 

            
 

 

 

1D Elements: Spring Type 12 (4 minutes)  

          
       

https://altairuniversity.com/learning-library/v_b_spring-type-4-in-radioss/
https://altairuniversity.com/learning-library/v_f_spring-element-type-12-in-radioss/
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1D Elements: Spring Type 13 (22 minutes) 

 
 

 

1D Elements: Spring Type 8 (20 minutes) 

 

https://altairuniversity.com/learning-library/spring-type-13-in-radioss/
https://altairuniversity.com/learning-library/v_e_spring-element-type-8/
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Information Required For Spring Elements (6 

minutes) 

 
 

 

2D Elements (18 minutes) 

 
 

 

 

 

 

https://altairuniversity.com/learning-library/v_c_required-input-for-spring-elements-in-radioss/
https://altairuniversity.com/learning-library/v_g_2d-shell-elements-in-radioss/
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3D Elements (15 minutes) 

                     
 

 

Material Law2 and Law36  

   

https://altairuniversity.com/learning-library/v_h_solid-elements-in-radioss/
https://altairuniversity.com/learning-library/vi_materials-in-radioss/
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Contact Interfaces (3 minutes) 

                   
 

 

Tied Contact (12 minutes) 

      
 

 

 

 

 

 

https://altairuniversity.com/learning-library/vii_a_interfaces-in-radioss/
https://altairuniversity.com/learning-library/vii_b_interface-type-2-in-radioss/
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How Sliding Contact Works (9 minutes) 

 
 

 

Contact Type7 (23 minutes) 

 
 

 

 

 

 

https://altairuniversity.com/learning-library/vii_c_sliding-contact-in-radioss/
https://altairuniversity.com/learning-library/vii_d_sliding-interface-type-7-in-radioss/
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Rigid Walls (6 minutes) 

        
     

 

 

Rigid Bodies (18 minutes). 

    
 

https://altairuniversity.com/learning-library/vi_a_rigid-wall-rwall-in-radioss/
https://altairuniversity.com/learning-library/vi_c_rigid-body-rbody-in-radioss/
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Added Mass and Skew Frame   

    

           
 

 

 

Loads & Boundary Conditions (18 minutes) 

                

                             

https://altairuniversity.com/learning-library/vi_f_added-mass-and-skew-frames/
https://altairuniversity.com/learning-library/vi_e_loads-and-boundary-conditions-in-radioss/
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Time Step Control (32 Minutes) 

 
 

 

 

Debugging Techniques - Starter Crash (14 minutes) 

 

https://altair-2.wistia.com/medias/o0bfml9ah5
https://altairuniversity.com/learning-library/considerations-about-time-step/
https://altairuniversity.com/learning-library/vii_e_issues-with-the-starter-file-in-radioss/
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Debugging - Engine Crash Before First Cycle (5 

minutes) 

             

Debugging - Engine Crash After Several Cycles  (8 

minutes) 

                

 

https://altairuniversity.com/learning-library/viii_b_issues-with-the-engine-file-in-radioss/
https://altair-2.wistia.com/medias/mi4roo3czj
https://altairuniversity.com/learning-library/viii_c_issues-with-engine-file-after-several-cycles-in-radioss/
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Troubles with Energy and Time Step (7 minutes) 

               
 

 

Troubles With Material Definition (4 minutes) 

           

https://altairuniversity.com/learning-library/viii_d_issues-with-energy-and-time-step-in-radioss/
https://altairuniversity.com/learning-library/viii_e_issues-with-materials-in-radioss/
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Troubles with Interfaces (7 minutes) 

              
 

Altair India released a new RADIOSS Introduction 

video series recently: 

 
Mesh Criteria, Materials and Properties (by Prashanth A.R.) 

https://altairuniversity.com/learning-library/viii_f_issues-with-contacts-in-radioss/
https://www.youtube.com/watch?v=CxM52wP3_ew&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6
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Interface 2 Connections (by Prashant A.R.) 

 

 
Creating Loads and Boundary Conditions (by Prashant A.R.) 

 

 
Contacts Type 7 and Type 11 (by Prashant A.R.) 

https://www.youtube.com/watch?v=ayK9V4JDdYY&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6&index=2
https://www.youtube.com/watch?v=mLGwVwYSmt4&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6&index=3
https://www.youtube.com/watch?v=-HdECgBC_lM&index=1&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6
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Creating Monitoring Volumes (by Prashant A.R.) 

 

 
Creating Output Block (by Prashant A.R.) 

 

 
Model Check and Engine File(by Prashant A.R.) 

 

 

 

 

 

https://www.youtube.com/watch?v=kCSRFss6GDE&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6&index=4
https://www.youtube.com/watch?v=1BnhOzRVkEQ&index=5&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6
https://www.youtube.com/watch?v=9jVzvmWjErc&list=PLQ7KUGFuVz4u5y3SvIEIU07427-gATaG6&index=6


    
 

456 

Introduction to Radioss   

https://www.youtube.com/watch?v=SAa1ozDM4Dk 

Radioss for Non-linear Crash using Altair HW SE   

https://www.youtube.com/watch?v=HGsA5RwddLs 

https://www.youtube.com/watch?v=HMMbJXgiO2Q 

https://youtu.be/kYWyjCfSnkU 

https://youtu.be/Mj_4IlcjSwU 

https://youtu.be/UPyWpl2bPzw 

https://youtu.be/FBY8OcIdDa4 

https://youtu.be/2ChWJbGhCVQ 

https://youtu.be/gQ4trEv9r3g 

Impact Attenuator Crash Analysis for SUPRA SAEINDIA 2017 - 3D Meshing & 

Analysis using HW SE 14.0 

https://www.youtube.com/watch?v=Srgn7ZE0jMI 

Impact AOC Webinar: Introduction to Radioss for Explicit Nonlinear 

https://youtu.be/U8oexuwbw28 

Impact AOC Webinar: Nonlinear Analysis using Radioss by HW SE 14.0 

https://youtu.be/qeIQHEqI6f8 

https://youtu.be/aoH2Fz1qcA0 

Hypermesh Crash Simulation 

https://www.youtube.com/watch?v=1k3sojVJZ10 

HyperWorks 2019 - Radioss - Steel Ball and Plate Impact Simulation   

https://www.youtube.com/watch?v=SAa1ozDM4Dk
https://www.youtube.com/watch?v=HGsA5RwddLs
https://www.youtube.com/watch?v=HMMbJXgiO2Q
https://youtu.be/kYWyjCfSnkU
https://youtu.be/Mj_4IlcjSwU
https://youtu.be/UPyWpl2bPzw
https://youtu.be/FBY8OcIdDa4
https://youtu.be/2ChWJbGhCVQ
https://youtu.be/gQ4trEv9r3g
https://www.youtube.com/watch?v=Srgn7ZE0jMI
https://youtu.be/U8oexuwbw28
https://youtu.be/qeIQHEqI6f8
https://youtu.be/aoH2Fz1qcA0
https://www.youtube.com/watch?v=1k3sojVJZ10
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https://www.youtube.com/watch?v=9zDNqWcUre4 

BAJA SAEINDIA Online Training-Dynamic Crash Analysis using Altair RADIOSS 

https://youtu.be/Y1BiKMcXr34 

AOC India 2019 RADIOSS 

https://youtu.be/TYRR7fHsdkg 

https://youtu.be/rdEyQ7Xeq-U 

Crash simulation 

https://youtu.be/AGzXrLvQHHA 

2016 Directed Learning Webinar Series – Crash Analysis with RADIOSS 

https://altairuniversity.com/learning-library/2016-directed-learning-webinar-

series-crash-analysis-with-Radioss/ 

SUPRA SAEINDIA 2015 - Webinar Series - Day - 5 

https://www.youtube.com/watch?v=lLFAUSmrCjo 

SAEINDIA BAJA 2016 Online Training Session Day 3   

https://www.youtube.com/watch?v=Aa1NBx6Kqh8 

AOC2015: Linear / Non-Linear Contest Models Solution recorded webinar 

https://youtu.be/eFh5xngYuLs?t=1823 

Dynamic Crash Analysis of Roll cage 

https://www.youtube.com/watch?v=vSAk3S8-G1Q 

https://youtu.be/UiRH2A6ORE8 

Radioss for Dynamic Analysis 

https://www.youtube.com/watch?v=JvcwgOdbIbM 

https://www.youtube.com/watch?v=9zDNqWcUre4
https://youtu.be/Y1BiKMcXr34
https://youtu.be/TYRR7fHsdkg
https://youtu.be/rdEyQ7Xeq-U
https://youtu.be/AGzXrLvQHHA
https://altairuniversity.com/learning-library/2016-directed-learning-webinar-series-crash-analysis-with-radioss/
https://altairuniversity.com/learning-library/2016-directed-learning-webinar-series-crash-analysis-with-radioss/
https://www.youtube.com/watch?v=lLFAUSmrCjo
https://www.youtube.com/watch?v=vSAk3S8-G1Q
https://youtu.be/UiRH2A6ORE8
https://www.youtube.com/watch?v=JvcwgOdbIbM
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https://www.youtube.com/watch?v=A7puoemvxPo 

Dynamic Crash Analysis using Radioss 

https://youtu.be/lVe-ioxnZjg 

https://youtu.be/9pfEq4JoosA 

Impact Characteristics of Crash Box in Vehicle - (Nonlinear Explicit Buckling analysis 

of tube) 

https://www.youtube.com/watch?v=Lxx4vMuxyVg 

https://www.youtube.com/watch?v=CSaigXNPlHg 

Hourglass and shear-Locking in FEA/FEM   

https://www.youtube.com/watch?v=lqLlpLFV53Y 

Even though the following videos by Paul Du Bois and Altair were recorded back in 

2008 (!), the message is still relevant. 

https://altair-2.wistia.com/medias/4ilsbbrgqo 

https://altair-2.wistia.com/medias/3dvn4v8sco 

https://altair-2.wistia.com/medias/unjgjb99uz 

In the videos shown below, Paul Du Bois explains the importance of shell elements 

and element quality on the outcome of an analysis. 

https://altair-2.wistia.com/medias/w84elqti38 

https://altair-2.wistia.com/medias/rmretoumym 

https://altair-2.wistia.com/medias/v230u05pq3 

 

 

 

https://www.youtube.com/watch?v=A7puoemvxPo
https://youtu.be/lVe-ioxnZjg
https://youtu.be/9pfEq4JoosA
https://www.youtube.com/watch?v=Lxx4vMuxyVg
https://www.youtube.com/watch?v=CSaigXNPlHg
https://www.youtube.com/watch?v=lqLlpLFV53Y
https://altair-2.wistia.com/medias/4ilsbbrgqo
https://altair-2.wistia.com/medias/3dvn4v8sco
https://altair-2.wistia.com/medias/unjgjb99uz
https://altair-2.wistia.com/medias/w84elqti38
https://altair-2.wistia.com/medias/rmretoumym
https://altair-2.wistia.com/medias/v230u05pq3
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Turkish: 

Crash Box Simulasyonu Altair HyperCrash – RADIOSS 

https://youtu.be/b2PyTSvCrYc 

Plaka üzerine kütle düşürme simülasyonu Altair HyperMesh - RADIOSS  

https://youtu.be/vE39mUlKLQM 

German: 

Organisation von RADIOSS Crash-Modellen mit HyperCrash   

https://www.youtube.com/watch?v=4f_BHy4ryrk 

Neue Möglichkeiten zur Kontaktmodellierung in RADIOSS   

https://www.youtube.com/watch?v=rJ3H_M8iMcY 

Tipps & Tricks in HyperCrash   

https://youtu.be/ky1Wr3Ie7xE 

Interpretation von RADIOSS Logfiles zur Kontrolle expliziter Simulationen 

https://youtu.be/QjM-XZSnN2s 

Versagensmodelle in RADIOSS   

https://youtu.be/YG0Rjok2JbE 

Anwendung von RADIOSS Kontaktdefinitionen für die Crashsimulation   

https://youtu.be/Ah8XKVFo20Q 

Vietnamese: 

Mô phỏng thả rơi điện thoại với phần mềm Radioss - Hyperworks tiếng Việt  (celll 

phone drop test) 

https://www.youtube.com/watch?v=kVmEJWbEWnM 

https://youtu.be/b2PyTSvCrYc
https://youtu.be/vE39mUlKLQM
https://www.youtube.com/watch?v=4f_BHy4ryrk
https://www.youtube.com/watch?v=rJ3H_M8iMcY
https://youtu.be/ky1Wr3Ie7xE
https://youtu.be/QjM-XZSnN2s
https://youtu.be/YG0Rjok2JbE
https://youtu.be/Ah8XKVFo20Q
https://www.youtube.com/watch?v=kVmEJWbEWnM
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Brazilian 

2016 06 RADIOSS 

https://youtu.be/FwuI2lJtjOY 

Korean: 

https://www.youtube.com/user/AltairKr/search?query=Radioss 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://youtu.be/FwuI2lJtjOY
https://www.youtube.com/user/AltairKr/search?query=radioss
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25 Appendix: Conversion Tables 

And Constants 
The following overview is part of the RADIOSS Theory (see HyperWorks Help 

Documentation for more details) 
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